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6 Function : |
» = Debug ToOE ERkakakakes Mavigation » Customize Perspective... E Bcie
v (= src g8 *= . ca nq
=4 / S Do e E£Y Team Synchronizing
> = bsp 9 Preferences
d 18 // Includes --- Reset Perspective.. Other...
? (& demo 11 #include “"deme.h"” c
o Close Perspective
13 Close All Perspectives
14 S Detinitions — oo T ————l = = e
15= int main{void)
16 {
17 // User application codes
8 2 18 1 v
B Target 22 B Oulline} = 8
2] | B nl L~ & Consale 2 =] Pmperﬂes}lﬂ Pmblemq@TerminanﬂgFum:lion Co}ﬂgSlalic Stﬁ:k\liﬁ Documents W = 0
> % Running Target &ﬁ}i’bl'—'ﬂaﬂ :a‘ﬂavrﬁv
-+ 1
> 5w Targets CDT Build C [a2350 dem
= CREE N
Invoking: 5ize (section size listing)
riscv32-elf-size "ae35@_demo.adx" | tee output/.PHONY.size
text code rodata data bss dec hex filename
9474 8698 776 e 736 16218 27e2 ae35@_demo.adx
Finished building: output/.PHONY.size
16:23:41 Build Finished. @ errors, @ warnings. (toock 13s.461lms)
v
< >
5 2e350_demo =R |
E 14 EE T AL
A c/ci+ - ae350_demo/src/demo/main.c - AndeSight RDS v5.1.1 — O X
Elle Edit Source Refactor Navigate Search Project Run MWindow Help
BO-HQIK- ki %% -0 8- A SEHETCED- ] | @ | @)
|7 Project Explorer &2 = B ||/Al Andes Project Creator (@ main.c £ = 0
& v 18 /* ~
. S 2=
v 15 ae350_demo 3  * File : main.c
> 4 Binaries 4  * author  : GowinSemicoductor
5 @l Includes 5 * chip : AE35@_S0C
6 * Function : Main functions
> = Debug 7 =
v = src 8 **/
» bs g
Bd " 1@ // Includes ---
? (& demo 11 #include "demo.h”
12
13
14 // Definitions -----mmmmm oo oo e
15=int main(void)
16 {
17 // User application codes
g e 18 1"

B Target 52 B2 Oulline] = 0

Q’Ul E‘nlﬂﬂ = || B Console 2

15| Pmperlieq =R Pmblems] &= Terminan il Function COW illl; Static Stack ] U Documents ] = 0

> 2 Running Target
> H Targets

O 4|5 GEEE =B B -8

[ae350_dem
av

SwTpeer

Invoking: Size (section size listing)
riscv32-elf-size "ae358 demo.adx” | tee output/.PHONY.size

text code rodata data bss dec hex filename

9474 8693 776 a 736 1e21@ 27e2 ae35@_demo.adx
Finished building: output/.PHONY.size

16:23:41 Build Finished. @ errors, @ warnings. (took 13s.461ms)

=5 22350 demo

AR 2 B AL EIEOE B & R LS A AL IR, AT DA

“Window > Show View” X, anf 1-5 fras.

F
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1 RDS ¥4 4

1.2 7 sh At

& 1-5 i£¥ Window > Show View

A c/iCt+ - ae350_demo/src/dema/main.c - AndeSight RDS v5.1.1

File Edit Source Refactor Navigate Search Project Run  Window Help

A~ | R ~iglh ~i R w0~ 0 New Windaw
. = . Editor >
75 Project Explorer 2 O |/|A Andes Project Creato
- Appearance >
B5E - 19 /*
= 2 Ul Mode 5
~ 1% 22350 demo 3
4 Binaries a Show View >
[l Includes 5 Perspective >
iz Debug Navigation >
¥ = src
bs; Preferences
Ed P 1@ // Includes ---
(& demo 11 #include “"demo.h"
12
13
4 f/ Definitions --------mmeem-cmmoooo-
15= int main(void)
5 1
// User application codes
< > ’
M Target 22 5= Qutlne] = 8
& | = ﬂjl = || & Console 2 " _[[] Properties|[£. Problems | (&~

X Running Target
3% Targets CDT Build Console [2¢350_

dema]
e

Invoking: Size (section size listing)

riscv3z-elf-size
text code rodata data bss
9474 8698 776 ] 736

Finished building: ocutput/.PHONY.size

- ] *
e - < - [auick Access] g | B 4
= 0
~
I
@ Build Targets
Eg C/C++ Projects
B Consale Alt+Shift+Q, C
‘= Include Browser
. Nawvigater |
g=  Outline Alt+Shift+Q, O
[ Problems Alt+Shift+Q, X
[y Project Explorer ~ feeeeeeeen
[ Properties
4 Search Ale+Shift+Q, S
¥| Tasks e
&2 Terminal
Other... Alteshifteq, @ | Documents - B
En—m=n i Nl = R e

"ae358_demo.adx” | tee output/.PHONY.size
dec
18218

hex filename
27e2 ae358_demo.adx

16:23:41 Build Finished. @ errors, 8 warnings. (tock 13s.461ms)

<

1% 2e350_demo

~

1.2 BahiH

MUG1025-1.3

At Windows PC %2 RDS i, nf LA s bty X “B7 o
%% H 3% “AndeSight RDS_v511\ide\AndeSight.exe”, &3 RDS #A4%:.

1.3 AHEMAEER

SR NS BAE RDS #MF O i1

1. % RDS #ft 3% “Help > About AndeSight_ RDS v511”,

1'6 Fﬁ/j_‘—\Ao

&

4(143)




1 RDS ¥4 4

1.3 HAFRRAE R

MUG1025-1.3

[# 1-6 #£#¥ Help > About AndeSight RDS v511

A C/C++ - 2e350_demoy/srcfdemo/main.c - AndeSight RDS v5.1.1

File Edit Source Refactor Navigate Search Project Run Window Help

Ars -~ | i v q;|:§;v‘)vg§v.,v (7) Help Contents
&7 Search
l{ Project Explorer i3 = B ||[f Andes Project Creator [gn”

Show Contextual Help

BE 7| i
Show Active Keybindings... Ctrl+Shift+L

Tips and Tricks...
Cheat Sheets...

125 ae350 demo

Documents Windaow
Check Update

1@ // Includes ----------- Install New Software...
11 #include “"demc.h™ -

SR IR AT R T

- O X

s | | @
= 8

-

12 Jfil License Content

13 .

12 7/ Definitions ——----—- A About AndeSight RDS v5.1.1
15= int main(void)

16 {

// User application codes
i

M Target 32 B= Outline| = O

-

& ~ || B Console 1 [T Properties|[£] Problems| & Terminal | flls Function Code Size| il Static Stack Analysis = O
211 B8 P y:

% Running Target

3¢ Targets No consoles to display at this time.

0 items selected

2. 1 “About AndeSight RDS v5.1.17 XHEHES, #FH 2450 1L A

RDS IR AAE S, wE 1-7 fis.
& 1-7 F RDS &

AndeSight/IDE
Version: 5.1.1
Copyright (c) 2005, 2022. Andes Technology Corporation.
. All rights reserved.

ANDES Visit http://www.andestech.com

TECHMOLoGy This product includes software developed by the
Apache Software Foundation http:/fwww.apache.org/
This software contains icons from icons8 https://icons8.com/

SHPOEeS @

A About AndeSight RDS v5.1.1 O *

- . . i
@,‘ Installation Details

3. Hifi “Installation Details”, 7t “AndeSight RDS v5.1.1 Installation
Details” *F1iHEH, “Version Information” %1% 7~ RDS #2423

A RRAE S, ik 1-8 .
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1 RDS #AF i 1.4 TAEASH

E 1-8 REBHHREER

A AndeSight RDS v5.1.1 Installation Details O x

Installed Software | Installation History | Features | Plug-ins| Configuration|

== ==== ====== AndeSight/ide ~

AndeSight RDS v5.1.1

S S S ice
Andes ICEman (Open0CD) 5.1.1-g3a34fc9 (20822-84-22-14:27)
AICE-driver DLL version: 1.2.6.8

S S S sid
AndeSim v1.1@.6088 (35542be)

S = ====== nds_ldsag

Andes LdSaG versicn (2822-85-18)

==== ======  nds32le-elf-mculib-v5/bin
.ghu (2022-85-83_nds321le-elf-mculib-v5-8856622c933) 10.3.8

riscv32-elf-gec
2-85-84 riscv32-elf-85bad23ad4e@) 8.2.50.20190522-git

GNU gdb (202

== ====== nds32le-elf-mculib-v5d/bin
riscy32-elf-gec.gnu (2022-85-83_nds32le-elf-mculib-vSd-8856622c933) 10.3.08

GNU gdb (2022-85-83_riscv32-elf-85ba823a40@) 8.2.50.20190522-git

==== ==== ====== nds32le-elf-mculib-v5f/bin M
gt/ Copy to Clipboard

1.4 T{E=1g)

TAF=518]) (Workspace) FIT{RFZEFIEH RDS A8/ T, BN
12N “USER_HOME\AndeSight5\workspace”.

XA RDS #A%it, 7€ “AndeSight RDS v5.1.1 Launcher” %%
FEH IR RDS B4 471 TAES R, i 1-9 Fron. AR E ka7
M T AR BRAF A E F B TR, #di “Launch” BIW] . o A8 2 o o
O ol i) TAEZ 1], #dh “Browse...”, 485 Hifth T/ES RIS . TEE
TAEZ AR LA/ (A-Z, a-z, 0-9). FRIZ (O AEFF () 4
Jio

B 1-9 RDS Launcher

A AndeSight RDS v5.1.1 Launcher X

Select a directory as workspace

AndeSight_RDS v5.1.1 uses the workspace directory to store its preferences and development artifacts.

Workspace: : D:\AndeSights_RDS\workspace ~ Browse...

[JUse this as the default and do not ask again

» Recent Workspaces

[ ] oo

MUG1025-1.3 6(143)




1 RDS #AF i 1.5 BoniE & I

1.5 B/RIESIEMR
RDS HCMHaHE 3 i (330, HSOMEHD BB,
CENPI e
SIRBLT B P 1) B 5

1. %&# RDS E3¢H “Window > Preferences > Language”, 4114 1-10 Fr
o

[# 1-10 i£#¥ Window > Preferences > Language

A C/C++ - AndeSight RDS v5.1.1 [GOWINSemic] — m] %
File Edit Source Refactor Navigate Search Project Run  Window Help
A~ il v LR R I New Window v o j@|@,§;ﬁ
Editor > -
75 Project Explorer 3 = O ||[E% Andes Project Creato = 0
p ol Appearance >
~ 18 /* ~
B 3 Ul Mode »
=% ae350_demo 3
a Show View >
5 Perspective >
[
7 Navigation >
9 Preferences
18 /7 INCLUAES - - — = = e e e e
11 #include "demo.h"
12
13
14 // Definitions - ---mmm oo oo e e
15= int main(void)
16 {
17 // User application codes
18 / ©
8 Target 11 _EF Outline = O
& ‘ = ﬂ]l =~ || & Console &2 [ Properties | [£] Problems | #® Terminal | s Function Code Size | illy Static Stack Analysis = g
£ Running Target - -
3¢ Targets No consoles to display at this time.
0 items selected ] - |

2. EHE—MERES, #ili “Apply”. 7£ “Change the displayed
language” XTifHER, 2ty “Yes”, HJH RDS #4f, W& 1-11 fix.

MUG1025-1.3 7(143)




1 RDS #AF i 1.6 PREA]

S ——
B 1-11 ERERES
A Preferences O *
type filter text Language & v
General 2 Change the displayed language
Binutils Preferences ;
C/C++ i English
Chip Profile Settings I=[F A Z(Japanese)
CMakeEd FZ(Simplified)
Geov
Help

Install/Update

Jython external library
Language

LdSaG

License

Remote Development
Remote Systems
Run/Debug

Script Shell

Target Management [
TCF Agent Configurati
Team

Terminal

Validation v Restore Defaults Apply

':?;' II\_‘. 1< Apply and Clase Cancel

3. RDS ¥frEJRJE, HAFLLE#IEIE S S,

1.6 REFEANIT]
AATRAPLENTEHAE, BEM T H PRl E92E RDS #4601 dt/# 8/
L RWARER s
SR UL N B BYI T #E RDS B M H IR

1. ARy R B 5 RDS #2035 B
“AndeSight_ RDS_v511\ide\ AndeSight.exe”, iz RDS #f4:.

2. “AndeSight_RDS v5.1.1 Launcher” XH&HER, $7R TAE2S A IERIA
12 “USER_HOME\AndeSight5\workspace”, H.i7 “Launch” 4f%:
T, WE 112 s

MUG1025-1.3 8(143)




1 RDS ¥4 4

1.6 PRIEAT]

& 1-12 RDS Launcher

A AndeSight RDS v5.1.1 Launcher

Select a directory as workspace

AndeSight_RDS v5.1.1 uses the workspace directory to store its preferences and development artifacts.

[
Workspace: ] D:\AndeSight5_RDS\workspace ~ Browse...

[JUse this as the default and do not ask again

» Recent Workspaces

T H A K (Andes Project Creator) 1, EFGEREME . THIE
A “Chip Profile”, Xk € H “Chip Profile” o7 “Create
Project...”, G4 T, WK 1-13 Fix.

1 -
Connection Configuration: ICE
Project Language: C

Chip Profile: GOWIN-AE350 (ADP-AE350-A25-GOWIN)
& 1-13 I B 6 Z 4L &

A C/Ct++ - - AndeSight RDS v5.1.1

- [m] X
Hle Edit Source Refactor Navigate Search Broject Run Window Help
Al | vigh v “D‘*?'Q'BE'@'J' m e - @‘%ﬁ#ﬁ
{5 Project E £3 = B |[[A Andes Project Creator i3 = 8
Bs -

Connection Configuration

Projert Language
. . Create Project...
O Simulator AndeSim ~ | @ ICE [ICE ~ @c|OcH+

Chip Profile (Double click to create project...)

Chip Profile Name Chip ID
v GOWIN-AE350

CPU

ADP-AE350-A25-GOWIN ADP-AE350-A25-GOWIN [A25]

AT x> So| = A8

IR =l = || Project Creator | Preferences
2 Running Target
:C:”argmg g B) Console 52 ™[] Properties| (2] Problems | 48 Terminal| il Funclion Code Size| flly Static Stack Analysis| 4° Call Hierarchy =0
3
g
T senesies m dp e i e

0 items selected

4. “C Project” *iFHERH, F87E Project name. Location. Project type

F1 Toolchains, i “Next”, W& 1-14 f~.

MUG1025-1.3
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1 RDS #AF i 1.6 PREA]

(LR

Project name: ae350_demo

Location: D:\RDS\workspace

Project type: Empty Project

Toolchains: nds32le-elf-mculib-v5
1-14 BIZEHH CRHTE

A CProject O X

C Project —

Create C project of selected type
Chip Profile: ADP-AE350-A25-GOWIN - "

Project name: ae350_demo|

Use default location
D:A\RDSS\workspace\ae350 dema Browse...

default

Project type: Taolchains:

v AndesExecutable |

[ nds32le-elf-meulib-vs

® Empty Project
® Hello World ANSI C Project
(Z= Andes Shared Library

nds32le-elf-mculib-v5d
nds32le-elf-mculib-v5f
nds32le-elf-newlib-v5

(= Andes Static Library
(2= Makefile project

nds32le-elf-newlib-vsd
nds32le-elf-newlib-vsf v

Show project types and toolchains only if they are supported on the platform

® = Back Next =

5. AEVIHREFHIBMWE T, EFCO @B TR, Bl RDS BT
A% “|7 (Build), #EZM4TRE, WK 1-15 i,

MUG1025-1.3 10(143)




1 RDS ¥4 4

1.6 PREA]

MUG1025-1.3

B 1-15 #EHRETE

A C/C++ - 28350 demo/srcfdemo/main.c - AndeSight RDS v5.1.1 — O x

Ele Edit Source Refactor Navigate Search Project Run Window Help

- .,IQ-|EE-;1 WA -0-Q-®F - ARE TS D [quick access| | & | IR 4
= 3

&5 ProjectE 2 = B |[/A Andes Project Creator r@ main.c &
e 18/7 ~

v 15 2e350_demo File : main.c

2 =
3 =
> 4 Binaries 4 * puthor  : GowinSemicoductor
> [ Includes 5 * Chip : AE358_S0C
6 * Function : Main functions
> (= Debug 7 =
W (= sre 8 ¥/
> & bsy 9
Bd P 18/ InEludes - - mmm oo e e
> & demo 11 #include "demo.h”
22350 demao Debugl || 12
13

18 /7 DEFANIEAONS == m = mm oo mmmm o
152 int main(void)

15 {
17 1
< b3 18 // User application codes
19 1
At iZo] = 0]
21 // Run UART demo v
flo@am -
2% Running Target =
- y - ; : - : . : =
3 T Targets 3 Console i3~ [ Properl\as] [ Prob\ams} & Tarmlnan ills Function Code SIZe‘W [y Static Stack Analysls] e cal Hlerarchﬂ =]

A T IR = R

CDT Build Console [ae350_demo]

Finished building: output/ae35@_demo.bin A

Invoking: Size (section size listing)
riscv32-elf-size "ae35@_demo.adx" | tee output/.PHONY.size

text code rodata data bss dec hex filename

18856 9083 968 2] 720 18776 2al8 ae35@_demo.adx
Finished building: output/.PHONY.size

A
v

6. AR GWEFRIgwmPEE R, Wikl S, i 1-16 fy
TNo
B 1-16 IEHI G ERHRIFLE R

A C/C++ - 28350 demo/srcfdemo/main.c - AndeSight RDS v5.1.1 — O x

Ele Edit Source Refactor Navigate Search Project Run Window Help

Bo-Eo S -k V-0 BSSRETPE DY [uick access| | o | @ 4%
It Project Explorer & =G ¥ = 08 ||[/Al Andes Project Creator f@ main.c &2 = 4d
v (% ae350_demo ~ 18 /* ~
> 4% Binaries 2.
ks 3 * File : main.c
> [l Includes 4 * author @ GowinSemicoductor
~ (= Debug 5 * Chip : AE358_50C
s & output g : Function : Main functions
> = src 5 */
> %ﬁ. ae350_demo.adx - [Andes/le] 9
makefile 18 // INCIUdES —= - mm s s oo m e oo
e K 11 #include "demo.h"”
| & objects.mk 12
|& sources.mk 13
14 // Definitions -----------m-ommmm e
M= EXECUtable 152 int main(void)
> (= bsp 15 {
> (= demo 17 I
[2_2e350 dema Debnalaunch © 18 /4 User application codes
19 1
8 Target Manage 2 . 5= Dutline] = 8 20
21 7/ Run UART demo M

g Em MM -

£ Running Targst

s | [#0 = . . : : =5
5 % Targets B Console 2 = Propemes} =R Prob\ems} o Tarmmaﬂ [l Function Cod ] [lly Static Stack AW % Call Hlerarchﬂ

== e N =R i

CDT Build Consale [26350 dema]

riscv32-elf-size "3e350_demo.adx” | tee output/.PHONY.size ~
text code rodata data bss dec hex filename
18856 9988 968 [} 720 10776  2al8 ae35@_demo.adx

Finished building: output/.PHONY.size

18:99:54 Build Finished. @ errers, @ warnings. (tock 11s.3@ms) Compl|at|0n reSL”ts

5 ae350 demo : - |

7. ¥ Gowin FTDI USB #ufdsdfi N PC FHL, [FIIF I AR - 2951
RiscV_AE350_SOC ] JTAG #11. i RDS #fF T Hf: “% 7
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1.6 PREA]

MUG1025-1.3

(Debug) JE3NHL, B 1-17 Fios.

B 117 Wi H L

[ ae350_dema Debug.launch

38 la t@, _stack
39 mv sp, t@

B

1 #ifdef _ nds_execit

2 J* Initialize EXEC.IT table */
3 1z t@, _ITB_BASE_

8 Target Manag &2 - 0= Oulline} = 0
NlEp@EmE -
v & Running Target

B ADP-AE350-A25-GOWIN ICE-ICE: 9902
> & Targets

csrw uith, t@

5 #endif

5

7 #ifdef _ riscv_flen

3 /* Enable FPU */

1i t@, MSTATUS_FS
csrrs t@, mstatus, t@

A Debug - 26350 demo/src/bsp/ae350/start.s - AndeSight RDS v5.1.1 — O x
File Edit Navigate Search Project Run Window Help
Ag-Dolf-d-sg-a-&-¢- % O -G -F-HETBErD | uick Access| | 5 | T ER[%%
[t Project Explorer &2 = O ||4% Debug &3 R % |2 @ o|iv 0 = = O |[w-variable 2 _0 Memorﬂ = g
BES < ~ {8 Process ~ LB | it ea
v 15 2350 demo v o Thread #1 (Suspended : User Request) Name Type Value
> 4 Binaries = start() at start.5:34 Oxc
> @l Includes & 9db(8.2.50.20190522)-0 v
> (& Debug [A Andes Project © ( main.c (@ config.h (@ start.s = B8
Vi sre 34 la gp, _ global_pointer$ ~
> &= bsp 35 .option pop
> = demo ~
57 /* Initialize stack pointer */

= a

LB ety -
Name 2
K4 All Registers

4% General Purpose Registers

ifii Registers 2

&% Floating Point Registers
5 ¥4 RISC-V ctandard machine made € ¥
< >

& Conso i _[2] Probl | ] Prope | & Termi | [G] GDB C| = Disass| = O

X% BKEESP 2D -5
ae350 demo Debug [MCU Program] ae350 demo.adx

%Bre ¥ . BAMo |@BDe | = O
Rgx@iaw g ~
Z:‘I‘Dilﬂu'

8. #HNWHXIEME, Al AE (Debug View) T AR “Ob7, “32.7,
o SRR AR, W] DOE R A B SR AR (B

an, s,
1-18 AR E

AL e+, W] 1-18 Fior

Quick Access| | E?l W @t

= Variable 2 0 Memory| = O
t =8 = | £F ‘ﬁl [
MName Type Value

§lt Registers 52 - | =B

A Debug - ae350_demoysrc/demo/main.c - AndeSight_RDS v5.1.1
File Edit Source Refactor Navigate Search Project Run Window Help
AC~EHE S~ k-~ & -F R H-0-E"d I JFTEFTLC
B Project Explorer 32 = B |(45.pebugic "% om|lzm o] =0
BES ¥ ~ ¥ Process ~
~ =5 22350 demo w o Thread #1 (Suspended : Breakpoint)
> #F Binaries = main( at main.c:123 Oxled8
> @l Includes 2 _adh(R.2.50.201905221-0 N
> (= Debug A ndes Project ¢ [[& mainc 5 [ configh | Bisterts | = 0O
v @ sre 113 demo_mm( ) n
114  #endif
> & bsp 115
> (= demo 116 // Run multiple peripherals interrupts demo
ae350_demo Debug.launch 117 #if RUN_DEMO_INTR
118 demo_intr();
119 #endif
12a
121 // Run waterfall led demo
122 #if RUN_DEMO_LED
= " = » 123 demo_led();
8 Target Manag 5352 Outline | 2 )" 122 sendif
glemEam || =
+ .
v 3P Running Target 127 // User application codes
‘BE ADP-AE350-A25-GOWIN ICE-ICE: 9902 128 I
> e Targets 129 " 5 M
B Conso 2 ~_[&] Probl ] i Pmpa},@ Termi) [Gl DB C] Disass} = O
XRBEREA -~
ae350 demeo Debug [MCU Program] ae350_demo.adx
Writable Smart Insert 123:1

G
Name a
K4 All Registers
44 General Purposs Registers

L4 Floating Point Registers

v v v

% Bre X ."&MDWQDEW = 04
RREAw|BES ~

A .-
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1.6 PRIEAT]

MUG1025-1.3

9. ¥ Gowin FTDI USB #4sfi sl GWU2X 4af dstfi \ PG EHL, [FIIN 4%
FF R B FPGA 11 JTAG. i RDS T A& “ 7 (Flash
Burner) J3 2l Gowin Programmer %#F, F #3442 Binary {4,
i 1-19 Fior. Wik T 8 H Gowin FTDI USB 4w f2 #5 DL &
WinUSB 5Kz, N2AZ07E “Cable Setting” XFifHEH /25 “using ft2xx
driver” &I, W& 1-20 fiw.

1-19 FHRHETLRE

A C/C++ - 22350 demo/src/demofmain.c - AndeSight RDS v5.1.1 — [m] x

Fle Edit Source Refactor Navigate Search Project Run Window Help

Ar-Hel&-ik-[8] vi¥-0-0-5- G-~ [avick access] | 2 |4 @
= 8

i) Project Explore &% = O |[/Al Andes Project Creator (£ main.c
BES® < 19 /* -
< 2.
v 1= 2e350_demo 3 % File . main.c
#¥ Binaries 4 * Author @ GowinSemicoducter
@l Includes 5 * chip : AE35@_S0C
= Debug 6 * Function : Main functions
¥ = src 8
bs 9
Bd P 18/ INClUdes - mm s oo e e e e
& demo 11 #include “"demo.h™
|2 2e350_demo Debug.launch 12
13
14 // Definitions -—-------omm o
15= int main{void)
16
: 18 /1 User application codes
BTarg B Froui | = O 1a %
& - 20
- - ‘ 2 ﬂ‘ 21 // Run UART demo v
5 Running Target
o Targets
&) Console &2 . [ Properties|[2 Problems| {® Terminal | s Function Code Size | il Static Stack Analysis = 8
O ¢G) EeE A& ME -
CDT Build Console [ae350_demo]
text  code rodata  data bss dec hex filename ~
9832 8398 634 @ 720 9882 2643 ae35@_demo.adx

Finished building: output/.PHONY.size

16:28:53 Build Finished. & errors, & warnings. {took 14s.135ms) v
€ >

& 2350 demo £ 4

[§] 1-20 Cable Setting

Wi Cable Setting ? X
Cable: IGowin USE Cable (WINUSE) v]
Port: Gowin USE Cable (WINUSE)/0/404/null  ~
Fraguency: 15MHz e
Custom LFT Query/Tetect Cable

]Jo HOT shew at startup
| coc

[D uzing ftfux driver

!

RiscV_AE350 SOC i 28 7] LLi%k F] Gowin FTDI USB #f%#%. Andes AICE i 28,
Olimex it 2845, #7718 Gowin FTDI USB 4wfiss. .3 ¥ FPGA 5 CPU 3/ Gowin
FTDI USB %2 #% LA & WinUSB 3Kz .
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1 RDS #AF i 1.7 B CRY

1.7 FBASCHE

TESCRY % AL E (Document Window View) H1 ] LLAT# RDS #k 14 H
PR, TEIER. 2008, eI MEAL C R0, %5 RDS B4
T3 “Help > Documents Window”, 41 1-21 fios.

[# 1-21 i%£3#% Help > Documents Window

A C/C++ - - AndeSight RDS v5.1.1

A | 4 %#-0-Q- -0

= O || A Andes Project Creator & s

=% v Connection Configuration

~ih v
{5 Project Explorer &2

<
1% ae350_demo O simulator | AndeSim v .

Chip Profile (Double click -

Chip Profile Name
~ GOWIN-AE350
ADP-AE350-A25-GC

« Tips and Tricks...

File Edit Source Refactor Mavigate Search Project Run Window Help

Help Contents
Search

Show Contextual Help

Show Active Keybindings..  Ctrl+Shift+L

Cheat Sheets...

Documents Window
Check Update
Install New Software...

License Content

About AndeSight RDS v5.1.1

B Target Mana 52~ 0= Outline] = B

&) B @l

2> Running Target

< || Project Creator | Preferences

% Targets

B Console | Properti [[2] Problem | {2 Terminal [l Function [illy Static 5t | 2 Call Hier

[Find

- O X

i) B R+
= B

Create Project...

Docume i = 8

V26 b b mE

&] 1-22 Documents Window

Documents Window &2

Find vl Leden @ E
MRM10253-1.2E_Gowin RiscV_AE350_50C RDS Software Release Mote, pdf
MRM1023-1.2_Gowin_RiscV_AE350_SOC_RDSEN{E ST pdf
MUGT1025-1.2E_Gowin RiscV_AE350_50C RDS Software User Manual.pdf
MUG1025-1.2_Gowin_RiscV_AF350_SOC_RDSENEFE I pdf
MUG1026-1.2E_Gowin RiscV_AE350_50C RDS5 Software Installation Guide. pdf
MUG1026-1.2_Gowin_RiscV_AE350_SOC_RDSE{E= 3SR pdf

% Breakpoints | G Debugger Console

1.8 RTOS ;B

RDS it 223 H 5418 Gowin RiscV_AE350 SOC Jf sz £ i) kY
RTOS fyiEfd, £+ “AndeSight RDS v511\demo”, % 1-1 fiis.
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1 RDS B 1.8RTOS J5ifig

& 1-1 RTOS &G
RTOS Jih5 it
ae350_rtthread_std RTOS RT-Thread Standard iz A # 4 FF & T 24
ae350_zephyr RTOS Zephyr
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2 QU AT TR 2.1 QI TR

2 BEMAERGTIE

RDS #A4F A LA —ASEr E A TR, Sde O s TR SN TAE
] G B RIBERE — N LREI BT E,  7 AE ml ST SR bn SO
HIdAE, FROvHE.

2.1 Sl TIIE

2.1.1 FERETIE
1. RDS #fFRi3hE, 0 F I A g RDS #ff TAR “A”

(Andes Project Creator), i&#% “Connection Configuration".
“Project Language” #1 “Chip Profile”, (k€K “Chip Profile”
o7 “Create Project...”, QI TR, & 2-1 Fis.

.

Connection Configuration: ICE

Project Language: C

Chip Profile: GOWIN-AE350 (ADP-AE350-A25-GOWIN)
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2 QU AT TR 2.1 QIR TR

& 2-1 T E G E 4L E

A C/C++ - - AndeSight RDS v5.1.1 — O X

Ele Edit Source Refactor Navigate Search Project Run Window Help

Al - | & ~ i v TR R A G [cwick Access| | 5 | [FEI R 45
= 3

=

O ||[A Andes Project Creator 2

- Cannection Configuration Projept Language
O Simulator | AndeSim | [@ICE |ICE ~ OC++ Create Project...

Chip Profile (Double click to create project...

I Project E &3

1
ih

Chip Profile Name Chip ID cPu
~ GOWIN-AE350
ADP-AE350-A25-GOWIN ADP-AE350-A25-GOWIN [A25]

AT 2~ So| = 0O
2| B & < || Project Creator| Preferences
2% Running Target

W Targets & Console 2 [T Properties| [2] Problems | & Terminal | ills Function Code Size | il Static Stack Analysis| 2 Call Hierarchy = 4

> -
||

No consoles to display at this time.

0 items selected ] fali R

Tt 5 G A0 ] A ik TG B R 2-1 s .
= 2-1 I B 81 32 1L &% TR

I ML & Eitipay

Connection Configuration | Simulator: AndeSim | BfLL3%, AT EiER: HARMK

ICE: ICE AR AR A E AR

Wike%, it Andes AICE-MINI+. Gowin
FTDI USB ##fe#%8L Olimex &&ift2s, Ml
F Gowin FTDI USB Zrf258 .

Project Language C C Wit &
C++ CH+mfiiE 5
Chip Profile GOWIN-AE350: ADP- | #5E RiscV_AE350_SOC

AE350-A25-GOWIN

2.  “C Project” XJiEHE, 455%E Project name. Location. Project type
fil Toolchains, i “Next”, WK 2-2 fliw.

Bl

Project name: ae350_demo
Location: D:\RDS\workspace
Project type: Empty Project
Toolchains: nds32le-elf-mculib-v5

MUG1025-1.3 17(143)




2 QARSI TR 2.1 QUEHA TR

& 2-2 BIEHM CHRHTE
A C Project O X
C Project ——

Create C project of selected type
Chip Profile: ADP-AE350-A25-GOWIN L —

Project name: aeESD_demo|

Use default location

D:\RDSS5\workspace\ae350 demo Browse...
default
Project type: Toolchains:
v = Andes Executable | [ nds32le-elf-meulib-v5 A
& Empty Project nds32le-elf-meulib-vad
® Hello World ANSI C Project nds32le-elf-meulib-v5f
(= Andes Shared Library nds32le-elf-newlib-v5
(= Andes Static Library nds32le-elf-newlib-v5d
(= Makefile project nds32le-elf-newlib-vsf v

Show project types and toolchains only if they are supported on the platform

C Project X 1A A (1L T fC B W5k 2-2 Aiw
&R 2-2 C Project FHEHEETR

I (L= iR
Project type Empty Project B A TR
Toolchains nds32le-elf-mculib-v5 RDS {43 FF ) LR i T2 4%: MCUIib.

nds32le-elf-mculib-v5d Newlib:

nds32le-elf-mculib-v5f Newlib J& — 4 THR ARG C Bt
nds32le-elf-newlib-v5 MCUIib & — Mk B C &7, & T
nds32le-elf-newlib-v5d MCU M HFEF, AALHIE/NT Newlib,

nds32le-elf-newlib-v5f

Project name A TREMA, (RS LI A-Z0-9!
@%MNI1.-+,~_o
Location Use default location B TFE AR

3. REMETEMEE, Hlin “Debug” o “Release”, i “Finish”,
mE 2-3 frs.
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2 QARSI TR 2.1 QUEHA TR

[ 2-3 iREREFAFELE

Ac Project O =

Select Configurations —

Select platforms and configurations you wish to deploy on

Project type:  Andes Executable
Toolchains: nds32le-elf-meulib-v5

Configurations:

& Debug
i) Release

Select all

Deselect all

Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either an toolbar or an property pages.

@' Next = Einish Cancel

212 5INBANRETE

ZH LU PRSI O MHA TR R Y w37 TAE =S H
1. %# RDS #HE329% “File > Import”, W 2-4 Fios.
& 2-4 #%&#¥ File > Import

A C/C++ - - AndeSight RDS v5.1.1 - m| ®

File Edit Source Refactor WNavigate Search Project Run Window Help

New AsSHfsN > | Q.+ 4 - IR [Cuick Access] | % | R @ 4

Open File... " =
_ . . roject Creator I B
[ Open Projects from File System...

bn Configuration

Recent Files > Project Language
R » Create Project...
Close celew T AndeSim @ICE ICE @®c OC++
Close All Cerl+Shift+W  fle (Double dick to create project..)
Ctrl+S file Name Chip ID cPU
IN-AE350
Ctrl+Shift+5 P-AE350-A25-GOWIN ADP-AE350-A25-GOWIN [A25]
Revert
Move...
Rename... F2
Refresh F5
Convert Line Delimiters To >
Print... Ctrl+P
v Import.. ator | Preferences
i Export.. 5[] Properties| £ Problems| &9 Terminal | iz Function Co | s Static Stack | 2 Call Hierarc | = O
Properties Alt+Enter -
Switch Workspace , Is to display at this time.
Restart
Exit
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2 QARSI TR 2.1 QUEHA TR

2. 1E “Import” XJiEHEH, %EHF “General > Existing Projects into
Workspace”, H.ii “Next”, #ifd 2-5 fixs.

2-5 %3 General > Existing Projects into Workspace
O X

A Import

Select \“
Create new prajects from an archive file or directory. [EI

Select an import wizard:

type filter text

v [= General
J& Archive File
=% Existing Projects into Workspace
[} File System
1 Preferences
[} Projects from Folder or Archive

= C/C++

@' = Back Mext = Finish Cancel

3. &P “Select root directory”, MRS EIN—ANCA WA L,
ok “Select archive file”, 5| N—ANAF TERERES SO, M

“Browse...”, WK 2-6 FT7~.
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2 QARSI TR 2.1 BB TR

[#] 2-6 Import Projects

A import ] *
Import Projects __LI .
Select a directory to search for existing Eclipse projects. .-_-':. ‘.r
(@) Select root directory: || V| Browse...
(O Select archive file: Browse...
Prajects:
Select All
Deselect All
Refresh
Options

[]Search for nested projects

[JCopy projects into workspace

[JClose newly imported projects upon completion
[[JHide projects that already exist in the workspace

Working sets

[]Add project to working sets New...
Select...
(?3' = Back Mext = Finish Cancel

4. 1E “Import Projects” XFiHHEH, EFRANE S NI A TREE K46 S
4, H.idi “Select Folder” =% “Open”, 5| N#44 LFE.

5. EMEG AWMt TS, &5 “Copy projects into workspace”,
B “Finish”, @l 2-7 . EEXT SNBSS TRERELE SO,
ikt “Copy projects into workspace ”.
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2 U B TR 2.2 B TR

[# 2-7 #%&#¥ Copy projects into workspace

A Import O ®
Import Projects L
Select a directory to search for existing Eclipse projects. s J

@) Select root directory: |EARDSS\workspace\ae350_demo v|E Browse... i

() Select archive file: Browse..
Projects:
ae350_demo (EA\RDSS\workspace\ae330 demao) ‘ Select All
Options

[[]Search for nested projects
] Copy projects into workspace
[JClese newly imported projects upon completion

[JHide projects that already exist in the workspace

Working sets

[JAdd project ta working sets Mew...
praj g

Select...
l:?} = Back Mext = Einish Cancel

6. FEIH SR E E A LA s SN BT TR .

N IRAERS BRI AIZAT S NP RE, RDS ¥t Bahia sl
AR TGS, THENEZICE . WR RDS BAASLFFIIA
IR AT RO FrBC B e T B BRI S, SR Ries M E
@A %

22 RETEXH

fE LR PRI A TR, A TR AT UGN CAF A RS ST,
BH PR SO

2.2.1 SIANBBEHXH

1. EWH RS BT, A ik B TR, T hsg bkt
“Import...”, K 2-8 fiius.
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2 QARSI TR

2.2 Bk TR

MUG1025-1.3

& 2-8 i£#F Import...

File Edit S
Ml
75 Project Ex) B

= ae350_ x

C. B

Aﬁ Target Mz
& Runnin

& Target:

e
3.”:

o
*

5 26350 den &

A C/Cr+ - tmderioienne s s

MNew

Show in Local Terminal

Copy

Paste

Delete

Paste As Link
Source
Move...
Rename...
Import...
Export...
Build Project
Clean Project
Refresh
Close Project

Build Targets
Index

Build Configurations

Build Settings
Target Configuration

Flash Burner

Validate

Run As
Debug As
Profile As
Compare With

Restore from Local Histary..

File Explorer

>
>

Cerl+C
Cirl+V
Delete

F2

F5

Ctrl+”

- ] X
Window Help
F-REITE D [avick access] | 5| 21 @ 4
Creator 3 = 0
figuration Project Language

Create Project...

deSim ~ @ICE [ICE ~ @®C OC++

uble click to create project..)

ame Chip ID CPU
50
FO-AES-GOWIN ADP-AE350-A25-GOWIN [A25]

'references‘

= Pmpertieq BB Problems} P Terminaq ills Function CDW {illy Static Stack 1 % call Hierarc} = 0

=B
splay at this time.

A

2. f£ “Import” XHEHEH, #%# “General > File System”, #.il;

“Finish”, Wk 2-9 Fi~.

[# 2-9 %#¥ General > File System

Select

&Im ort
p

Import resources from the local file system into an existing project.

O X

R4

Select an import wizard:

type filter text

v = General

& Archive File

22 Existing Projects into Workspace

[} File System
] Preferences

= C/C++

[} Prajects from Folder or Archive

®

< Back

Einish Cancel

3. ft “File system” XifiES, M ANBHES| ARSI RIHE, B
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2 QARSI TR

2.2 Bk TR

MUG1025-1.3

“Browse...”, R VUIFHKRL.

4. f£ “File system” X&EHER rRAIAL B, A WoR B E 5] N SCIF %
17, ARERRIEAR S A S . AR IR AR B G NSO,
“Info folder” #i& & R E 5| AR A THE, B “Finish”, 1/ 2-10

I
2-10 IEFESIANBISCH

A Import O *
File system (o
-
Import resources from the local file system. L‘f KA
From directory: |D:\AndeSightS_RDS\worl-cspace\aeESD_dsp\src\demo v| Browse...
= dema [€] demo_dsp.c
Filter Types... Select All Deselect All
Into folder: |a5350_demo Browse...
Options
] Overwrite existing resources without warning
[]Create top-level folder
Advanced ==
(?3' = Back Mext = Cancel

5. REIWHRFEEHESME, 7TUEE S5 BB TR IR S
2.2.2 FiEIR/S 305
1. ARdrdkeE IR, MR FiEE “New > Source File” 5%

“Header File”, tnE 2-11 fix.
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2 QARSI TR

2.2 Bk TR

& 2-11 i%&+¥ New > Source File 8 Header File

A C/Cs - - red-cistinne.c1s
New

File Edit So

L Wil

[ Project Exp

Show in Local Terminal
B Copy
Paste
5 aa50.d Delete
- Paste As Link
Source
Move...
Rename...
is Import..
3 Export..
Build Project
Clean Project
Refresh

Close Praoject

Build Target
48 Target Mar S TR

Index

Build Configurations
5 Running g
o Targets Build Settings

B Target Configuration
n

Flash Burner

Validate

J RunAs

15 Debug As
Profile As
Compare With

Restore from Local History...

5 2e350 dem (= File Explorer

2. fF “New Source File”

>
>

Crl+C
Crl+Vv

Delete

F2

F5

Cirl+

o v v

o 3

Project...
File
File from Template

Folder

Class

Header File

Source File

[ Y EX o]

oA

Source Folder

C/C++ Project
Canvert to a C/C++ Praject (Adds C/C++ Nature)

Example...

Other...

Crl+N

eferences

[T Properties|[£ Problems | /™ Terminal| il Function Co | il Static Stack | 2® Call Hierarc =g

play at this time.

] = @+
= O

[m] X

Create Project...

Ll

5 “New Header File” %fiffEH, “Source

file” 2% “Header file” i A¥rFI¥/ L CAFRIAFR, BIEES 4. 8i.h,
“Template” TFHF|FRIEFE—MER, FUW “<None>”, Hi
“Finish”, Wk 2-12 s

& 2-12 S HFTA0ME/ LS

i~ || Configure..

A New Header File
Header File

Create a new header file.
Source folder: |a|3350_demo
Header file: |new_ﬂ|e.h
Template: ‘«Mone>

| Browse...

3. R [EITHH BHEE H AL,

MUG1025-1.3
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2 U B TR

2.3 B LR H AR

M AT I BESCAE, JFhadm 5 AR .

23 U TiEAFEE

e 5E A TRER) H b BC B =78 o B ARS8 H AR E B BN E .
DU P B A TR R B AR & .

1. AERdEENRM TR, Mhpdiks# “Target Configuration”, 40
& 2-13 ffizR.

SR

= NN

& 2-13 1%£+F Ta

rget Configuration

File Edit So
A -

7 Project Exp

1S ae350 d x

E

38 Target Mar
e Running

o Targets

ey
n

(]
¥

5 22350 deme

A C/Cht - - Amdmriota

New

Show in Local Terminal

& Copy

Paste

Delete

Paste As Link
Source
Move...

Rename...

Import...
Export...

Build Project
Clean Project
Refresh

Close Project

Build Targets
Index

Build Configurations

Build Settings
Target Configuration

Flash Burner

Validate

Run As

Debug As

Profile As

Compare With

Restore from Local History...

File Explorer

>
>
Ctrl+C
Crl+v
Delete

>

F2

F5

Cirl+

vov v v

- O X
indow Help
;e oo @
reator £ = 8
guration Praject Language
HeSim ~ @ ICE[ICE ®c Oc++ Create Project...
ble click to create project.)
e Chip ID cPU
0
b—AZS—GC}WIN ADP-AE350-A25-GOWIN [A25]
eferences
[T Properties | [2! Problems | & Terminal | lls Function Co | il Static Stack |2 Call Hierarc = 0
- M-
|
play at this time.
i

2. £ “Target Configuration” XJiEHEH, &+ “Chip Profile”, Hif;
“Browse...”, tnk& 2-14 fix.

MUG1025-1.3
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2 QARSI TR

2.3 B TR HARBCE

MUG1025-1.3

& 2-14 i%£#¥ Chip Profile

A Properties for ae330_demo

type filter text

Resource
Builders
w CfC++ Build
Build Variables
Environment
Logging
Settings
Target Configuration
Tool Chain Editor
C/C++ General
Project Matures
Project References
Run/Debug Settings
Task Tags
Validation

@

Target Configuration = v

Configuration: |Debug [ Active ] ~| | Manage Configurations...

Apply to All Configurations.

Chip Profile

ADP-AE330-A25-GOWIN Browse...

Target Settings

Connection Configuration

(O Simulator AndeSim ~  @ICE ICE | Bus1Port 1 [GWUSB-5>=vd1]

Arguments Settings

ICE Misc Arguments |

Clean and Rebuild Project
Clean project
Build project

£ >

Apply and Close Cancel

7£ “Select Target” XHEHEF, “Targets” EFHbr, Hlin “ADP-
AE350-A25-GOWIN”, H.i; “Select Toolchains”, FHig|&pik$E T A

B, Htn “nds32le-elf-mculib-v5”, B “OK”, #n1& 2-15 .

& 2-15 i%#¥ Targets #1 Toolchain

A select Target

Connection: | Local

Select Target: [Current: ADP-AE350-A25-GOWIN]

rsei/[LOCALHOST/~target/ADP-AE350-A25-GOWIN

A }:D Targets

ADP-AE350-A25-GOWIN

Toolchain

[15Select Toolchain: [Currently used: nds32le-elf-mculib-vSE

[ nds32le-elf-meculib-v3 ~

nds32le-elf-meulib-vsd
nds32le-elf-meulib-vaf

nds32le-elf-newlib-v5 v

ey =
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2 QARSI TR 2.3 B TR HARRCE

3. #E# “Target Settings”, R EHACE, WK 2-16 fin.
LUE
ICE:
- ICE
~ Bus 1 Port 1 [GWUSB-S >=v4.1]
2-16 JE#E Target Settings

A Properties for ae350_demo m] *
type filter text Target Configuration - v
Resource
Builders
s C/C++ Build Configuration: |Debug [ Active ] ~ |  Manage Configurations...
Build Variables
Environment
Logging Apply to All Configurations.
Settings Chip Profile
Target Cenfiguration
Tool Chain Editar ADP-AE350-A25-GOWIN Browse...
C/C++ General
Project Natures X
Project References BEiG SR HING
Run/Debug Settings Connection Configuration
Task T: .
oske 1892 O Simulator | AndeSim | @ICE [ICE | Bus1Port 1 [GWUSB-S>=vd1] ~
Validation
Argurments Settings
ICE Misc Arguments ||
Clean and Rebuild Project
Clean project
Build project
< >
":?)' Apply and Close Cancel

IR EFER A H ArAR, RDS B AF 2 B sl A & 7sdi A ) ICE 1
A

W% Andes AICE-MINI+ER S, ZiifaE HA R, Hlin
“SDP (2-wire)” = “Auto”, & 2-17 fiR.
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2 QARSI TR

2.3 B TR HARBCE

& 2-17 i%$¥ Connection Configuration:

Andes AICE-MINI+Zit 8

A properties for ae350_demo

type filter text
Resource
Builders
w C{C++ Build
Build Variables
Environment
Logging
Settings
Target Configuration
Tool Chain Editor
C/C++ General
Project Natures
Project References
Refactoring History
Run/Debug Settings
Task Tags
Validation

Target Configuration

Configuration:

Apply to All Configurations.
Chip Profile

Debug [ Active ]

~ | | Manage Configurations...

ADP-AE350-A25-GOWIN

Browse...

Target Settings

Connection Configuration

(O Simulator | AndeSim  ~

Arguments Settings

ICE Misc Arguments

Clean and Rebuild Project
Clean project
Build project

®ICE [ICE ~

Bus 1 Port 4 [AICE-MINI+]

SDP (2-wire)

DP (4-wire)

Apply and Close

Cancel

iRk A Gowin FTDI USB Zifeds, Wi 2-18 fiix.
B 2-18 #%#F Gowin FTDI USB 425§

.B Properties for ae330_demo

type filter text

Rescurce
Builders
~ C/C++ Build
Build Variables
Envirenment
Logging
Settings
Target Configuration
Tool Chain Editor
C/C++ General
Project Matures
Project References
Run/Debug Settings
Task Tags
Validation

Target Configuration

Configuration:

Apply to All Configurations.
Chip Profile

Debug [ Active ]

* | | Manage Configurations...

ADP-AE350-A25-GOWIN

Browse...

Target Settings

Connection Cenfiguration

(O Simulater AndeSim  ~

Arguments Settings

ICE Misc Arguments

Clean and Rebuild Project
[ Clean project
[ Build project

@ICE|ICE ~

Bus 1 Port 1[GWUSB-5 >=v4.1]

~

Cancel

R A Olimex A4y, W& 2-19 Fior.

MUG1025-1.3
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2 QARSI TR

2.3 B TR HARRCE

& 2-19 i%#F Olimex fHiX 25

A Properties for 2e350_demo

type filter text
Resource
Builders
v CfC++ Build
Build Variables
Environment
Logging
Settings
Target Configuration
Tool Chain Editor
C/C++ General
Project Natures
Project References
Run/Debug Settings
Task Tags
Validation

Target Configuration

Configuration: Debug [ Active ]

Apply to All Configurations.
Chip Profile

ADP-AE350-A25-GOWIN

Target Settings

Connection Configuration

(O Simulator AndeSim  ~

Arguments Settings

ICE Misc Arguments ‘

Clean and Rebuild Project
Clean project
Build project

O X
- - -
~| | Manage Configurations...
Browse...
@ ICE |ICE ~
Apply and Close Cancel

4. #%F¢ “Clean and Rebuild Project”, 5% 7E5¢ & H brlic B o 2 575 Hak
P TR, W 2-20 fios. “Clean project”, FTi&H &4} T
. “Build project”, F T4 TR .

[# 2-20 i%£#¥ Clean and Rebuild Project

A Properties for ae350_demo

type filter text
Rescurce
Builders
w C/C++ Build
Build Variables
Environment
Logging
Settings
Target Configuration
Tool Chain Editer
C/C++ General
Project Matures
Project References
Run/Debug Settings
Task Tags
Validation

Target Configuration

Configuration: |Debug [ Active]

Apply to All Configurations.
Chip Profile

*~ | Manage Configurations...

ADP-AE350-A23-GOWIN

Browse...

Target Settings
Cennection Configuration

(O Simulator | AndeSim ~ | @ICE ICE ~

Arguments Settings

Bus 1 Port 1 [GWUSB-5 >=v4.1] ~

ICE Misc Arguments |

Clean and Rebuild Project
Clean project
Build project

<

Cancel

Apply and Close

5. H.i; “Apply and Close”, &%k & 4 AL H brfic & -

MUG1025-1.3
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2 U B TR 2.4 FIHE RS

24 BNHERS

il Y DAL P 35 DO pE DRR IR % — PP RO B, L3R e A L
FERIRIE R G o

241 BEMERLE

FEIH SR B, A R e AR TR, PRSI E
“Build Configurations > Set Active”, E#—FiiEACE, BE L ATEIIR
3, WK 2-21 Fis.

2-21 % Build Configurations > Set Active

A Cice+ Aedoriols nne _ O %
ew >
File Edit n Window Help
— Show in Local Termina ] P :
A - o e} I
[of Cerl+C
Blpiie = “°PY " Lt Creator 52 =0
Paste Ctrl+V
< o3 K Delete Delete Configuration Project Language 8
& ae e A [ AndeSim | @ICE [ICE ~ ®C Oc++ Create Project...
S » . .
ouree Double click to create project..)
Move...
Rename. e Name Chip ID CPU
AE350
Ly Import.. E350-A25-GOWIN ADP-AE350-A25-GOWIN [A25]
4 Export..
Build Project
Clean Project
Refresh FS
Close Project
AT = Build Targets »
arget
Index R [—
R Build Configurations > Set Active » '+ 1Debug
F Run . 3 -, : =
%s |
2 Tary Build Settings Manage... 2 Release ion Co | il Static Stack |3® Call Hierarc
-
|8 Target Configuration Build Al T
A Flash Burner Cirl+* Clean Al
Validate Build Selected...
@ RunAs >
45 Debug As >
Profile As »
Compare With >
Restore from Local History...
S ae350, & File Explorer ; & A

242 EEWERE
S DL 5 T 1 5 3 5 O B TR A R

1. AEWH B E AR b, A e R TS, Rk ik ds
“Build Settings”, & 2-22 ffiir,
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& 2-22 i%&#¥ Build Settings

A c/C++ Aedofiols DO T AT _ O >
ew »
File Edit un  Window Help
Show in Local Terminal > . m— .
Bo- -7 oo i} 5| EE
Y C Ctrl+C
I Project & copy ’ lect Creator &2 = 3
Paste Ctrl+V
e o % Delete Delete  [configuration Project Language ‘
= =2 Paste As Link AndeSim v | @ICE [ICE ~ @®C OC++ Create Project..
Source * |iDouble dlick to create project..)
Move...
Rename... r f Name Chip ID cPU
AE350
&y Import.. }.Esso-Azs-Gowm ADP-AE350-A25-GOWIN [A25]
7 Export.
Build Project

Clean Project
Refresh F5
Close Project

}ETarget Build Targets >
Index b
% Rur Build Configurations , fr]Preferences _
% Tar Build Settings ] Properties| 2] Problems | & Terminal | illls Function Co | ills Static Stack |5 Call Hierarc = 8
8 Target Configuration . ~ -
N Flash Burner cules b display at this fime.
Validate
O RunAs >
45 Debug As ]
Profile As »
Compare With >

Restore from Local History...

£ ae350 (= File Explorer

7£ “Settings” XHEHES, “Tool Settings” LI K4H T 4 TRENE
A ARG B A e I, 2 N 75 SR E S ANE T, i 2-23 B

& 2-23 Tool Settings iZIR+

B Tool Settings & Build Steps Build Artifact Binary Parsers @ Error Parsers

# nds32le-elf-meulib-v5 Configurations
w 53 Andes C Compiler
(&2 Preprocessor
(£ Symbols
(&2 Directories
(22 Optimization
(2 Debugging
& Warnings
(# Miscellaneous
w 83 Andes C Linker
¥ General
2 Libraries
(£ Miscellaneous
(£ Loaded Address
~ B Andes Assembler
(£ General
~ B NM (symbol listing)
(& General
~ [ Readelf (ELF info listing)
& General
w 83 Objdump (disassembly)
¥ General
w 53 Objcopy (object content copy)
& General
w 53 Size (section size listing)
(£ General
~ B LdSaG Tool
(& General

2. #%&# “Andes C Compiler > Directories > Include paths (-1)”, & & #ft:
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(LR

“${workspace_loc:/${ProjName}/src/bsp/ae350}";
“${workspace_loc:/${ProjName}/src/bsp/config}’;
“${workspace_loc:/${ProjName}/src/bsp/driver/ae350}";
“${workspace_loc:/${ProjName}/src/bsp/driver/include}’;
“${workspace_loc:/${ProjName}/src/bsp/lib}’;
“${workspace_loc:/${ProjName}/src/demo}”.

2-24 & Andes C Compiler > Directories

B Tool Settings  # Build Steps Build Artifact Binary Parsers @ Error Parsers
(£ nds32le-elf-mculib-vS Configurations Include paths (-1} & a8 &

v &3 Andes C Compiler
@ Preprocessor

*${workspace loc/${ProjName}/src/bsp/ae350}"
"${workspace_loc;/${ProjName}/src/bspfconfig)”

@ Symbols "${workspace_loc;/${ProjNamel/src/bsp/driver/ae350)"
# Directories "${workspace_loc:/${ProjName}/src/bsp/driver/finclude}"
( Optimization "${workspace locy/${ProjName}/src/bsp/lib}”

*$lworkspace loc:/$(ProjName}/src/demo)”

(2 Debugging
(&2 Warnings
(£ Miscellaneous
~ B Andes C Linker
(& General
(& Libraries
(£ Miscellaneous
(# Loaded Address
~ B Andes Assembler
¥ General
w BB NM (symbol listing)
& General
~ 83 Readelf (ELF info listing)
&2 General
~ B Objdump (disassembly)
(£ General
~ &) Objcopy (object content copy)
(& General
~ [ Size (section size listing)
& General
w 83 LdSaG Tool
¥ General

3. #%# “Andes C Compiler > Optimization”, & &%t TR LR N
RAGRERLSE, ] 2-25 FioR.
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[& 2-25 i%#F Andes C Compiler > Optimization
B Tool Settings Build Steps Build Artifact [ii} Binary Parsers @ Error Parsers
& nds32le-elf-mculib-v5 Configurations | Optimization Level -Og : Optimize for speed with better debuggability than -01  ~

v [y Andes C Compiler
@ Preprocessor
# Symbols
(& Directories
# Optimization
# Debugging
= Warnings
# Miscellaneous
v B3 Andes C Linker
#2 General
 Libraries
% Miscellaneous
# Loaded Address
~ &) Andes Assembler
2 General
v 85 NM (symbal listing)
% General
~v ) Readelf (ELF info listing)
# General
v 5 Objdump (disassembly)
= General
v 83 Objcopy (object content copy)
= General
~ &) Size (section size listing)
& General
w 8 LdSaG Tool
% General

Code Model ‘medium

N

Other optimization flags

[ Link Time Optimization {-flto)
Remove unused function sections (-flunction-sections)

Remove unused data sections (-fdata-sections)

Optimization ik
%% 2-3 Optimization i%£IR

TR % 2-3 s

I

(L

ik

Optimization Level

-00: Do not optimize

-Og: Optimize for speed with
better debuggability than -O1
-01: Optimize for speed

-O2: Optimize more for speed
-03: Optimize most for speed
-Os1: Optimize for size

-Os2: Optimize more for size
-Os: Optimize most for size

SIRIA TR, B
TR R
T

Code Model

small
medium

large

2 2-4 Prow, fREMY
T, Kot AAEE I
1

Other optimization flags

FP 485 B At AL 12150

Link Time Optimization (-flto)

TFIR IR H]

DU IR Fr B 4%
I 8]

Remove unused function sections (-
ffunction-sections)

TFIR IR H]

I MIERAR 5| IR 45

/?\
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pril B & it
Remove unused data section (-fdata- VANCIESi FTMIBR AR 5] RIFE 75
sections) &
R 24 RIDHREY
AT AL Bt | text data rodata
small 4 32 firF-Hk (A
medium
large
RDS A ()9 &5 1R 2 AL BRARAL ) g P e . 3R 2-5 FIIH | — 1%
g PR AR I, TSN A 22 AL o
* 2-5 fIFH/MMIET
PR | ik
Code size -Os1 This option enables minimum code size optimizations.
Performance is still concerned.

-Os2 This option enables partial code size optimizations with little
performance concern.

-0OS3 (-Os) This option works the same as the -Os option to enable all
code size optimizations. Performance may seriously drop with
this option.

-0z Supported by LLVM only, this option works the same as -Os
option to enable all code size optimizations. Performance may
seriously drop with this option.

Code speed | -0O3 Sometimes the code size may increase dramatically after this
option is applied.
This is because -O3 also implies -finline-functions that can
expand the content of callee within the caller (See Table 17 for
enabled options at -O3). To avoid such function inlining
optimization, just use the option -fno-inline-functions.

-funroll-loops Use with GCC:

Unroll loops whose number of iterations can be determined at

compile time or upon entry to the loop. The compiler has a set

of heuristics to estimate whether to unroll loop or not.

Use with LLVM:

The compiler has a set of heuristics to estimate whether to

unroll loop or not, even if the number of iterations is uncertain

when the loop is entered. This option may make programs run
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more slowly if it loses locality after unrolling.

-funroll-all-loops

Use with GCC:

Unroll all loops, even if their number of iterations is uncertain
when the loop is entered. This option may make programs run
more slowly if it loses locality after unrolling.

Use with LLVM:

This option is accepted but ignored by clang.

-malways-align

Enforces 4-byte alignment on jump targets, return addresses
and function entries. The two options are to prevent extra
performance penalty due to misalignment. They are not
default applied at -Os (including -Os1, -Os2, -Os3, and -Oz)
since they may slightly increase code size.

-mcpu or -mtune

Optimizes the program for the given processor by
specification of the CPU name or series. For example, -
mcpu=a25 and -mtune=andes-25-series. Both options will
optimize the program according to processor feature such as
pipeline latency.

Undefined
behavior

-fno-delete-null-
pointer-checks

In the C language standard, programs cannot safely
dereference null pointers, and no code or data element
resides there. However, this assumption is not true in some
cases, especially for embedded platform. Thus, if you have to
dereference the memory address 0x00000000, please use -
fno-delete-null-pointer-checks to tell the compiler not to
optimize out null pointer checking.

-fno-strict-aliasing

In the compiler framework, it may enable strict aliasing
optimization on the assumption that the strictest aliasing rules
applicable to the language being compiled. If a program
contains pointer casting, it may break the strict aliasing rule.
Therefore, it would be better not to use pointer casting in your
programs. If you must use it, having the option -fno-strict-
aliasing is recommended. Otherwise, the execution result may
be unexpected.

-fwrapv

The C language standard considers the overflow of a signed
value is undefined behavior. That means a valid program must
never generate signed overflow when computing an
expression and the compiler is able to perform some
optimization under such condition. If you must have invalid
code containing signed overflow, please compile it with -
fwrapv, which tells the compiler to treat signed overflow as
wrapping.
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-mfma

The option -fma is used to generate floating-point fused
multiply-add (FMA) instructions. It is enabled by default in
RDS Compiler to increase the performance, albeit an unsafe
floating-point math optimization which may decrease
precision. If you need a program result compatible with IEEE
754, use -mno-fma to disable this optimization.

MUG1025-1.3

4. #%# “Andes C Compiler > Debugging”, & 7& % TR IR,
ﬁl:l IZEI 2'26 Fﬁﬂ—‘—\‘o

1 -

Debug Level: Maximum (-g3)

[# 2-26 i%£#¥ Andes C Compiler > Debugging

B Tool Settings & Build Steps

Build Artifact Binary Parsers @ Error Parsers

w 53 Andes C Compiler
(&2 Preprocessor
(£ Symbols
(&2 Directories
(22 Optimization
(22 Debugging
& Warnings
(# Miscellaneous
w 83 Andes C Linker
¥ General
2 Libraries
(£ Miscellaneous
(£ Loaded Address
~ B Andes Assembler
(£ General
~ B NM (symbol listing)
(& General
~ [ Readelf (ELF info listing)
& General
w 83 Objdump (disassembly)
¥ General

& General

w 53 Size (section size listing)
(£ General

~ B LdSaG Tool
(& General

@ nds32le-elf-mculib-vS Configurations Debug Level

w 53 Objcopy (object content copy)

Maximum (-g3) ~

None

Minimal (-g1)

Generate gprof inforDefault (-g2 equal to -g)

Generate prof inform et

Other debugging flags

5. %# “Andes C Compiler > Miscellaneous”, #55& #f TR (1) HoAth 4w 13
BRI, P 2-27 s

1 -

Other flags: -c -fmessage-length=0 -fno-builtin -fomit-frame-pointer -

fno-strict-aliasing;

Compiler to use: gcc
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& 2-27 i£$#F Andes C Compiler > Miscellaneous

® Tool Settings Build Steps

(£ nds32le-elf-mculib-vS Configurations
v &3 Andes C Compiler
@ Preprocessor
# Symbols
(¥ Directories
(%2 Optimization
(2 Debugging
(&2 Warnings
(22 Miscellaneous
~ B Andes C Linker
(& General
(& Libraries
(£ Miscellaneous
(# Loaded Address
~ B Andes Assembler
¥ General
w BB NM (symbol listing)
& General
~ 83 Readelf (ELF info listing)
&2 General
~ B Objdump (disassembly)
(£ General
~ &) Objcopy (object content copy)
(& General
~ [ Size (section size listing)
& General
w 83 LdSaG Tool
¥ General

Build Artifact [5) Binary Parsers @ Error Parsers

“IVerbose (-v)

“lSupport ANSI programs (-ansi)
TlCode Coverage (--coverage)
_|Single Precision Constant
“1Apply HW DSP options

Other flags -c -fmessage-length=0 -fno-builtin -fomit-frame-pointer -fno-strict-aliasing
Zompiler to use | gec ~
< >

Miscellaneous &b Nk 2-6 Fr~.

% 2-6 Miscellaneous %I

builtin -fomit-frame-pointer -fno-
strict-aliasing

bl L= Eiipa
Other flags -c -fmessage-length=0 -fno- -fmessage-length=N: #0105

wRIEE, BAMENO

INIEN]

Code Coverage (--coverage)

(NEE: 5 &

INIEN]

Single Precision Constant

R EE RN R

Apply HW DSP options AW =IP N

SCFF DSP ISA 7 i i 1

Compiler to use gcc

llvm

&M TR AL LLVM Al GCC
%45 RDS RISC-V elf TH
i

RDS #4414 1% 28 1 GNU A1 LLVM # & ek, 484 7 GNU [ gee.

as Ml 1d &I L K LLVM [ clang 1 1d %7
Gb, IR BERRR R RR AL 1 RR R () T,

K7 GNU FI LLVM itz
151 G4 BE AN K ASE ) T~

RDS # {1 GCC & ¥ ek TN R 2-7 o

MUG1025-1.3

38(143)




2 UM TR

2.4 FIHE RS

= 2-7 GCC 4miEsFiEI

GCC i i A 1% 131

Eitipay

-pass-exit-codes

Exit with highest error code from a phase.

--help Display this information.

--target-help Display target specific command line options.
--version Display compiler version information.
-dumpspecs Display all of the built in spec strings.

-dumpversion

Display the version of the compiler.

-dumpmachine

Display the compiler's target processor.

-print-search-dirs

Display the directories in the compiler's search path.

-print-libgcc-file-name

Display the name of the compiler's companion library.

-print-file-name=<lib>

Display the full path to library <lib>.

-print-prog-name=<prog>

Display the full path to compiler component <prog>.

-print-multiarch

Display the target's normalized GNU triplet, used as a component in the
library path.

-print-multi-directory

Display the root directory for versions of libgcc.

-print-multi-lib

Display the mapping between command line options and multiple library
search directories.

-print-multi-os-directory

Display the relative path to OS libraries.

-print-sysroot

Display the target libraries directory.

-print-sysroot-headers-
suffix

Display the sysroot suffix used to find headers.

-Wa,<options>

Pass comma-separated <options> on to the assembiler.

-Wp,<options>

Pass comma-separated <options> on to the preprocessor.

-WI,<options>

Pass comma-separated <options> on to the linker.

-Xassembler <arg>

Pass <arg> on to the assembiler.

-Xpreprocessor <arg>

Pass <arg> on to the preprocessor.

-Xlinker <arg>

Pass <arg> on to the linker.

-save-temps

Do not delete intermediate files.

-save-temps=<arg>

Do not delete intermediate files.

-no-canonical-prefixes

Do not canonicalize paths when building relative prefixes to other gcc
components.

-pipe

Use pipes rather than intermediate files.

-time

Time the execution of each subprocess.

-specs=<file>

Override built-in specs with the contents of <file>.

MUG1025-1.3
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Eitipay

-std=<standard>

Assume that the input sources are for <standard>.

--sysroot=<directory>

Use <directory> as the root directory for headers and libraries.

-B <directory>

Add <directory> to the compiler's search paths.

-V Display the programs invoked by the compiler.

-E Preprocess only; do not compile, assemble or link.

-S Compile only; do not assemble or link.

-C Compile and assemble, but do not link.

-0 <file> Place the output into <file>.

-pie Create a position independent executable.

-shared Create a shared library.

-mabi= Specify integer and floating-point calling convention.
-mace Compile with ACE.

-mace-s2s= Argument for pass to ACE source-to-source translator.

-malways-align

Always align function entry, jump target and return address.

-march= Generate code for given RISC-V ISA (e.g. RV64IM). ISA strings must be
lower-case.

-matomic Use atomic extension instructions.

-mbf16 Support BFLOAT16 conversion extension

-mb20282 Avoid conditional jump erratum

-mbranch-cost=N

Set the cost of branches to roughly N instructions.

-mcmodel= Specify the code model.

-mconfig-mul= Specify configuration of instruction mul.

-mcpu= -mcpu=PROCESSOR Optimize the output for PROCESSOR. Same as -
mtune=.

-mctor-dtor Enable constructor/destructor feature.

-mdiv Use hardware instructions for integer division.

-mexecit Use special directives to guide linker to perform exec.it optimization.

-mexplicit-relocs

Use %reloc() operators, rather than assembly macros, to load
addresses.

-mext-dsp

Use hardware DSP instructions.

-mext-vector

Use vector instructions.

-mext-zbabcs

Use RVB hardware instructions including zba, zbb, zbc, zbs.

-mfdiv Use hardware floating-point divide and square root instructions.
-mfma Generating fma instructions.
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Eitipay

-mgp-insn-relax

Use special directives to guide linker doing gp insn relax optimization.

-minnermost-loop

Insert the innermost loop directive.

-mmove-bytes-per-loop=

-mmove-bytes-per-loop=N Set <N> bytes of data movement can be
handled per loop iteration.

-mno-16-bit Do not generate C extension instructions.

-mplt When generating -fpic code, allow the use of PLTs. Ignored for fno-pic.
-mpreferred-stack- Attempt to keep stack aligned to this power of 2.

boundary=

-mrelax Take advantage of linker relaxations to reduce the number of

instructions required to materialize symbol addresses.

-mrestrict-even-reg-for-
regpair

Restrict register pair must start with even register number.

-msave-restore

Use smaller but slower prologue and epilogue code.

-msmall-data-limit=N

Put global and static data smaller than <number> bytes into a special
section (on some targets).

-mstrict-align

Do not generate unaligned memory accesses.

-mtune=PROCESSOR

Optimize the output for PROCESSOR.

-mvh Enable Virtual Hosting support.
-mzfh Support Zfh half-precision floating-point extension.

RDS ) LLVM % Pk a5 B I 41 3% 2-8 Fios .

% 2-8 LLVM 4RiEe5iEIN

LLVM % %45 3L 151 Eitipa
-HHiH Print (but do not run) the commands to run for this compilation
-B <dir> Add <dir> to search path for binaries and object files used implicitly
-C Only run preprocess, compile, and assemble steps
-E Only run the preprocessor
--help-hidden Display help for hidden options
-help Display available options
-o <file> Write output to <file>
-no-canonical-prefixes Use relative instead of canonical paths
-pipe Use pipes between commands, when possible
-print-file-name=<file> Print the full library path of <file>
-print-libgcc-file-name Print the library path for the currently used compiler runtime library
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("libgcc.a" or "libclang_rt.builtins.*.a")

-print-multi-directory

Print the directory name corresponding to the supported multilib

-print-multi-lib

Print the mapping from command line options to multilib search directories

-print-prog-
name=<prog>

Print the full program path of <name>

-print-search-dirs

Print the paths used for finding libraries and programs

-save-temps=<value>

Save intermediate compilation results.

-save-temps

Save intermediate compilation results

-std=<value>

Language standard to compile for

--sysroot=<value>

Set the root directory for headers and libraries

-S

Only run preprocess and compilation steps

-time Time individual commands

--version Print version informatio

-V Show commands to run and use verbose output

-Wa,<arg> Pass the comma separated arguments in <arg> to the assembler
-Wl,<arg> Pass the comma separated arguments in <arg> to the linker
-Wp,<arg> Pass the comma separated arguments in <arg> to the preprocessor

-Xassembler <arg>

Pass <arg> to the assembler

-Xlinker <arg>

Pass <arg> on to the linker.

-Xpreprocessor <arg>

Pass <arg> on to the preprocessor.

-X <language>

Treat subsequent input files as having type <language>

-mabi=<value>

Set the RISC-V ABI

-mace-s2s=<value>

Argument for pass to ACE source-to-source translator.

-mace

Compile with ACE.

-malways-align

Always align function entry, jump target and return address.

-march=<value>

Set the RISC-V architecture

-matomic Use atomic extension instructions.

-mb20282 Avoid conditional jump erratum

-mb22827.1 Insert a NOP after FSHW conditionally

-mb22827 Insert a fclass.x after FDIV.x/FSQRT.x conditionally
-mbf16 Enable bf16 support

-mcmodel=<value>

Specify the code model.

-mctor-dtor Enable constructor/destructor feature
-mdiv Use hardware instructions for integer division
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-mexecit Use special directives to guide linker doing execit optimization.
-mext-dsp Enable DSP support

-mext-zbabcs

Use RVB hardware instructions including zba, zbb, zbc, zbs.

-mfdiv

Use hardware floating-point divide and square root instructions.

-mgp-insn-relax

Use special directives to guide linker doing gp insn relax optimization.

-mict-model=<value>

Specify the address generation strategy for ICT call's code model

-minnermost-loop

Insert the innermost loop directive.

-mno-16-bit

Do not generate C extension instructions.

-mrelax

Enable linker relaxation

-msave-restore

Use smaller but slower prologue and epilogue code

-msmall-data- Put global and static data smaller than <number> bytes into a special
limit=<value> section.
-mstrict-align Force all memory accesses to be aligned (same as mno-unaligned-access
-mvh Enable link virtual hosting
-mzfh Enable zfh support
6. % “Andes C Linker > General”, &% /F TIEMBERETL, WK
2-28 Firne
flan:
Do not use standard start files (-nostartfiles): )5 ;
Linker Script (-T): $(LDSAG_OUT)
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& 2-28 i%&#¥ Andes C Linker > General

B Tool Settings Build Steps Build Artifact Binary Parsers @ Error Parsers

(£ nds32le-elf-mculib-v5 Configurations [ Do not use standard start files (-nostartfiles)

~ & Andes C Compiler [JDo not use default libraries (-nodefaultlibs)
(& Preprocessor [JNo startup or default libs (-nostdlib)
@ Symbals [JOmit all symbol information (-s)

(=2 Directories
(& Optimization
(& Debugging
# Warnings [Jwrite a map file. (-Map)
@ Miscellaneous [virtual Hosting (-mvh)

~ 3 Andes C Linker
& General

No shared libraries (-static)

Linker Script (-T) | $(LDSAG_OUT) Browse...

# Libraries
# Miscellaneous
# Loaded Address

w 53 Andes Assembler
& General

w B3 NM (symbol listing)
& General

~ 53 Readelf (ELF info listing)
& General

~ B Objdump (disassembly)
& General

~ B Objcopy (object content copy)
(& General

~ &) Size (section size listing)
& General

~ &) LdSaG Tool
& General

General LT R UNE 2-9 Fx.

% 2-9 General i£IR
pril [ Eii3%
Do not use standard start files | JT /5 /5% ] JRTT A eI I, AL FPRAER) start SO
(-nostartfiles)
Linker Script (-T) $(LDSAG_OUT) KT “LdSaG Tool > General”, WXL 48E

SaG A, A TR A A th SaG
SRR, BT hfEE

Write a map file. (-Map) VAN I P “map.txt” SCHE

Virtual Hosting (-mvh) AR EIE G WS L ENL, W LB 110 B4 1 H bRtk
(¥ 1/0 1 3K € 7 21| 415 1) GDB

7. 1%&# “Andes C Linker > Libraries”, &5 8tk T R854 1AM 4 1
W 2-29 Fiw.

i an:
Libraries (-I):
- dsp

- m
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& 2-29 i%&+¥ Andes C Linker > Libraries
B Tool Settings & Build Steps Build Artifact Binary Parsers @ Error Parsers
(# nds32le-elf-mculib-v5 Configurations Libraries (-I) & 8 3
~ & Andes C Compiler dop

@ Preprocessor
% Symbols
(# Directories
# Optimization
(£ Debugging
& Warnings
(& Miscellaneous
~ &) Andes C Linker
% General
% Libraries
(# Miscellanecus
(2 Loaded Address
~ B Andes Assembler
= General
~ B NM (symbol listing)
% General
w 83 Readelf (ELF info listing)
# General
~ 83 Objdump (disassembly)
# General
~ 83 Objcopy (object content copy)
% General
w 83 Size (section size listing)
# General
w 83 LdSaG Tool

# General

Library search path (-1

&

Libraries IR 413k 2-10 fis.

%% 2-10 Libraries %15
e T5i Eiipa
Libraries (-1) 8 8 A TR BE R AN AR 22, 1 dsp library

math library, nn library &

Library search path (-L)

A ERERAF P I A

8. 1&# “Andes C Linker > Miscellaneous”, &5 &4 T2 1 HAh i 2
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& 2-30 i%£#F Andes C Linker > Miscellaneous

¥ Tool Settings Build Steps

(% nds32le-elf-meulib-v5 Configurations
~ 8 Andes C Compiler
@ Preprocessor

Linker flags |

Build Artifact [0} Binary Parsers @ Error Parsers

Other options (-Xlinker [option]) £

(2 Symbals

(22 Directories

(# Optimization

(% Debugging

(% Warnings

(% Miscellaneous
~ 8 Andes C Linker

(2 General

# Libraries

(% Miscellaneous

(% Loaded Address
~ B3 Andes Assembler

(% General

v B NM (symbol listing)

Other objects £

(2 General
v [ Readelf (ELF info listing)
(% General
~ 3 Objdump (disassembly)
(= General
~ 5 Objcopy (object content copy)
(2 General
~ [ Size (section size listing)
(# General
~ B LdSaG Tool

(% General

RDS A IR AR IR IR I3 2-11 Pos.

F+ 2-11 SEHERRIEIN
B e A 1 T ik

--allow-multiple-definition

Allow multiple definitions

--as-needed

Only set DT_NEEDED for shared libraries if used

--auxiliary <value>

Set DT_AUXILIARY field to the specified name

--Bdynamic Link against shared libraries
--Bshareable Build a shared object
--Bstatic Do not link against shared libraries

--Bsymbolic-functions

Bind defined function symbols locally

--Bsymbolic

Bind defined symbols locally

--build-id=<value>

Generate build ID note

--build-id Generate build ID note

--b <value> Change the input format of the inputs following this
option

--call_shared Link against shared libraries

--color-diagnostics=<value>

Use colors in diagnostics

--color-diagnostics

Use colors in diagnostics

--compress-debug-

Compress DWARF debug sections
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sections=<value>

--compress-debug-sections
<value>

Compress DWARF debug sections

--dc

Assign space to common symbols

--define-common

Assign space to common symbols

--defsym=<value>

Define a symbol alias

--defsym <value>

Define a symbol alias

--demangle

Demangle symbol names

--disable-new-dtags

Disable new dynamic tags

--discard-all

Delete all local symbols

--discard-locals

Delete temporary local symbols

--discard-none

Keep all symbols in the symbol table

--dn

Do not link against shared libraries

__dp

Assign space to common symbols

--dynamic-linker=<value>

--dynamic-linker <value>

Which dynamic linker to use
Which dynamic linker to use

--dynamic-list=<value>

Read a list of dynamic symbols

--dynamic-list <value>

Read a list of dynamic symbols

-_dy

Link against shared libraries

-d

Assign space to common symbols

--eh-frame-hdr

Request creation of .eh_frame_hdr section and
PT_GNU_EH_FRAME segment header

--emit-relocs

Generate relocations in output

--enable-new-dtags

Enable new dynamic tags

--end-lib

End a grouping of objects that should be treated as
if they were together in an archive

--entry=<entry>

Name of entry point symbol

--entry <entry>

Name of entry point symbol

--error-limit=<value>

Maximum number of errors to emit before stopping
(0 = no limit)

--error-limit <value>

Maximum number of errors to emit before stopping
(0 = no limit)

--error-unresolved-symbols

Report unresolved symbols as errors

--exclude-libs=<value>

Exclude static libraries from automatic export

--exclude-libs <value>

Exclude static libraries from automatic export
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--export-dynamic-
symbol=<value>

Put a symbol in the dynamic symbol table

--export-dynamic-symbol
<value>

Put a symbol in the dynamic symbol table

--export-dynamic

Put symbols in the dynamic symbol table

-E

Put symbols in the dynamic symbol table

-e <value>

Name of entry point symbol

--fatal-warnings

Treat warnings as errors

--filter=<value>

Set DT_FILTER field to the specified name

--filter <value>

Set DT_FILTER field to the specified name

--fini=<symbol>

Specify a finalizer function

--fini <symbol>

Specify a finalizer function

--force-exe-suffix

Force generation of file with .exe suffix

--format=<input-format>

Change the input format of the inputs following this
option

--format <input-format>

Change the input format of the inputs following this
option

--full-shutdown

Perform a full shutdown instead of calling _exit

-F <value> Set DT_FILTER field to the specified name

-f <value> Set DT_AUXILIARY field to the specified name
--gc-sections Enable garbage collection of unused sections
--gdb-index Generate .gdb_index section

--hash-style=<value>

Specify hash style (sysv, gnu or both)

--hash-style <value>

Specify hash style (sysv, gnu or both)

--help Print option help

-h <value> Set DT_SONAME

--icf-data Enable ICF to also fold identical read only data
--icf=all Enable identical code folding

--icf=none Disable identical code folding

--image-base=<value>

Set the base address

--image-base <value>

Set the base address

--init=<symbol>

Specify an initializer function

--init <symbol>

Specify an initializer function

--just-symbols=<value>

Just link symbols
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--just-symbols <value>

Just link symbols

--library-path=<dir>

Add a directory to the library search path

--library-path <dir>

Add a directory to the library search path

--library=<libName>

Root name of library to use

--library <libName>

Root name of library to use

--lto-aa-pipeline=<value>

AA pipeline to run during LTO. Used in conjunction
with -lto-newpm-passes

--lto-newpm-
passes=<value>

Passes to run during LTO

--lto-O<opt-level>

Optimization level for LTO

--lto-partitions=<value>

Number of LTO codegen partitions

-L <value>

Add a directory to the library search path

-l <value>

Root name of library to use

--Map=<value>

Print a link map to the specified file

--Map <value>

Print a link map to the specified file

--mexecit-limit=<value>

Maximum number of entries in exec.it table

--mexecit-loop-aware

Avoid generating exec.it instruction inside loop

--mexecit

Perform exec.it optimization

--mexport-execit=<value>

Export exec.it table after linking

--mexport-
symbols=<value>

Export defined global symbols in form of linker script

--mimport-execit=<value>

Import exec.it table

--mkeep-import-
execit<value>

Keep exec.it table

--mno-execit

Don't perform exec.it optimization.

--mupdate-execit<value>

Update exec.it table

-M

Print a link map to the standard output

-m <value>

Set target emulation

--no-as-needed

Always DT_NEEDED for shared libraries

--no-color-diagnostics

Do not use colors in diagnostics

--no-define-common

Do not assign space to common symbols

--no-demangle

Do not demangle symbol names

--no-dynamic-linker

Inhibit output of .interp section

--no-eh-frame-hdr

Do not create .eh_frame_hdr section
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--no-gc-sections

Disable garbage collection of unused sections

--no-gdb-index

Do not generate .gdb_index section

--no-gnu-unique

Disable STB_GNU_UNIQUE symbol binding

--no-omagic

Do not set the text data sections to be writable

--no-print-gc-sections

Do not list removed unused sections

--no-relax

Do not perform linker relaxation to reduce code size

--no-rosegment

Do not put read-only non-executable sections in
their own segment

--no-threads

Do not run the linker multi-threaded

--no-undefined-version

Report version scripts that refer undefined symbols

--no-undefined

Report unresolved symbols even if the linker is
creating a shared library

--no-whole-archive

Restores the default behavior of loading archive
members

--noinhibit-exec

Retain the executable output file whenever it is still
usable

--non_shared Do not link against shared libraries

--nopie Do not create a position independent executable

--nostdlib Only search directories specified on the command
line

-N Set the text and data sections to be readable and

writable

--oformat <format>

Specify the binary format for the output object file

--omagic

Set the text and data sections to be readable and
writable

--opt-remarks-filename
<value>

YAML output file for optimization remarks

--opt-remarks-with-hotness

Include hotness informations in the optimization
remarks file

--orphan-handling=<value>

Control how orphan sections are handled when
linker script used

--orphan-handling <value>

Control how orphan sections are handled when
linker script used

--output=<value>

Path to file to write output

--output <value>

Path to file to write output

-0 <value>

Optimize output file size
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-0 <path>

Path to file to write output

--pack-dyn-relocs=<format>

Pack dynamic relocations in the given format (none
or android)

--pic-executable

Create a position independent executable

--pie

Create a position independent executable

--plugin-opt=<value>

specifies LTO options for compatibility with GNU
linkers

--plugin-opt <value>

specifies LTO options for compatibility with GNU
linkers

--print-gc-sections

List removed unused sections

--print-map Print a link map to the standard output

-q Generate relocations in output

--relax Perform linker relaxation to reduce code size
--relocatable Create relocatable object file

--reproduce=<value>

Dump linker invocation and input files for debugging

--reproduce <value>

Dump linker invocation and input files for debugging

--retain-symbols-file=<file>

Retain only the symbols listed in the file

--retain-symbols-file <file>

Retain only the symbols listed in the file

--rpath=<value>

Add a DT_RUNPATH to the output

--rpath <value>

Add a DT_RUNPATH to the output

--rsp-quoting=<value>

Quoting style for response files. Values supported:
windows|posix

--rsp-quoting <value>

Quoting style for response files. Values supported:
windows|posix

-R <value>

Alias to --rpath or --just-symbols

-r

Create relocatable object file

--script=<value>

Read linker script

--script <value>

Read linker script

--section-start <address>

Set address of section

--shared

Build a shared object

--soname=<value>

Set DT_SONAME

--soname <value>

Set DT_SONAME

--sort-section=<value>

Specifies sections sorting rule when linkerscript is
used

--sort-section <value>

Specifies sections sorting rule when linkerscript is

MUG1025-1.3
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--start-lib Start a grouping of objects that should be treated as
if they were together in an archive

--static Do not link against shared libraries

--strip-all Strip all symbols

--strip-debug Strip debugging information

--symbol-ordering-file
<value>

Layout sections in the order specified by symbol file

--sysroot=<value>

Set the system root

--sysroot <value>

Set the system root

-S

Strip debugging information

-S

Strip all symbols

--Tbss=<value>

Same as --section-start with .bss as the
sectionname

--Thss <value>

Same as --section-start with .bss as the
sectionname

--Tdata=<value>

Same as --section-start with .data as the
sectionname

--Tdata <value>

Same as --section-start with .data as the
sectionname

--thinlto-cache-dir=<value>

Path to ThinLTO cached object file directory

--thinlto-cache-policy
<value>

Pruning policy for the ThinLTO cache

--thinlto-jobs=<value>

Number of ThinLTO jobs

--threads

Run the linker multi-threaded

--trace-symbol=<value>

Trace references to symbols

--trace-symbol <value>

Trace references to symbols

--trace

Print the names of the input files

--Ttext-segment=<value>

Same as --section-start with .text as the
sectionname

--Ttext-segment <value>

Same as --section-start with .text as the
sectionname

--Ttext=<value>

Same as --section-start with .text as the
sectionname

--Ttext <value>

Same as --section-start with .text as the
sectionname
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-T <value>

Read linker script

-t

Print the names of the input files

--undefined=<value>

Force undefined symbol during linking

--undefined <value>

Force undefined symbol during linking

--unresolved-
symbols=<value>

Determine how to handle unresolved symbols

--unresolved-symbols
<value>

Determine how to handle unresolved symbols

-u <value>

Force undefined symbol during linking

--verbose

Verbose mode

--version-script=<value>

Read a version script

--version-script <value>

Read a version script

--version Display the version number and exit
-V Display the version number and exit
-V Display the version number

--warn-common

Warn about duplicate common symbols

--warn-unresolved-symbols

Report unresolved symbols as warnings

--whole-archive

Force load of all members in a static library

--wrap=<symbol>

Use wrapper functions for symbol

--wrap <symbol>

Use wrapper functions for symbol

-X Delete temporary local symbols
-X Delete all local symbols

-y <value> Trace references to symbols

-z <option> Linker option extensions

9. %&FF “Andes Assembler > General”, 155 # 4 TR gL T 51 H 1

SR B AR G 2 1 T30

ﬁu 2'31 ﬁﬁ/j——\‘o
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& 2-31 i%&#¥ Andes Assembler > General

& Tool Settings Build Steps Build Artifact Binary Parsers @ Error Parsers

(22 nds32le-elf-meulib-v5 Configurations Include paths (-1) £
~ 3 Andes C Compiler
(22 Preprocessor

22 Symbals
(22 Directories
# Optimization
(22 Debugging
22 Warnings
22 Miscellansous
w 133 Andes C Linker
22 General
(22 Libraries
22 Miscellansous
(22 Loaded Address
~ 3 Andes Assembler
(= General
v 5 NM (symbol listing)
(2 General
~ %3 Readelf (ELF info listing)
(2 General
~ 53 Objdump (disassembly)
(2 General
~ 3 Objcopy (object content copy)
(2 General
~ 183 Size (section size listing)
(2 General
v 5 LdSaG Tool
(2 General

O Suppress warnings (-W)

[J Announce version (-v)

Assembler flags |-g

RDS #AF L g A% 1B TR U1 3% 2-12 P

T 2-12 C4RaRIEm

T4 g I IR
-a[sub-option...] turn on listings

Sub-options [default hls]:

¢ omit false conditionals

d omit debugging directives

g include general info

h include high-level source

| include assembly

m include macro expansions

n omit forms processing

s include symbols

=FILE list to FILE (must be last sub-option)
--alternate initially turn on alternate macro syntax
--compress-debug- compress DWARF debug sections using zlib
sections[={none|zlib|zlib-gnu|zlib-
gabi}]
--nocompress-debug-sections don't compress DWARF debug sections [default]
-D produce assembler debugging messages
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--debug-prefix-map OLD=NEW

map OLD to NEW in debug information

--defsym SYM=VAL

define symbol SYM to given value

--execstack

require executable stack for this object

--noexecstack

don't require executable stack for this object

--size-check=[error|warning]

ELF .size directive check (default --size-check=error)

--elf-stt-common=[no|yes]

generate ELF common symbols with STT_COMMON type

--sectname-subst

enable section name substitution sequences

-f skip whitespace and comment preprocessing
-g --gen-debug generate debugging information
--gdwarf-2 generate DWARF2 debugging information

--gdwarf-sections

generate per-function section names for DWARF line
information

--hash-size=<value>

set the hash table size close to <value>

--help show this message and exi

--target-help show target specific options

- DIR add DIR to search list for .include directives

-J don't warn about signed overflow

-K warn when differences altered for long displacements

-L,--keep-locals

keep local symbols (e.g. starting with L")

-M,--mri assemble in MRI compatibility mode
--MD FILE write dependency information in FILE (default none)
-nocpp ignored

-no-pad-sections

do not pad the end of sections to alignment boundaries

-0 OBJFILE

name the object-file output OBJFILE (default a.out)

-R

fold data section into text section

--reduce-memory-overheads

prefer smaller memory use at the cost of longer assembly
times

--statistics

print various measured statistics from execution

--strip-local-absolute

strip local absolute symbols

--traditional-format

Use same format as native assembler when possible

--version print assembler version number and exit
-W --no-warn suppress warnings
--warn don't suppress warnings

--fatal-warnings

treat warnings as errors

MUG1025-1.3
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-Z

generate object file even after errors

--listing-lhs-width

set the width in words of the output data column of the
listing

--listing-lhs-width2

set the width in words of the continuation lines of the output
data column; ignored if smaller than the width of the first
line

--listing-rhs-width

set the max width in characters of the lines from the source
file

--listing-cont-lines

set the maximum number of continuation lines used for the
output data column of the listing

-fpic generate position-independent code

-fPIC same as -fpic

-fno-pic don't generate position-independent code (default)
-march=ISA set the RISC-V architecture

-mabi=ABI set the RISC-V ABI

-mno-16-bit don't generate rvc instructions

-matomic enable atomic extension

-mace Support user defined instruction extension
-01 optimize for performance

-Os optimize for space

-mext-dsp enable dsp extension

10. %&£ “NM  (symbol listing) > General”, #itH #5571 %5 8 5
“symbol.txt” ¢, WK 2-32 fis.
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& 2-32 i%#F NM (symbol listing) > General

B Tool Settings Build Steps Build Artifact [ Binary Parsers @ Error Parsers

(£ nds32le-elf-mculib-v5 Configurations [Disable. (Do not auto-generate output file.)

~ & Andes C Compiler [ Sort symbaols numerically by address. (-n)
(& Preprocessor [Include line numbers and filenames in output. (-1}
(% Symbols [ Decade low-level symbol names into user-level names. (-C)

= [ ; )
%’: D'réd‘?”els [ Display debugger-only symbols. (-a)
%; Op;\mlzatlon [ Print name of the input file before every symbol. (-4)
D i

(£ Bebugging [ Display only external symbols. {-g)
(& Warnings

# Miscellaneous Other flags |

~ 3 Andes C Linker
& General

# Libraries
# Miscellaneous
# Loaded Address

w 53 Andes Assembler
& General

w B3 NM (symbol listing)
& General

~ 53 Readelf (ELF info listing)
& General

~ B Objdump (disassembly)
& General

~ B Objcopy (object content copy)
(& General

~ &) Size (section size listing)
& General

~ &) LdSaG Tool
& General

NM (symbol listing)[] General 3£k i3 2-13 Fir.
%% 2-13 NM (symbol listing) ¥ General &I}

I Eitipay

Disable. (Do not auto-generate output file.) | < [AF5 513K 4 S

Sort symbols numerically by address. (-n) | {&HhEHEF 7 5507

Include line numbers and filenames in s B ST S M4
output. ()

Decode low-level symbol names into user- | X255 b A ] 2 9% 4 75
level names. (-C)

Display debugger-only symbols. (-a) WAL TS

Print name of the input file before every TERANTF S 2 AT FT BN NSO 44 FR
symbol. (-A)

Display only external symbols. (-g) B IRINT 5

11. %4 “Readelf (ELF info listing) > General”, #iiti ELF %1|3{5 B 3
“readelf.txt” M, Wik 2-33 fis.
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& 2-33 i£#¥ Readelf (ELF info listing) > General

B Tool Settings Build Steps Build Artifact Binary Parsers @ Error Parsers

(£ nds32le-elf-mculib-vS Configurations [Ipisable. (Do not auto-generate output file.)

v &3 Andes C Compiler EAEquivalent to: -h -| -G -5 -r -d -V -A - (-a)
(& Preprocessor [ Display the ELF file header. (-h)
(£ Symbols [ Display the program headers. (-))

(2 Directories [ Display the sections' header. (-5)

i) imizati
(22 Optimization [JDisplay the section groups. (-g)
[ Display the symbol table. (-s)

Other flags |

(2 Debugging
(&2 Warnings

(£ Miscellaneous
~ B Andes C Linker
(& General

(& Libraries
(£ Miscellaneous
(# Loaded Address

~ B Andes Assembler
¥ General

w BB NM (symbol listing)
& General

~ 83 Readelf (ELF info listing)
(2 General

~ B Objdump (disassembly)
(£ General

~ &) Objcopy (object content copy)
(& General

~ [ Size (section size listing)
& General

w 83 LdSaG Tool

¥ General

Readelf (ELF info listing) ] General £k 1% 2-14 Fios.
% 2-14 Readelf (ELF info listing) B9 General i%IR

Hic & Eif{)

Disable. (Do not auto-generate output KM ELF 3124 o
file.)

Display the ELF file header. (-h) 7R ELF SUHLE R
Display the program headers. (-I) BRETRER.
Display the sections’ header. (-S) TRBERER

Display the section groups. (-g) oA

Display the symbol table. (-s) TR ER.

12. i%&#% “Objdump (disassembly) > General”, %t [ IL 4 1s 5 5
“objdump.txt” SCHF, WK 2-34 Fis.
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& 2-34 i%#F Objdump (disassembly) > General

B Tool Settings Build Steps Build Artifact Io_ﬂ; Binary Parsers @ Error Parsers

(& Directories
(& Optimization
(& Debugging
(& Warnings

(# nds32le-elf-mculib-v5 Configurations [IDisable. (Do not auto-generate output fils.)

~ i Andes C Compiler [ Display the contents of all headers. (-x)
(# Preprocessor [1Display the contents of the section headers. (-h)
(£ Symbols Display assembler contents of executable sections. (-d)

[ Display the contents of the symbol table(s). (-t)
include line numbers and filenames in output. (-)

[ Decode mangled/processed symbol names. (-C)

(# Miscellaneous Other flags |

~ & Andes C Linker
(& General
(& Libraries
(& Miscellaneous
(& Loaded Address

~ 8 Andes Assembler
(& General

~ & NM (symbal listing)
(& General

~ &) Readelf (ELF info listing)
(& General

v & Objdump (disassembly)
(& General

~ &3 Objcopy (object content copy)
(& General

~ &} Size (section size listing)
(& General

v &3 LdSaiG Tool
(& General

Objdump (disassembly)f] General &b 1% 2-15 Fiis.

%% 2-15 Objdump (disassembly)Hy General iEIR

fic &

Eitipa

Disable. (Do not auto-generate output file.)

R P S i HE SO

Display the contents of all headers. (-x)

SR AT kAR B A

Display the contents of the section headers. (-h)

BRBELE RN AE

Display assembler contents of executable
sections. (-d)

R ATHRAT BUIC R AR e (0 N 7

Display the contents of the symbol table(s). (-t)

SR T R AR

Include line numbers and filenames in output. (-

1)

A B RS AT S A4

Decode mangled/processed symbol names. (-C)

fiprhLh 2 b PR PR A4 R

13. % “Objcopy (object content copy) > General”, & 4| H Az CHH-HI A
BB — A, — T4 Binary S0, & 2-35 iR

1 -

Disable. (Do not auto-generate output file.): <];

Create an output file in format: binary (Raw binary form)
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[& 2-35 i%#F Objcopy (object content copy) > General
& Tool Settings Build Steps Build Artifact &) Binary Parsers @ Error Parsers
(£ nds32le-elf-mculib-v5 Configurations [Disable. (Do not auto-generate output file.)
~ & Andes C Compiler [ Remove all symbal and relocation information. (-5)
(& Preprocessor [JRemove all debugging symbols _sections. (-g)
(& Symbols [JRemove all non-global symbals. (-x)
(£ Directories [JRemove any compiler-generated symbols. (-X)
(& Optimization X . .
Create an output file in format | binary (Raw binary form) ~

(& Debugging

(& Warnings Other flags

# Miscellaneous

~ 3 Andes C Linker
& General
# Libraries
# Miscellaneous
# Loaded Address

w 53 Andes Assembler
& General

w B3 NM (symbol listing)
& General

~ 53 Readelf (ELF info listing)
& General

~ B Objdump (disassembly)
& General

~ B Objcopy (object content copy)
(& General

~ &) Size (section size listing)
& General

~ &) LdSaG Tool
& General

Objcopy (object content copy) i General i iR a1 2-16 Fx.
% 2-16 Objcopy (object content copy)H General 3EIR

I

Eitipa

Disable. (Do not auto-generate output file.)

5% ] Object % i S

Remove all symbol and relocation
information. (-S)

] R RS R L DA P )

Remove all debugging symbols _sections. (-
9)

T P AT 5 B

Remove all non-global symbols. (-x)

MR A E RS

Remove any compiler-generated symbols. (-
X)

T A AT G P ™ A 5

Create an output file in format

88 HARSCIF R s, SCRFRATR 3
AT Ml A HE RS 2

binary (Raw binary form)

ihex (Intel Hex)

srec (Motorola S-record)

14. i%&¥#% “Size (section size listing) > General”, % Bok/INI R 15 B 5
“_PHONY.size” 3Cff, il 2-36 Fiir.
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& 2-36 i£#¥ Size (section size listing) > General

® Tool Settings Build Steps

v &3 Andes C Compiler
@ Preprocessor
# Symbols
(¥ Directories
(%2 Optimization
(2 Debugging
(&2 Warnings
(£ Miscellaneous
~ B Andes C Linker
(& General
(& Libraries
(£ Miscellaneous
(# Loaded Address
~ B Andes Assembler
¥ General
w BB NM (symbol listing)
& General
~ 83 Readelf (ELF info listing)
&2 General
~ B Objdump (disassembly)
(£ General

(& General

~ [ Size (section size listing)
(2 General

w 83 LdSaG Tool
¥ General

(£ nds32le-elf-mculib-vS Configurations

~ &) Objcopy (object content copy)

Build Artifact Binary Parsers @ Error Parsers

[JDisable. (Do not auto-generate output file.)

Other flags |

Size (section size listing)f] General £ TR WZR 2-17 Fis.
% 2-17 Size (section size listing) ) General i£I}

I

ik

Disable. (Do not auto-generate output file.)

K size iy SCH:

15. #%&# “LdSaG Tool > General”, f&5 SaG 4, HTre B84 TR
BEREIA SO, i 2-37 AT

4.

Generate linker script: T )5 ;

Linker script template:

$(ANDESIGHT_ROOT)/utils/nds32_template_v5.txt;
SaG file: ${ProjDirPath}/src/bsp/sag/ae350-ddr.sag
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2.5 FER AT TR

& 2-37 i%&+¥ 1LdSaG Tool > General

B Tool Settings

Build Steps Build Artifact Binary Parsers @ Error Parsers

~ i Andes C Compiler

~ & Andes C Linker

~ 8 Andes Assembler

~ & NM (symbal listing)

~ &) Readelf (ELF info listing)

v & Objdump (disassembly)

~ &3 Objcopy (object content copy)
~ &} Size (section size listing)

v &3 LdSaiG Tool

(# nds32le-elf-meulib-v5 Configurations Generate linker script

Linker script template |$(ANDESIGHT_ROOT),futiIs,t‘nd532_temp|ate_v5.bct | Browse...

@ Preprocessor

SaG file |${ProjDirPath]fsrc,-’bspfaeSSD—xip.sag | Browse...

(& Symbols

= o .
(#2 Directories Other flags |

(& Optimization
(& Debugging
(& Warnings

(# Miscellaneous
(& General

(& Libraries

(& Miscellaneous
(& Loaded Address
(& General

(& General

(& General

(& General

(& General

(& General

(E General

LdSaG Tool ] General £ Tifiid a1k 2-18 Frox.

R 2-18 LdSaG Tool B General j%Ii

15 T Eifi
Generate linker “PROJECT\BUILD_CONFIG\output” #4575~ — A 82 1
script A3, “Andes C Linker > General > Linker Script (-T):”

B HZ) BN “$(LDSAG_OUT)”

Linker script

TR M TP AR BE R A SO IR, Gowin

template RiscV_AE350_SOC #kiAA “nds32_template_v5.txt”
SaG file fRE—> SaG 3, Hlid nT HhAT WG A A7 L

16. e TR ENRE G, #idi “Apply and Close”.

2.5 R H T2

MUG1025-1.3

P B TR R R IR ACAS Ju g 52 H AR R ST AT AT S0
S WU DR A TR
S 2.4 AT RGUENLE R TR RS

i RDS B TEAL “ &7 (Build), 347 ik e s TR, T
SEHLHILEFE “Build Project”, MEHMF T, W& 2-38 fin.
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& 2-38 #gEHRET 72

A CiC++ - aenEn Ao -ein -
New >
File Edit So Window Help
B - Show in Local Terminal o - PO

Col Cirl+C
B projectbp = Y e Y

Paste Ctrl+V

#  Delete Delete Ekkkk kR kAR kR kkk ko k ko kk kR ko kK Rk kR KRk KKKk .
~ 15 2350 ¢

3 Binar
[l Inclue
= Debu
&= src Rename... F2
= ael5l

IO o o

i= Import..

Export... demo.h"”

Build Project

e OIS - m o m
Clean Project 0id)

27 Refresh F5

Close Project

}ﬁTarget == Build Targets >

Index
Build Configurations

UART demo e

% Running
o Targets Build Settings

= A O
Target Configuration & ¢ —.)l ikl @
[a2350_dema]

] Properties | [ Problems | @ Terminal | s Function Co | il Static Stack | -3 Call Hierarc = 0
x| B-riv

=

Flash Burner Ctrl+~

Validate
Run As
Debug As
Profile As

#* 0

Compare With

Restore from Local History...

S 22350 dem & File Explorer : i

3. fEIEH G AL E T IS UE AT TR A A

4. “PROJECT\BUILD_CONFIG\output” #4%, & FIA[HAT SCHRIF=4E
() oAt LA

2.6 BRSO

RDS %A DLk & A TR R nl $AT SO A, SCREDL R R Y
FIFRASTETF 0T BBV A BT A S HER T o R BUACHS U 43 BT 12
PE AN PR EPARES RN F P e LR A BRI AR B ASE . B aSHERR b 42
HEEEA™ 0B BN BEANFE PP BT F R HEARR RSN

My I TR S, RDS 84wt 2 B AT RS04 At DAZER)
BRI, SRU T SREEMEME, HFRERSST:

1. %+ RDS #fF3K ¥ “Window > Preferences”, 77

“Preferences” XfiffE .

2. “Preferences” XIiHtEH, 1L#F “C/C++ > Build > Static Analysis”.

3. “Static Analysis” XJiEHEH, 1EFE “Enable function code size
calculation” F1/¢ “Enable static stack analysis”, H.i7 “Apply and
Close”, WKl 2-39 A7 .
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& 2-39 B S E

A Preferences

type filter text
General
Binutils Preferences
v CfC++
Appearance
Autotools
» Build
Build Targets
Build Variables
Cansole
Environment
Logging
Makefile Editor
Settings
Static Analysis
CfC++ Project Tem
Code Style
Core Build Toolcha
Debug
Editor
File Types

Indexer

Static Analysis

General settings for Static Analysis
Execute static analysis after building projects
Enable function code size calculation

Enable static stack analysis

Execute static stack analysis calculation
[JEnable parsing C++ exception handling

Restore Defaults

Apply and Close

Apply

Cancel

!

C++IEF IEF S BN 8 7  AL BEA SR ACAD, 7 ot el AR, 5%

“Enable parsing C++ exception handling”.

WERES AT ERUGE RN, WA AEM @3 TR 5, i RDS ¥
T HA: “do -7 FHrFIF, #%F “1 Function Code Size”. “2 Static
Stack Analysis” B “3 Both Static Analyses”, /& 2-40 Ffin~.

2-40 FFRRFS S

A C/C++ - ae350_demo/src/demo/main.c - AndeSight RDS v5.1.1

File Edit Source Refactor Mavigate Search Project Run Window Help

- O X

G- G Rkl G808~ - G- ] |
[ Project Explorer 2 1 Function Code Size ct Creator main.c 52 =8
2 Static Stack Analysis Py
+ 1 20350 demo v 3 Both Static Analyses i o
4 Binaries Author @ GowinSemicoductor
!l Includes Chip 2_s0c
Function : Main functions
(= Debug
= src /
|Z] 2e350_demo Debug.launch -
T
#include "demo.h"
J/ DEFANEEAONS === === === === oo
5= int main(void)
16 {
17 i
18 // User application codes
19 [/
A Target Mana 2 5= Outline 29
21 // Run UART demo ¥
2] ‘ = ﬂl < >
5 Running Target
3=:” tg ¢ E Consale i1 . [ Properties| 2] Problems | & Terminal | illy Function Co |l Static Stack | 3 Call Hierarc = 0
¢ Targets
B EE AR e
CDT Build Console [ae350_demo]
Finished building: output/ae358_demo.bin A
Invoking: Size (section size listing)
riscvi2-elf-size "ae358_demo.adx” | tee output/.PHONY.size
text code rodata data bss dec hex filename
leess 9e88 968 @ 720 le776 2318 ae35@_demo.adx
Finished building: output/.PHONY.size
v
< >
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FFEFRA AT, 2B AR R A iR IEAE AT R . S HT e
g, BRI (Function Code Size View) FI/Ei A& HERR 20 Hr
MK (Static Stack Analysis View) SRiA IS B,

2.6.1 R BAIRILE

MUG1025-1.3

PR B RS AL B - B M R R R ) R MO S T OG5 2. I
M@wm%ﬁ%FEX%U@%M&%i%@ﬁ%ME,MEZAH%N

& 2-41 REARBRERE

& Console | [T Properties [ Problems | & Terminal |l Function Code § &2 llls Static Stack Anal | 23 Call Hierarchy = 04

= =

Binary File: fae350_demo/Debug/ae350_demo.adx --= Total Function Code Size: 7836 (User defined functions only)

Name Size File Line Path - K
demo_led 122 demo_led.c 58 d:\RDSS5\workspace\ae350 dema'\Debug), \src\demolled
gpio_callback 2 demo_led.c 47 d:\RDS5\workspacelae350_demao\Debug\,.\src\demotled
main 14 main.c 16 d:\RDSS\workspace\ae350_demo'Debug\,.\src\demo
get_core_freq 6 delay.c 25 d:\RDSS5\workspace\ae350_demo'\Debug\,.\src\bspllib
rdmcycle 18 delay.c 30 d:\RDSS\workspace\ae350_demo'\Debug\,.\srcibspllib
printchar 30 printf.c 25 d:\RDSS\workspace\ae350_demo'\Debug\,.\src\bspllib
prints 154 printf.c 43 d:\RDS5\workspace\ae350_demo\Debug\.\src\bspllib
printi 192 printf.c 99 d:\RDSS\workspace\ae350_demo\Debug\.\src\bsp\lib
print 362 printf.c 152 dARDSS\workspace\ae350_dema\Debugh.\src\bspllib
printf 34 printfc 251 dARDSS\workspace\ae350_dema\Debugh.\src\bspllib
simple_delay_ms 20 delay.c 55 d\RDSS\workspace\ae350_demo\Debug\.\src\bsp\lib
uart_init 52 uart.c 29 d\RDSS\workspace\ae350_demo\Debug\.\src\bsp\lib
outbyte 34 uartc 87 d\RDSS\workspace\ae350_demo\Debug\.\src\bsp\lib
uart_putc 18 uart.c 56 d:\RDSS\workspace\ae350_demo\Debug\.\src\bsp\lib
time 46 delay.c 49 d\RDSS\Workspace\aBSSD demo\Debug\ \src\bsp\hb v

< >

SR T3 5 7 B BR B A RS A0 Y, S B0 B A R RT DA 44 BRSO/
XS RR R, AT DA — A e BB L B A SO AL, & &
2-42 iR

B 2-42 EARHABAE

A Andes Project Creator [€] main.c [ demo_led.c &2 = 0
54} -
55

56 // Application entry function

int demo_led(void)

59 AE35@8_DRIVER_GPIO *GPIO_Dri = &Driver_GPIO;
uintd_t num = @;

uint32_t led_pin = @; /f This led

long begin_time = @;

long end_time = @;

long use_time = 8; W

B Consols | [T Properties [£] Problems | & Terminal |l Function Code § &2 . il Static Stack Anal e call Hierarchy = 0

==

Binary File:{/ae350_demo/Debug/ae350 demo.adx --= Total Function Code Size: 7836 (User defined functions only)

Name Size File Line Path N )
demo _led 122 demo_led.c 58 d:\RDS5\workspace\ae350 demo\Debug\.\src\demoled
gpio_callback 2 demo_led.c 47 d\RDSS5\workspace\ae350 demo\Debug\.\src\demo'led
main 14 main.c 16 d:\RDS5\workspace\ae350 demo\Debug'.\sre\demo
get_core freq 6 delay.c 25 d:\RDS5\workspace\ae350 demo\Debug\.\src\bspylib
rdmeyele 18 delay.c 30 d:\RDS5\workspace\ae350 demo\Debug\.\src\bspylib
printchar 30 printf.c 25 d:\RDS5\workspace\ae350 demo\Debug\.\src\bspylib
prints 154 printf.c 43 d\RDS5\workspace\ae350 demo\Debug\.\src\bspllib
printi 192 printf.c 99 d:\RDS5\workspace\ae350 demo\Debug\.\src\bspylib
print 362 printf.c 152 d:\RDSS5\workspace\ae350 demo\Debug\.\src\bspllib v

P R . . . A R

!

X F R FE R AL B RR A, R AR AR R A5 S . BkAk, MK “Total
Function Code Size” RAE#& “.text” BB, R ERNFE TP CB I RENE, E46 1T
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“text BZ” Fl “.nds32_init” Et.

2.6.2 EESHER ST HTAL B

B HER AT T B A P DR I AR KD, A
2-43 Pvn . PRAEMTEIR R, LEAL I TOTERR 51t 3R BT e HEAR 1 B K
5, PRBOR SR BB I PRACRS I VRS U2 o 3 7 W7 e 55 e P A i) 42 18 P
RIRR A HER RN, AT AP RHER N B R

& 2-43 B7SHERR S AT E

El Consale [ Properties |[2] Problems | & Terminal {ills Function Code Size | il Static Stack Analysis &2 :*‘ Call Hierarchy == = 8
Binary File: /ae350_ demo/Debug/ae350_demo.adx --> Max Stack Size: 384 (User defined functions only), lll Used Stack, Self Stack Size,| | sub-functio
Name Used Stack  Self Stack Size Graphical Stack Bar  File Line Path @
trap_entry - 8080] 240 [ top-< 49 d\RDSS\workspace\ae350 demo\Debug), \src\bsp'
gpio_control - 32 gpio_ae350.c 185 d:\RDSS\workspace\ae350 demo\Debug\, \sre\bsp'
i2c_irg_handler - 16l 180 | i2c_ae350.c 1468 d:\RDSS\workspace\ae350_demo\Debug\,\src\bsp'
gpio_irg_handler - 16 gpio_ae350.c 305 di\RDSS\workspace\ae350_demo\Debug\.\src\bsp'
gp0_irg_handler - 16ll 224 | interrupt.c 24 di\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
spi_irg_handler - 16128 spi_ae350.c 1241 d:\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
rtc_alarm_irq_handler - 16llt16 rtc_ae350.c 479 d:\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
default_irg_handler - 16l 224 | interrupt.c 24 d:\RDSS\workspace\ae350_demo\Debugh.\srcibsp'
dma_irg_handler - 160 96| dma_ae350.c 506 d:\RDSS\workspace\ae350_demo\Debug\.\src\bsp'
reset_handler - 16l 272 | reset.c 28 d:\RDS5\workspace\ae350_demo\Debug\,.\src\bsp'
rtc_period_irq_handler - 1616 rtc_ae350.c 439 d:\RDSS5\workspace\ae350 demo\Debug\.\src\bsp'
uart2 irq_handler - 16432 uart_ae350.c 1446 d:\RDSS\workspace!ae350 demo\Debug),\sre\bsp'
nmi_handler - 16 wdt_ae350.c 259 di\RDSS\workspace\ae350_demo\Debug\.\src\bsp'
uart1_irg_handler - 161432 uart_ae350.c 1444 d:\RDS5\workspace\ae350_demo\Debug\,\src\bsp'

gpio_pinread - - gpio_ae350.c 143 d\RDSS\workspace\ae350_demo\Debug\.\src\bsp' v
< >

YT RN REL,  HEAL R AL DL HERRAE B

Self Stack Size: 47 bR A8 FH I HERR 19K/

Used Stack: 47 eR%csk AT, A IHERRIR /N

Graphical Stack Bar: KA B~ 71T bR A HER 1) RSO, 0k
FEFH “Self Stack Size”. “Used Stack”. “sub-function max
required stack” F1 “Max Stack Size”. 7} AR [FFita £~ 3 FhHERL
KN “mn” RIx “Self Stack Size”, “®” £/ “Used Stack”,

“1 1”7 EI~ “sub-function max required stack”.

ORI, AL RS IR R B E S, BREA DAL PR
SAEFP AN LR R 2. Al MRBEL, TRk $F “Expand
A7, FEIT BRI T R B L HERAE I, W&l 2-44 PR . BEHERRAE 210
TSGR, IR0 o AR 55 2 (0 BR AR AT 42
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E 244 RFFFRBFER

B Console | Properties |[2] Problems | {2 Terminal |l Function Code Size |illy Static Stack Analysis 2 . 73 Call Hierarchy = m = 0
Binary File: fae350_demo/Debug/ae350_demo.adx --= Max Stack Size: 384 (User defined functions only), Il Used Stack, Self Stack Size,| | sub-functic
Mame Used Stack  Self Stack Size Graphical Stack Bar  File Line Path @
5 trap ertne . 8080] 240 [N trsp-< 49 d)\RDSS\workspace\ae350 demo\Debugh, \sre\bsp!
gpic_c Expand Al 32 gpic_ae350.c 185 d:\RDS5\workspace\ae350_demo\Debugh. \src\bsp'
i2c irq. Collapse All 16l 160 | i2c ae350.c 1468 d:\RDSS\workspace\ae350_dema\Debugh,.\src\bsp'
gpio_ir Export to CSV file 16 gpio_ae350.c 305 d\RDSS\workspace\ae350_demo\Debugh. \src\bsp'
gp0 irq handler 16l 224 | interrupt.c 24 dARDS5\workspace\ae350_dema\Debug\.\src\bsp'
spi_irg_handler - 16 128 spi_ae350.c 1241 d\RDSS\workspace\ae350_demo\Debug\. \src\bsp'
rtc_alarm_irg_handler - 1616 ric_ae350.c 479 dARDS5\workspace\ae350_dema\Debug\.\src\bsp'
default_irg_handler - w6l 224 | interrupt.c 24 d:\RDSS\workspace\ae350_demo\Debug\.\src\bsp'
dma_irg_handler - 16096 dma_ae350.c 506 dARDSS\workspacelae350_dema\Debugl.\src\bsp'
reset handler - sl 22 | reset.c 28 d\RDSS\workspace\ae350 demo\Debugh.\src\bsp'
rtc_period_irq_handler - 16lk16 rtc_ae350.c 439 d\RDSS\workspace\ae350_demo\Debugh. \src\bsp'
uart2 irg handler - 160432 uart_ae350.c 1446 d\RDSS\workspace\ae350 demo\Debugh, \sre\bsp!
nmi_handler - 16 wdt_ae350.c 259 d:\RDSS\workspace\ae350_demao\Debug\.\src\bsp'
uart1 irg handler - 161432 uart_ae350.c 1444 d\RDSS\workspace\ae350 demo\Debugh, \sre\bsp!

gpio_pinread - - gpio_ae350.c 143 d:\RDS5\workspace\ae350_dema\Debug\.\src\bsp' v
< >

Al — MR, MRS L SE “Export to CSV file”, 5 HiHER
H R ST B AT B A csv SCI, W 2-45 R .

& 2-45 5| 18| CSV Xt

B Console [T Properties [#] Problems A Terminal ills Function Code Size [y Static Stack Analysis I3 :‘“ Call Hierarchy == = O3
Binary File: fae350_demo/Debug/ae350 demo.adx --= Max Stack Size: 384 (User defined functions only), lll Used Stack, Self Stack Size,| | sub-functio

Name Used Stack  Self Stack Size Graphical Stack Bar  File Line Path K

s trap entry - a080] 240 [N trer< 49 d)\RDSS\workspace\ae350 demo\Debugh.\srcibsp’
gpio_ ¢ Expand All 32 gpio_ae350.c 185 dn\RDSS\workspace\ae350_demo\Debug\..\src\bsp’
i2c_irg) Collapse All 161 160 | i2c_ae350.c 1468 d:\RDSS\workspace\ae350_demo\Debugh.\src\bsp'
gpio_ir Export to CSV file 16 gpio_ae350.c 305 d:\RDSS\workspace\ae350_demo\Debugh.\src\bsp'
gp0_irg Wanarer = 6l 224 | interrupt.c 24 d\RDSS\workspace\ae350_demo\Debugh.\src\bsp’
spi_irg_handler - 16 128 spi_ae350.c 1241 d\RDSS\workspace\ae350_dema\Debugh.\src\bsp’
rtc_alarm_irq_handler - 16lH6 ric_ae350.c 479 d\RDSS\workspace\ae350_demo\Debugh.\src\bsp®
default_irg_handler - 16l 224 | interrupt.c 24 di\RDSF\workspace\ae330_dema\Debug\.\src\bsp
dma_irq_handler - 16096 dma_ae350.c 506 d\RDSS\workspace\ae350 dema\Debug\.\src\bsp’
reset handler . w6l 272 | reset.c 28 di\RDSS\workspace\ae350 demo\Debugh.\sre\bsp’
rtc_period_irq_handler - 16l rtc_ae350.c 439 d)\RDSS\workspace\ae350_demo\Debug\..\src\bsp’
uart2_irg_handler - 161432 uart_ae350.c 1446 d\RDSS5\workspace\ae350 demo\Debugh..\src\bsp'
nmi_handler - 16 wdt_ae350.c 259 d:\RDSS\workspace\ae350_demo\Debug\.\src\bsp'
uart]_irg_handler - 161432 uart_ae350.c 1444 dA\RDSS\workspace\ae350_dema\Debug\.\src\bsp'
gpio_pinread - - gpio_ae350.c 143 d:\RDSS\workspace\ae350_demo\Debug\.\src\bsp" v

< >

FEFRSHERR AT a] DUE T el b, %40 K/, “Self
Stack Size” 8¢ “Used Stack” Xf & EHEF, HA] LA — N R B E e fr
PR AL B, Kl 2-46 T
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& 2-46 EARBABAE

A Andes Project Creator
// Trap entry

void trap_entry(void) _ attribute__ ((interrupt ("machine”) , aligned(4)));
= void trap_entry(void)

Binary File:

Mame

> trap_ents

long mcause = re
long mepc = read
long mstatus = r
SUPPORT_PFT_ARCH
long mxstatus =

O Properties |[2] Problems | { Terminal |glly Function Code Size [l Static Stack Analysis 52
£350_demo/Debug/ae350_demo.adx --» Max Stack Size: 384 (User defined functions only), Ill Used Stack,
Self Stack Size Graphical Stack Bar  File

gpio_contral

i2¢ irq_handler

gpio_irg_handler

gp0_irg_handler

spi_irg_handler

rtc_alarm_irq_handler

default_irq_handler

dma_irg_handler

reset_handler

rtc_period_irq_handler

uart2_irg_handler

nemi_handler

uartl_irg_handler

gpio_pinread

|8 main.c

Used Stack

& demo led.c | trap.c 53

ad_csr(NDS_PMCAUSE) ;

_csr(NDS_MEPC) 3

ead_csr(NDS_MSTATUS) ;

read_csr(NDS_MXSTATUS) ;

80 80 240 - trap.c

32
16l 160 |

16

16l 224 |
16l 128
16llte

16l 224 |
16l 96|

w6l ez |
16llhe
16432

16

16432

gpio_ae350.c
i2c ae350.c
gpio_ae350.c
interrupt.c
spi_ae330.c
rtc_ae350.c
interrupt.c
dma_ae350.c
reset.c
rtc_ae350.c
uart_ae350.c
wdt_ae350.c
uart_ae350.c
gpio_ae350.c

Line
49
185
1468
305
24
1241
479
24
506
28
439
1446
259
1444
14

o

% Call Hierarchy

Path

Self Stack Size, |

= 0

EEEE

| sub-functio

~

d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
di\RDS5\workspace\ae350_dema\Debugl.\src\bsp'
d\RDSS\workspace\ae350 demo\Debug).\src\bsp’
d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
d:\RDS5\workspace\ae350_dema\Debug\.\src\bsp'
d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
di\RDS5\workspace\ae350_dema\Debug\.\src\bsp'
d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
di\RDS5\workspace\ae350_dema\Debugl.\src\bsp'
dA\RDSS\workspace\ae350 demo\Debug).\src\bsp’
d\RDS5\workspace\ae350_demo\Debug\.\src\bsp'
di\RDS5\workspace\ae350_dema\Debugh.\src\bsp' v
>
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3 BirEH

3 ans

RDS #fflid HAr B H K (Target Manager View) & #H Hx
(Target). H#Frti (Target Board) F1H#H:Z%: (Target System), HAik%
M 3.2 HAnEHEAR.

LAR B BRMS 1 RDS B F A AR H A MR TV

1. ESLAERIEAT N AR B H AR
2. GIEHMTRE (BAS T 2.4 ST, HT i
3. MEHMTRE (BfASN 2.5 WEHRM TR, F=AEnHiT .
4. REHFR, BATARR T BT R R, i EARE LS LR B
RDS ¥ r M8 5 Frg B AR, &l 3-1 P
3-1 BIREERE
Target

project creation

Running
Target

Target Manager

AndeSight™ IDE
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3 BirEH 3.1 @y Hir RS

3.1 B BfHRS%

Hir RG0 2 — Nl ICE B (11 Gowin FTDI USB 4nfi#% .
Andes AICE-MINI+E% Olimex S5 A% ) EHE R AHD H bR 1) B PPl ~F
&, 35 ICE Hin. HAstK. ICEman F1FEHL RDS #ft:. & Hix &%
i, SR 3-2 @57 RDS %45 H bRtk R B Rz .

[# 3-2 RDS ¥4 5 B et EE

AndeSight™ RDS IDE | Target Manager
\

Local / Remote
Ethernet

ICEman

USB 2.0
|

ICE Target

\
JTAG

Real Evaluation Platform

3.2 BfrETERS

RDS #AA# H HAnE 4% (Target Manager) K& ¥ RDS %t 5 Hbr
SR, & 3-3 Fras.
3-3 Bt EER
18 Target Manager : Local Targets 2 . 0= Outline| & | = e | =
~-® Running Target:
y :{=::>Targets
|4 ADP-AE350-A25-GOWIN

HFr &2, “&” (AICE Diagnostic report) 27 H i R 45 HiEE
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P,

K 3-4 fws.

3-4 WHT R RS

ICE.

a| | s
| AICE Diagnostic report

ADP-AE350-A25-GOWIN

Hiif; “E2” (AICE Diagnostic report), 7£ Test Memory Access H it &
Misc Argument A1 Address, K2 K Hbr %% .

Gowin FTDI USB Zf2 %1 Test Memory Access, 115 3-5 flTw.
.

ICE: Bus 1 Port 1 [GWUSB-S >=v4.1]

Misc Argument: -Z v5

[# 3-5 Test Memory Access: Gowin FTDI USB #R#28%

A Test Memary Access (Optional] >
ICE: Bus 1 Port 1 [GWUSB-5 »=v4.1] W
Misc Argurnent: ¥

Enter a writable address

Address: v

Olimex 11 #% 1 Test Memory Access, 115 3-6 fAlTn.
Bl

ICE: Bus 1 Port 4 [Olimex ARM]

Misc Argument: -Z v5
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[# 3-6 Test Memory Access: Olimex A 2%

A Test Memory Access (Optional) x
ICE: Bus 1 Port 4 [Olimex ARM)] v
Misc Argument: v

Enter a writable address

Address: v

By “OK”, A RGZWiik &0 T Fos.

Andes ICEman (OpenOCD) 5.1.1-g3a34fc9 (2022-04-22-14:27)
Burner listens on 2354

Telnet port: 4444

TCL port: 6666

JTAG frequency 10.000 MHz
There is 1 core in tap

target-0 = tap0O_target_0 Ox0 Ox1
The core #0 listens on 1111.
ICEman is ready to use.

== TEST target-0 ==

* |nitializing Debug Module Interface
* |nitializing Debug Module
Scanning number of harts

* test frequency

Setting adapter speed: 5000 kHz
JTAG frequency 5.000 MHz
Current adapter speed: 5000 kHz
JTAG frequency 10.000 MHz
Halting Hart O

coreOQ: target_xlen = 0x20

core0: mvendorid=0x31e

core0: marchid=0x80000a25 A25
core0: mimpid=0x160

core0: misa=0x4094312d

core0: dcsr=0x400006c3

core0: mnvec=0x80000000
core0: pc = 0x80001ba8

core0: debug_buffer_size=0x8

* Access GPRs testing

RV32 base ISA (32 GPRs)
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* Abstractauto testing

* Single Step testing

* Check haltsumO value

* Check haltsum1 value

Testing reset_and_halt_one_hart

execute ndmreset should not affect these registers:abstractcs,
abstractauto, program buffer and abstract data

clear abstractcs.cmderr(W1C) and abstractauto(0)

Hart O pc = 0x80000000

execute DM reset should reset these registers:abstractcs, abstractauto,
program buffer and abstract data

kkkkkkkkkkkhkkkkkkkkk

Diagnostic Report

(PASS) check that Debug Module (DM) is operational ...
(PASS) check JTAG/DTM connectivity ...

(PASS) check changing the JTAG frequency ...

(PASS) check GPRs access ...

(PASS) check ABSTRACTAUTO should cause COMMAND to run the
expected number of times ...

(PASS) check all harts single step ...

(PASS) check haltsumO ...

(PASS) check haltsuml ...

(PASS) check reset-and-halt ...

kkkkkkkkkkkkkkkkkkkk

HirE AR T, “Targets” o RDS A4 Fr SCRF) B b

HbR ARG 6 Ha @ A 3P RDS 845 B briR 2 7 1)@
&, Wbl “Targets” Fiken Br, Nh R EE “Connect
Target via ICE > ICE”, THisg g & B E, #li “Bus 1 Port 1
[GWUSB-S >=v4.1] JDP (4-wire)”, Faha3IBinRS. NEIERRS,
gt — e E AN ICE iR #s AR &5 E, WK 3-7 fis.

3-7 EM BFRRS
.EETarget Manager : Local Targets &2 EE Qutline 3 | = ILH ——
:",=:5> Running Target
L :",=:€> Targets
[4] ADP-AE350-A25 =ruann

Connect Target via ICE ¥ ICE : Bus 1 Port 1 [GWUSB-5 > =v4.1] JDP (4-wire)

@, Connect Target via Simulator > T
E  Open Console
&

Refresh F5
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REBER RS, “Targets” BoniEEdz2kM ., EHEEMNH T GDB &
Pefm 5, & 3-8 Fian, “Running Target” o~ AH [H A5 & .

3-8 REBHRRES

8 Target Manager : Local Targets &2 . B Outline = 8

| EE wm

~ & Running Target
EE ADP-AE350-A25-GOWIN ICE-ICE: 9902
b :,"——:D Targets
v ADP-AE350-A25-GOWIN
BE ADP-AE350-A25-GOWIN ICE-ICE: 9902

H b e AL IS = Bon A AAR REMERIRG, 0.
o WAPRE “E” HIERGATFTWHRE, oTLLUERERIFE.

CRZIRA “ 887 HARIR CERER 4L RDS #itk, (REEAH I
Fro

o otk MU HERLADE, BFLMR. DIFEEFITR.

3.3 L B#RtR

RDS # et — NP0, TR A R W I EAL H AR

SAEEBATH EAAR, £ AR E ESIET, sl THAE “ &7 5

“B 7 G E RO R R BARTE PC=0 AL E, Wk 3-9 iR, W~
FrifikBr BEE AL, IR R 2 1 9 A o

MUG1025-1.3

74(143)



3 BirEH 3.4 kA BbR

& 3-9 S B#R
48 Target Manager : Local Targets &2 . Z= Outline = B
alem v
v = Running Target
BE ADP-AE350-A25-GOWIN ICE-ICE: 9902
v & Targets
hd ADP-AE350-A25-GOWIN
EE ADP-AE350-A25-GOWIN ICE-ICE: 9902

HEEIRER HAR, TR kS “Reset Target” 5 “Reset
Target and Hold”, A LS AL HARMR, Wikl 3-10 Frox.

& 3-10 EGIB R
18 Target Manager : Local Targets &2 . 5= Outline = g
e e <
~ 2 Running Target
?_E ADP_AEBS.D_'!".I': AL L L, 0N

“ ;!'__:9 Targets s Reset Target

v [0 ADP-AE350|/M& Reset Target and Hold
BE ADP-AES! £ Shut Down

B Open Terminal

&7 Refresh

3.4 XFB¥R

HAr &AM E Y, Amdiike i Bis, ThsgshiEs “Shut
Down”, <M H#¥r, WK 3-11 fixs.
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3.4 XM HAR
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& 3-11 XA B¥x

1 Target Manager : Local Targets 03 &

~ & Running Target

v & Targets
w |4 ADP-AE350-A25-GOWIN
BE ADP-AE350-A25-GOWIN IC

= Outll'new

= B8

& Reset Target and Hold

&
&l

BE ADP-AE350-A25-GOWIN ICE-Ir™- nnnn

Reset Target

Open Terminal
Refresh

=N T
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| p—

4.1 FRELE

WEE S g S . B E B E A 2R, T
SRR AT RS, 2B AT R A5 6, W 4-1 s

& 4-1 EiRENRE

A Debug - 22350 demo/sre/demo/main.c - AndeSight RDS v5.1.1 - O X
File Edit Source Refactor Navigate Search Project Run Window Help Debug Perspective
e LS S R A AR IR T [HPS e ik heeme] T T
{5 Project Explarer 32 = O |[4 Debug 22 Bixmn ®m| e o = = O || Variables | [ Memary 2 = A
2 G ¥ || v ik 2e350_demo Debug [MCU Program] e
v % ae350_demo ~ v i Process o
4 Binaries v @ Thread #1 (Suspended : Breakpoint) 8 - |
[l Includes = main() at main.c:123 Oxled8 -
(> Debug 35 gdb(8.2.50.20190522)-3 I 38 %% |0x80000000 : 0xB0... i3
v = src = = @ 0x80 >
v = bsp &) main.c 23 *._[d trap.c 8 starts 8l configh 2 g8 BxB000000050000000 BOOBI A
= 20350 116 // Run multiple peripherals interrupts demo ~ Ox0000000080000004 BATT
17 #if RUN_DEMO_INTR
— = OxBo00000050000008 SOBO
v @ config 113 deme_intr(); *
[8 configh o Do ©x00000008000000C B875! Y
R 12 < > |< 3
& driver Z fall led d
1 // Run waterfa ed demo " 3 =
& lib 2 #if RUN_DEMO_LED Lt REB‘StefDﬂbug View o
(= sag b 123 demo_led(); . 5 [ <
. vl 122 sendif Code Editor B 5oy
— = 5 Name ~
8 Target Mana 52 5= Outline . . £ All Registers
// User t s
&l e || = 7 User application code 84 General Purpose Registers
v 3¢ Running Target % Floating Point Registers v
BE ADP-AE350-A25-GOWIN ICE-ICE: 990:|| 138 return 8; < >
v % Targets -t v
v [ ADP-AE350-A25-GOWIN <
= — o, illls il k3 =
BE ADP-AE350-A25-GOWIN ICE-ICE: 9| () Consol 3 . [£] Proble | [l Proper | & Termin | [G] GDB C | & Disasse g ||% 8 % il S|k F| =
= g & v
= |BEEREE *B - & 4w | =3
Target Manager 2e350_demo Debug [MCU Program] ae350_demo.adx
< >
Writable SmartInsert | 37:3 Ty A

#WiX<x1h (Debug Session) E3)jf5, RDS ¥ E shdk N A RIZE
K, =i RDS BHELE T HAE “% 7 (Debug), Fah#t A&
K, sitn] LLik$E RDS #4F 32 “Window > Perspective > Open
Perspective > Debug”, K 4-2 iR,
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& 4-2 £#F Window > Perspective > Open Perspective > Debug

ADP-AE350-A25-GOWIN AL r-reoou-reo—crorwrer—pme Reset Perspective... Other...

A C/C++ - - AndeSight RDS v5.1.1 - m] x
File Edit Source Refactor Mavigate Search Project Run Window Help
A | & v il ~: LR R R B New Window ks~ O - j@|@ﬁ$
Editor >
&5 Projec 22 = O |[[A] Andes Project Creator £2 “_[h] ¢ = B8
- Appearance ¥
=% 7| Connection Canfiguration Ul Made 5 Project Language
< .
(= R de O Simulator | AndeSim | @ ICE ) ®C Ocs++ Create Project...
Show View >
Chip Profile (Double dlick to create Perspective > [ Open Perspective > 45 Debug
Chip Profile Name d  Navigation N T S P
- ..
~ GOWIN-AE3S0 Prefarencas Save Perspective As... &1 Team Synchronizing

Close Perspective

Close All Perspectives

Project Creator | Preferences

= 5 || B Console & . [ Properties | [£] Problems | & Terminal | il Function Code Size | il Static Stack Analysis| 3¢ Call Hierarchy

BT = =
2| om| 2

5 Running Target No consoles to display at this time.

3 Targets

A

= 0

)

4.2 R E

MUG1025-1.3

W& Esh G, RDS 844 Eshil AN R . NEREE
FIARAL A, 1%E# RDS #F 1328 “Window > Show View> Other ...”,
Kl 4-3 Fisn. “Show View” XEHEH, Hif; “Debug” FHifik, 7EfE

%2R ik B E BRI, i 4-4 s
4-3 %3 Window > Show View > Other...

A C/C++ - - AndeSight RDS v5.1.1 - ] X
ght |
Fle Edit Source Refactor Navigate Search Project Run | Window | Help
A | & v i G| 4 v @ v @ - NewWindow ks - o - j@|@|[ﬁ$
Editor »
¥ projec 32 = B |[[Al Andes Project Creator 5 [ ¢ = 8
Appearance >
E % || Connection Configuration Ul Mode 5 Project Language
=% 2350 demo . . - . Create Project...
= Simulator | AndeS ~ ICE =
O simulator |AndeSim ® Show View > @ Build Targets
Chip Profile (Double click to create Perspective > @ C/C++ Projects
Chip Profile Name ct MNavigation > O Console Alt+Shift+Q, €
“z Include Browser
~ GOWIN-AE3S0 Preferences % Navi
ADP-AE350-A25-GOWIN ADrreoswmresmorvrmemgme - N2VIG2t0"
0= Outline Alt+Shift+Q, O
[#  Problems Alt+Shift+Q, X
{5 Project Explorer
[ Properties
4 Search Alt+Shife+Q, S
Project Creator | Preferences & Tasks
&) Terminal E
» = Bl Console &2 . [ Properties|[2] Problems | & Terminal | i £+ Call Hierarch = B8
ATz m] P & "
! Other... Ale+Shift+Q, Q =
sleciam - =

"L [ T No consoles to display at this time.
E,

2o Targets
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& 44 iZF R E

A show View ]

type filter text

w = Debug
@g Breakpoints
[ Cache Dump View

%5 Debug
E Debugger Consale

{2 Executables

4" Expressions

GDB Command

t)= Global Variables Live View
0 Memory

@ Memory Browser

& Memory Map

B, Modules

85 OS5 Resources

1Y Renisters

Open Cancel

4.2.1 i E
TR B A T N AR P IO AAT IS, 8o HAs R GEE Ry 25 Bk,
AT eI DL, A 4-5 Fiow

& 4-5 B E
%5 Debug I3 L i == g

v 4% ae350_demo Debug [MCU Program]
v ¥ Process
v f# Thread #1 (Suspended : Breakpoint)
= main() at main.c:123 Oxledd
o5 gdb(8.2.50.20190522)-3

VAL TR A ) D e A

® “ 7 (Terminate and Relaunch): fZIEAUIHRLEFE, 5 H R
LR

® “IF” (Resume): ZkZPATEIFMIIH LR,

® “I1” (Suspend): Il B =R LFE.
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® “E7” (Terminate): {ZILIHIRZFE.

® “ 7 (StepInto): HIBHATHRLRENI Y HHES), FHEANTREHA .

® “7” (Step Over): H PHATHALAEM YAER], Bhid 1 eREH
H.

® “ .7 (Step Return): M BHATHIALRER L), HENRFII
— O .

® “ 7 (Instruction Stepping Mode): #ARICZwALIE (Disassembly
View), FPHATICHTE 2
4.2.2 AFLE

WAL (Memory View) DL A7 1% 513 (0 1F 2t B AME O Fr i Y
17, WK 4-6 . B AAF IR EOCIE— Bida s bl BiRIE N A7
BN A AE P A B AR T BARL 2 R e SRS AU

& 4-6 AFHLE

)= Variables | [] Memory &3 T | g e ‘“" E| HE <=e=.>| ag '| ~ = B8
Monitors <5 3¢ 3% | 0xB0000000 : 0xB0000000 <Traditional= &2 | 4= New Renderings...
@ 0xB0000000 @xPPRARAAESARARRRR BAAEE7I7 P4375793 500RE5IT7 "

exBoppREREEDEEOE1E 81598D9D
BxEeREREREERERE20 30828697
oxBoboRBBERERRRRE3E 87918691
axBepEREREE0EERRLE  BBEBECER
BxBopEREREE0BERESE FFFE3597
expepEREREEERRREER 3ECTETL3
gxBpboRBERERRRRETE BBBLABEL (5084
BxBeBERRERERRRBER FEBGEAES FFF

FEC78713
43984839
BBa7FEET
FFFEB797
81898090
4E468693
87918685
97 3DeeseET

B6 0oB0BBEE DOODEODE BBOBBBRE DEEREERE  ................
@ ©0BBBBBEL COCOREOD DBRBBREE DOBBOEEE  ................
)

8 eREEEEAR COREOROD BBABREEE CORBEEEE ... ... ... ....

Bx20220RE0ERRBR1ER 342822F3 G0025463 2518186F 0ARA3197 6" 4c...o0..%.1.. v

B AFLEE

1. BEFPATEEE, ER B R — N R I R 2R AR B AR S5
nE 4-7 Frw.
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B 4-7 T ARSI

45 Debug 2 Bk m| 2
v ik ae330 demo Debug [MCU Program]
v 12 Process
v 2 Thread #1 (Suspended ; Breakpoint
= main() at main.c:123 Ox1ed8
sl gdb(B.2.50.207180522)-3

2. WAMKEAH, sdiEEmikr “<” (Add Memory Monitor), il 4-8
Fr7x. “Monitor Memory” XFUFHEH, #i A\ —ANEELAF 1) P A7 bk BX
Kk, Hd “OK”, i 4-9 Fir.

[¥] 4-8 Add Memory Monitor #H

= Variables | [] Memory &3 :L]: - | xR .'_."| E| Hi| <='==€'>| Ci | 6\3 v = O
Monitors @ 8 | New Renderings...l
@ (heBO000NNN

- P
. tor: Ox80000000 : 0x80000000
Add Memory Monitor .Om er

ring(s) to create:

Add Rendering(s)

Floating Point

& 4-9 RIMAFE

A Monitar Memary x

Enter address or expression to
maonitor:

[gemo led] v

@

3. WAAHLEF, BN RoR — MEGHIAAES:, WA 4-10 Fror.

MUG1025-1.3 81(143)




4 R LR

MUG1025-1.3

& 4-10 RGBSR

)= Variables | [] Memory 2

W mee G |8 ES B2 = 0O

Monitor - §§ 3& demao_led : 0x1 <Traditional= &2 IE':? New Renderings...|
& 080000000 |@ 1 63342822 6FEAR254 97251818 93808031 " 4c...o..%.1... A
@ demo led |@xeececepeceeeaell 97ECC1S1 93880082 16FEC282 46928681 .Ai...... Bp....x
h 8xPA3GAPABARAREA2] S529873E2 A5280938 B2AB@121 81APE18@  &s5.Re. (%!

[} 31 B7220822 F3008067 577CATET -1
exPREEEPRREEERRRAL 03008827 F3603737 F37CATAY SETCAB27  '....7 48§]8" |[
OxB000HPERARERBRS] F30137F6 SE7CADZT7 B2BFA7FE 41006180 67.6' |[pG¢....A
BxPEDORPRREREREEE] BBCEBE11 AESG1FIS @IADIFIE EFASE18E . .E....... - LEi
6xPE0GRPRRRREREET] B21A5028 52014140 BBGAOLEA B7923697 SZEAL ...
8xPA0GAPARARBERAS] BEFALEA7 BR27F3CE 17FDSBID 88876788  ..3 E6'.}H[y..
8xBA0GAPARAREEREIL 23478DE4 J300E7AR F3148087 677D67A7  &.G# c.....465.}g
2} 8A1 B7 8@ B5E48087 F5C39847 F3808167 .5.G6.88-..6
8xPA3GAPARARBARAEL Al388477 1FA7AESE 73E7@DEM SEFC1A27  w.@)..5...¢s'.0[
8xBARGAPABARARBACL 13286727 J1FFF7@6 C6ELE346 93878982 g ..+V.Fcdf....
9x200000000280000L 330@LO6 AEGGESI7 138@EFC3 SEG2LEE7  ...3.2.«Ai..... 9
T ————— S, - - o

o WAEALRIAT LT “New Renderings...”, 3% “Floating
Point”, i “Add Rendering(s)”, Gl&—MF AR NFAEL, 1E 4-11

I
E 411 QI EF R BRAFER

)= Variables | [J Memory i

Wy GBS B =0

II-J:J New Renderings...l

Monitor &b 3¢ &% |demo led : Ox1 <Traditional=
& (xBO0O0DOOO |Memcrry Monitor: demo_led : Ox1
@ demo led

Select rendering(s) to create:

4. FHTNAHEYE, MR AILER “Endian”, w] LUE SO0 s ) T

FENF AT 0RO, 4

'12 F}‘I"ﬂ_‘—\‘o
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Ry S
B 4-12 FHIHFRE
)= Variables | [] Memory &2 :Li.I1 4 | I u-_n"l t'é| HH <*===D| ECI v | ?43 v = O
Monitor = 3¢ 3% |demo led : Ox1 <Traditional= &3 l 0 New Renderings...|
@ 0xB80000000 Gxé? ““““““““““““““ S e S n et 16 9388831 " 4c...0..%.1... A
@ demo led |@x®e °% Add Watchpoint (C/C++)... 248928881  LAl......Ap....K
- BxBE Find and Replace Ctrl+F  p1 p1ape180  &s.Re.(¥!. ... .
BxBE Add Rendering 7 B77CATB7  eeu...-g..6-5]
[T . 7 SB7CAB27  C....7 68§86 |[
3 Remove Rendering
BxBE E 41800150
BxBE Panes > B6 EF45818E
axde Endian b Big A.
BxBE .
Text > Little
BxBE . .
Cell Size b _ . -
BxBE . 47 F30001E7  ...-..5.G.88-..0
@xeE Radix ? BB SBFC1E27  w.B[..5...¢s .0[
BxBE Columns > 8603070902 'g ..+V.FCaL....
BxBE Update Mode > [388001007 ...3.2.Ri......
1< Copy > >

A DUME SR BT R I AR, (R WA T A G ERME, 75
SHEHL.
5. BEF#ITERES, FAEARRNRFZESUAL GRS, WK 4-13 B,
B 4-13 FERE
(x)= Variables | ] Memory 2 :L]: A | L

Monitor & 3§ %% | demo led : Ox1 <Traditional> ES]E:J New Renderings...|

BHS| %~ ~= 08

& OxBOODDDOO |Bx8BBRALB1 |737CB518|337CC158|E388D585 [B2FEATTA| |.p|SPA|H.0.§z6p? ﬁ
@ demo led @xBe8BA1C1 (92442248 (82614144|416683186(22C68611( [0"D.DA. .|...A. .£"
h @xBeBBA1DL |347473C4|31882138(|8424733F (22468230 [st.@!.1?s5.B2@"
BxBEBBRLE]L (82014144 |41000180(|22C60611 [#47473C4| pa. .| .. 4. . & Est.
@xBeBBA1F1 |11882130|04247337|22486236(82814144| P! [7s5.[p2@"DA. .
OxARARE261 |B186a150|22CEAG11 [4ACAZECC|S2CR4ECE| ... .. . I"|TREIENER
exeeee0211 |SAC256(C4|24100000|36892E8A(63801FA7| PvAZA..4....5..q
exe0000221 |ABG2675C|93807FAS|C1EAFIE7 [F1813398| |...«@....u.4.3.H

@xP0808231 (33548440 |B341300E(B3014E7A|FDOL139a7| @..3.048%zK. 3.9,
9x00808241 |FEVE3317|E319FDEA|630129F0|33@34AF4| [ 3{0.v.30).d8]. 3
9x20808251 |B1415406|A1AB2947|B3B7EI3D|3300FAGE| [(ZA.JG) jl=E-3.0. 3
E|
3

9x00808261 |E300F487(230006C6(9300D720|E3001T7E7| 4. JE. 8.2, ...,
9x00808271 |63FECTER|33036972(51412686 |B3AB1947| mChdri.3.+4.G.7
Ox00808281 3300F006 2600FIE7 @6CE3397 D7002300  .0U.3.0.8. . 4. .#.x W

6. R EAEHE G E S B e G A F N A7 IR s, 20 kT
WETEE, 18 RDS #F £ 5 “Window > Preferences >
C/C++ > Debug > Automatic Rendering Settings”, % “In the
Memory view, automatically render data without clicking “Add
Rendering” in the next debug session.”, 41 4-14 fiizr. EEHNALE
P 15 0T LAV ) 38— AR IR B i sk By, RRE A REEAE, &
W25 A N A7 TR 1R
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E 4-14 BRERRE

A preferences O X
type filter text Automatic Rendering Settings - v -
Autotools ~ . .
. Auto-refresh interval (in seconds): |1
Build
C/C++ Project Tem In the Memory view, automatically render data without clicking "Add Rendering” in the next debug session.
Code Style Note: To use this feature, users must make sure the address of the first memory monitor can be accessed whe

Core Build Toolcha

<

Debug
s fendring e
Breakpoint Actio
Breakpoints Path
Disassembly
Floating Point M
GDB
RTOS Awareness
Source Lookup F
Tracepoint Actio
Traditional Mem

Editor

File Types

Indexer

Language Mapping

New C/C++ Pmia)d e

(?:' [ Apply and Close Cancel

WE R TR

WAFE GBI CLR SO B R, SR LN DERUA RIS X 705 G 15
P ANtk

1. HHNEMET RS “ 77 (View Menu), FHsg#rhig#F
“Traditional Rendering Preferences...” 5 “Floating Point Rendering
Preferences...”, WK 4-15 Ffizs.

4-15 BB R RYR

)= Variables | [] Memory &3 W - | I o ="| B EE <‘§>| ag v | EE O
Monitors 25 3 ¥ |demo led : Ox1 <Tradi Layout 4
& 0x30000000 BxOBEBABRL 6334207 Find/Replace...
@ demo led Px20008RGD 0300803 e Nt
Bxeaea8819 16FEC2
AxARRRBAZS AS2EE93 Traditional Rendering Preferences...
GxEEREEE3] GREEBEM Floating Point Rendering Preferences ...
exaaaaaa3D B77CATE Preferences...
Bx@0888049 F3TCATR Table Renderings Preferences...
@XBRBBBASS SB7CARZ rororErrT-wTewerow R R—
@xeee88661 BBCABEL1L1 BESALFIS BOADIFIS . -.
BxB2868860 EF45818E BE21A20206 32814148 LLEL L LA@AL.
BxE2868670 BBBRELlEE EVO2EEST BEFRLEBTY ....... c..0,
AxABABABES @B27F3CB 17FDSE7D ABA7E78@ ES' [ Feeran
BxB82e88891 23478DE4 9S8BETVAL F3148687 a3.0% c..... a
axepeaeasld 677DBVATY BVOEREEE B5E48087 §.}g...-..8. W

2.  “Preferences > C/C++ > Debug” XJiEHEH, ®EILHBUHIES “Use
Global Text Color”, #RJ5 NHuhEAIEHE % H 2 X CARGI e, K 4-16
Fr7R o
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B 4-16 G NFERRE

A Preferences (Filtered)

type filter text
v CfC++
v Debug
Traditional Memor

< >

3

Traditional Memory Rendering v

Traditional Memory Rendering

Ou: or:

Address Text Color: I
Data Text Color: I
Brighten Alternate Cells I

Use Global Background Color
]
I [eold [Jlkalic [~“]Box

| [JBold [ lktalic []Box
[~ Use Global Selection Color

Apply and Close Cancel

Background Color:
Changed Color:

Edit Color:

Selection Color:

3. H.if “Apply and Close”, fRIFiXH.

RELEIARE

AL T BAE I D e R

® “.i ~” (switch source): T5ENIEHNAERISKIE, CPU { BUS. CPU
AR R G E R AL I NAF N A . BUS BERMURIE RGN AE N

%
o

® “"i” (Import):

& 4-17 SINTFE

A Import Memary

Restore to address: |g.x1

File name: |

Browse...

[JScrall to restore address

"
@

OK Cancel

® “U” (Export):

B .

SIN—HIGE NI NAAAE, WK 4-17 Fis.

WAL BRI A AR 51 B — NS, i 4-18
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4 P T

& 4-18 SILHNTE(E

A Export Memory

Format: Plain Text . +

Start address: |Dx1 End address: |0x1 |Length: |U

File name: | | Browse...

':?3' OK Cancel

RDS #AF3CHF 3 Bl NG| A AFE 4% 20 S-record. 4 SCASHI
Ak SO EIG TR, o BEE . ASCREEE, B 16
BERE, — I ORAE 2 4 16 BEf AT Jeln —EERIAEE, 0 Rtk
fH.

® “@7” (Auto Refresh): H Tl hlH NAFHANE. T EBA H3hHTH
A E ) Gowin RiscV_AE350 _SOC, T LLJEH E3hl#iThfe.

4.2.3 ATFN SRR E

AR 02540 E (Memory Brower View) J& N 7741 IR ) — i 4% 1 B4R
T H TR EME SO FE N AT

BN AEST

1. BEFPHATEE S, WA E R0 B 1 SCASHE Hh 4 N B EE A 1 A7 Hukk
HRIEX, i “Go”, kK 4-19 Fiow.

4-19 RTEN ST ERHLE

& console |[2] Problems | [ Properties | (] Memary Browser i3 GDB Command | 2 Disassembly = 0
W~ v

V| Go | | New Tab

demo_led

2. PWAFDEALE T, BN MEG R AHES, W& 4-20 Fios.
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4 R LR

MUG1025-1.3

& 4-20 R G RNFER

& Console ﬂ:: Problems (E Properties (ﬂ Memary Browser %

[Gl GDB Commancq = Disassembhﬂ

= 8

T ML

| demao_led

V| New Tab

BxdpaappaapEEREEEL
BxdpaazpaEE000819

0x1 - demo_led <Traditional> &3 |

63342022 cFERE254 97251810 938668651 97ECCLIBL 936506682
16FEC282 4B028E51 529873E2 AS2868936 82480121 BliBalse

31
axepaaapaapRRE849
axeaaaapaapERREEEL
exeaaaapaaEREREE79
axeaaaapaapERREEIL
axepaaapaREEREBA0
axeaaaapaapaEREECL
axeaaaapaaREEREE09
Bxpeaae0e0000000F L
B AAGRABRRRRBRRGT R0

B7eeaa6e F300@a67 B77CAVET 93008827 F3683787

F37CATAT SE7CAB2TY F3@137F6 SE7CABZT B2BF47FE 410680180
BBCE@61]1 BEEA1FI5 @IADIFI6 EF45515E B21AB020 52014148
BBeaelse 57925697 BEF@1@AY BE27F3CE 17FD5B7D BeavVETEE
2347BDE4 9380E7AR F3140807 077087AT B7000080 B5E40087
F5C39847 F3@00167 Al13080477 1FATBEEE 73E70DB0 SEFCLA2T
13286727 91FFF7@6 C6E16346 93878902 33001006 ABBBELST
1380BEFC3 SE@@leay F380EFBA 673087AT7 ABGBRBBR FSEEGFCS
410001687 22060611 AAC226(04 BEE42E54 63B@1FAT ApoBa7aC
IIRATFAR THARAART NAATRITT O7FS 3340 51ARAGRAR TIRTENIE

"4c...0..%5.1.. AL ... A
JAp. .. KEs.ReL(¥l. L.
P - 111 IER U o'
§8|6" |[87.6" |[pG¢....A
Y S Ei ..2@A. .

ST

vee.®i.65.0g. .. 8, .8
S Y- T L B T

RO
>

'3 L 3 pdERA v

B AR T EES “ T (View Menu), NS sk
“Default Rendering > Floating Point”, #8J5 .47 “New Tab”, ik 4-21
%DE 4'22 Fﬁ/j—_;‘o

E 4-21 RRBANFESR

& console ﬂf_ Prablems ﬂ-_=| Properties (ﬂ Memaory Browser 22

[GlGDE Command} Ey Disassembly\l

=0

1w 1000

T I

|demo_|ed Traditional Default Rendering >
0x1 - demo_led =Traditional= &2 l . Floating Point Find/Replace...
0x00000000000BB008] 63342022 FEEA254 97251010 93000631 97ECC181 93850002  4c. Eind Next
Bxepo00000000080019 16FEC282 4B9235B51 529873E2 AS2580930 82480121 41ABR1EE .aib. . .

~ Clear Expressions

@ 31 AB BYaBa008 F3000067 B77CAVET 93000827 F3683787 e
PxPBRERRPRBRERBAY F37CATA7 SE7CAB2T7 F3@L37F6 SE7CAG2T B2BFATFE 410001868 §§|6"
axepaoeeaa00000061 BBCEG611 GESG1FIS BOADLIFO6 EFASS1EE B21ABG2G 520814148 . E.. ...
axepooappoeRoRR7Y GBBRELER 57925697 BEFBL@AT 0027F3CE 17FD5ETD aaaTEVEE
axepaoapaaeEE0009]1 23470DE4 0ZR0ETAR F31480@7 c77DEVAT BYBGBREEE D5E4REET
a@xepooepaoBRERBA0 F3C39847 FI00O0LEY AL3@0477 LFATOESE 73EVODBe SEFCLEZT
axeppopppoepEeRRC]l 13206727 91FFF706 CBELG6346 93870982 33001006 ABBRESST
Axepaoapaae20080000 138BEFC3 CEQOLEGT FIBRBEFBR 673007A7 ABBBBR3E FS5E0EFCS ..%1.65.0g.. Lk, 8
axepboappoeREEREF]l  418001E7 220608611 AAC22604 SEE42E54 63B@LFAT ABBRETEC - ALLEBRRE LGl
@ 189 338@7FAG 7DEE54ET7 DB@TE31T7 9VF553540 S51ABB008 73ETVEDSF H: DR R .o A T A o

& 4-22 New Tab 3%&I5R

& console ﬂ:: Prablems (E Properties (u Memory Browser £ - [G] GDB Command} == Disassem blﬂ = 8

T UL eI
|demo_|ed ~ Mew Tab

Ox1 - demo_led =<Traditional= [0)(1 - demo_led =Floating Point= &2

BxpaaoeeEERRREEEEL 3.322729E21 3.961712E28 -5.333465E-25 -1.615597E-27 ~

expooooeeERRREEE11 -1.529999E-24 -1.716562E-27 4.115866E-25 1.928794E7

exeeoEe0RERR0R8021 3.182897E11 -1.457479E-16 -2.351853E-37 5.877687E-38

exepoee0eER200803 L Infinity -7.829395E-6 -1.814133E31 -1.585942E-5

exeepeppaepaeEEE4l  -1.815989E-27 -1.776429E31 -2.881738E31 7.118778E16

exeapeppaERREREE51 -1.823775E31 7.118778E1G -2.818625E-37 &.8e8366E8

faplatalelaalslalata o el N 7.627595E-32 4.935133E-32 4.167794E-33 -6.112517E28

exeapeppooRRRBRETL  -8.993112E-9 -9.496149E-38 2.465383E-32 -1.746956E-5

exeapeppoepaERRE8L -1.144785E-4 Infinity 1.637284E-24 Infinity

axepaeppaERRERRE9 1 1.879875E-17 -1.627@@7E-27 -1.172578E31 1.1949688E24

exeppeppoEpRERREAL  -7.629511E-6 2.144183E-35 -4.958918E32 -1.814174E31

AVAGRARRARRARAARRT -5 OR2TARF-10 7 BTARIEE-74 2 AR1177F31 1 41R0RaF17 v

3. AT NAHEYE, MR AILER “Endian”, Al LUE O8O s i) T
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4 R TRE

MUG1025-1.3

Ty AT SRR, e 4-23 fis

B 4-23 FHIRFRE

Find and Replace

B &5 add Watchpoint (C/C++)..

Browser i

Gl GDE Command} gl Disassemblﬂ = 8

e v | 9 5| € ©

E v| | Mew Tab|
Panes
Ode Endian Big
@x08 5 81 03080802 " 4c...o..%.1....A0..... A
Text . Little . Ceee? +
@x08 ) 21 91400188 .Ap....Kas.RE.(¥!. ...
Cell Size _ . . ..
@xe |7 B77CA7E7 93000827 F3603787  ......'B..0°§| "....7°6
@x80 Radix 6 SB7CAR27 B2BFA7FE 41000180 §§|d° |[87.6° [[pG¢....A
@xan Columns 6 EF45818E B21ABG20 82014140 ..A.....
@xan Update Mode 7 @@27F3CE 17FDSB7D @B07E700
@xa c 7 677D27A7 B70@@080 BSE40007
Bx28 opy 7 1FA78555 73E78D8@ SEFC1827
Bx28 Reset To Base Address 6 93078902 33901096 ABBOEGTT
Bx08 Go to Address... @ 67300747 ABBPBBSE FS5E00FC3  Ai......°1.66.08g...«h. .8
@3 Refresh 4 BBB42E84 63BBLFAT ABOEATEC  -..A. £ ARAZ. .. .§..c...«
o TeO RATFOR TR T TIAATRIT 7 Q7FR 2240 R1ARAQAR T2RTFEN=F ! = 1 3 pAERA NP s w7
£ >

4. BEFPATHERES, FHNERRZESULORRDS, WK 4-24 Fis.

E 4-24 FHAR

& console (E Problems (E Properties (ﬂ Memory Browser &2

[Gl GDB Command}

Disassemblﬂ = B8

e v | riet|d v

|dem0_|ed

> |

|NewTab|

0x121 - demo_led(+0x120) <Traditional> 2 |

aweaseapepaeREER121  73VCB51@ 337CCE0E E3@B05@5 B2FEATTA 9244224 52014144

.| sPA|3.0.825p2@"D.DA. . A

axesaeaopaepaEBl39 41800158

AAC226C4|86842E84 |638@1FAT |ABBRATEC

exbooeapoooRRRBl5l |33B0VFAG

DeavE317|97F53548 |E1ABB90@|73E7EDST

axepaepappeRRER1ES |73VCES18

axepaepoppeBREBlEl (418081588

BxeoopaoRReRRRBLYY |33587FAL

exbooeapbbopeRBlBEL |73VCESLE

aweaaepepaeREERLICY (410201582

axepepaepaeREERLEL |52814144

exbooeapbooRRRBlFY |2240B238

axepaeaepae0080211 |SAC256C4

E3@80585|B2FEATTA(924422408(|82014144
AAC226C4|86842E84 |638@1FAT |ABBRATEC L
D@a7E317|97F53348|11A8090@|73E7ED37| | ..3..
E3@80585 [B2FEATTA(92442248 (32014144 |.p|
B47473C4|31882130|8424733F (22486238

41666186 (22068611 |(847473C4|A1882135308|84247337| DAL ...
21200183 |22CE@611 [4ACAZBCC|52CR4ECE| P2@"
BBB92ESA|63801FA7 |ABB2078C|93807FAT| [VAZA. .

AvRARRRRRARAARATIQ  IF1AAFART
L4

FAFRARLAAIRIAT ZAARIRIATARTAIFNGAT IGAT

N4l

5. i AR T AR “ 77 (View Menu), T Hhi3g ik
“Find/Replace...”, R LLEHANE Bl sE i 3 A7 9% 1O 7 e 2, i

K] 4-25 ffios .
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4 R TRE

& 4-25 i%£#¥ Find/Replace...

= console (2] Problems |[C] Properties | [ Memary Browser &2 . [5G GDB Command | 22 Disassembly

CITIRTIT Rt =
I .-—Lv|LJ |

|dem0_|ed

Default Rendering

0x1 - demo_led =Traditional= &3

gx@eaaac0002000001
axepaoaaaaEEEE8819

Find/Replace...

53342022 cFoRE254 97251818 O Find Next

Clear Expressions

@ 31
Bx2p00800000000040
axepaaaspaeERa086 1
Bx2Baa000002080879
axepaaaaaaeEaa889 1
BxEBRAGRRREERE8A0
gx@eaaa000020208C1
axepaoaaaaeREE0809
BxERaa000020000F 1
Bx2pa08000000001090

F37CATAT S
BBCeB611 GBS
BBA@E18@ EVI25E07 BBF@L1AAT 2027
2347@8DE4 9 E7A
F5C39847 F
13286727 91
138BBEFCS 5600
4leealB7 2206
33807FAG 7DR2E457 DBRTB3L17 O7F53540 51AB0908 73EVEDSF

W

“Find / Replace Memory” Xf1lfHE, i N ZEA AN S Bds, &
i “Find” 2% “Replace”, 1k 4-26 Fr7x.

& 4-26 EX/ B HAE

(D) Byte Sequence

A Find / Replace Memory O >
Find: | |
Replace With: | |

Direction Range

® Forward Start address: |onooooooouumoooo v|

(C) Backward

End address: | OXFFFFFFFFFFFFFFFF v|

Format Options

(®) ASCII String Wrap Search

() Hexadecimal [JCase Insensitive

() Octal

() Binary

() Decimal

Find Find All

1_?'\ -
(;/' Replace/Find Replace
Replace All Close

6. XN TEAMREHRKERRS, XFARIFThEE, BN a0
K T HEL “% 7 (Auto Refresh), 52 BARIET N AE N 25

4.2.4 ARG E

NAEL ST LB (Memory Map View) J&—/MEH, H TR & ins
MU N AE IR AF IR (e, H5. 55D AN A7 IS % &% i 4
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4 R TRE

R, WK 4-27 Fizs.
4-27 NS E

B Memory Map &2 . 11l Registers = - | @e 7 O | ®E Y= O
[8] ae350_demo Debug [ADP-AE350-A25-GOWIN]

On/Off  Number Name Low Address High Address  Mode Width Cacheable Descriptior
oini Oxl oini O w nocache ar
| 1 DDR/SRAM 11 000000000 51 OxBOO0000D 64 h DDR or SR
oini Oxd oini O w nocache ar
%] 2 ROM/FLASH 1 0xBOO0000D 151 0xB0000000 32 h ROM FL|
acal Memo ave P.. il Oxa oini Oxa w nocache acal Men|
3 Local M ry Sl P.. it 0xa0000000 i Oxa0400000 32 h Local M
4 EMC i OxcOD0D00D il OxcO100000  rw 32 nocache BMC
evices oinl Oxe oini Oxe w nocache evic
5 AHB Devi 1l Oxe0000000 151 Oxe0500000 32 h AHB Devi
6 PLIC i Oxed000000 {1 Oxe6000000  rw 32 nocache Platform-Ls
7 PLMT i Oxe6000000 H Oxe6100000 rw 32 nocache Platform-Ls
- oinl Oxe oini Oxe w nocache atform-Li
8 PLIC-SWINT 1l Oxe6400000 151 Oxe6800000 32 h Platf: Ls
g PLDM il Oxe6B00000 (il Oxe6200000 rw 32 nocache Platform-Li
ave Devices oinl Oxe ol w nocache ave
10 AHB sl Devi 1 OxeB000000 1517 OwfODDO000 32 h AHB sl
evices oint oint w nocache evice
1 APB Devi 1 0xfO000000 151 OwF1000000 32 h APB Dewvi
xten evices ool ool cl w nocache xkenc
12 APB E d Devi 13l 0xfB000000 1i37 OxfcODODO00 32 h APB E
£ >

SR BT SRV I SRR PR 5 SR P47 IR

LIS, B TR O (Add Memory
Regions), siifi Hsili Py (7ML IERERLEL, T i3 6 o
“Add”. BEHNAFICE, PEBSLE S AT, S Py E

AR I T B A2 7 (Modify Memory Regions), Bl A5 Bt P 77 LSRR

KT EA LS, FHSEa g Edit’. BINESNAXE, K 4-28
Fioso

B 4-28 RIS XA EXIE
B Memory Map &2 . 11l Registers = - @ O | eE Y= O

[8] ae350_demo Debug [ADP-AE350-A25-GOWIN]

On/Off  Number Name Low Address High Address  Mode Width Cacheable Descriptior
oit Oxd ot Oxd w nocache or
DDR/SRAM 13l 0x00000000 i} OxB0000000 64 h DDR or SR
oY Oxd ot Ox w nocache or
2 ROM/FLASH 13l 0x80000000 i} 0x90000000 32 h ROM FL|
3 Local Memaory Slave P11 0xa0000000 (il Oxa0400000 rw 32 nocache  Local Memr
4 BMC & Edit %c0000000 [ 0xcD100000  rw 32 nocache  BMC
evil & e o Oxed w nocache evic
5 AHB Devi| & Add 0000000 1 0xe0500000 22 h AHB Devi
& PLIC @ Delete xe4000000 1} 0xe6000000 rw 22 nocache  Platform-Li
7 PLMT 8 Clear xe6000000 i1 Oxe6100000 rw 32 nocache Platform-Ls
8 PLIC-SWI Q) save xe6400000 151 Oxe6800000 rw 32 nocache Platform-Ls
] 9 PLDM i xeG800000 oo OxeB900000  rw 32 nocache Platform-Ls
@3 Refresh i b lat
T — ) o w nocache ave
10 AHB sl 8000000 17 OxfOO0DO000 32 h AHB sl
1 APB Devices i 0xf0000000 i OxF1000000  rw 32 nocache APB Device
12 APB Extend Devices i 0xfB000000 i OxfcDOO0D0  rw 32 nocache APB Extenc
< >

2. Wi — WA XIEE, 7£ “Memory Map Region Wizard” X ifHE
W, FCE AR, i “Add” 5t “Change”, Wk 4-29 FiR.
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4 A TR

[# 4-29 Memory Map Region Wizard X1HHE

A Memory Map Region Wizard O *

Modify Memory Regions

Memory region attributes describe special handling required by target memory regions.

Name |DDR/SRAM |

Low Address | 0x00000000 |

High Address | 0x80000000 |

Mode w w
Width 64

Cacheable ]

Description |DDR or SRAM

®

A7 IR DX IR T, Ik 4-1 B

+ 4-1 RTFRRGT X% T
gL ik
Name PAF XS 44 FR
Low Address € WAE XIS fh b bk
High Address i € N AE DX I 25 R b
Description AT X I TE R IR
Mode i€ GDB Vjin] A AE X AR, 4
ro: Wik
wo: RE
rw: B/E CERIAMESD
Cacheable & GDB & %47 Hirn W17

3. QUEMEUN PAF XS S BB s £ A U AL R, dd e o /IO i
d1 “On/Off” FEIEHE, 7T LIIFR/S LA A7 X 3

4. MIBRNAEXIR, EFH—AT X, RN T ER “9 7
(Delete Memory Regions), & 4-30 7w
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4 A TR

& 4-30 MR F X

B Memory Map &2 . 11l Registers = - | \)f O | eE Y= O
[8] ae350_demo Debug [ADP-AE350-A25-GOWIN]

On/Off  Number Name Low Address High Address  Mode Width Cacheable Descriptior
1 DDR/SRAM it 0x00000000 it OxBO0DOODOD rw 64 nocache DDR or SR
2 ROM/FLASH il 0x80000000 il Ox90000000 rw 32 nocache ROM or FL|
3 Local Memory Slave P... iiti 0xa0000000 i Oxa0400000 rw 32 nocache Local Merr|
Y

4 EMC i1 OxcO000000 i Oxc0100000 rw 32 nocache BMC

5 AHB Devices i OxeD0O00000 § Oxe0S00000  rw 32 nocache AHB Devici
6 PLIC i Oxed000000 {1 Oxe6000000  rw 32 nocache Platform-Ls
7 PLMT i Oxe6000000 H Oxe6100000 rw 32 nocache Platform-Ls
8 PLIC-SWINT i Oxe6400000 H Oxe6B00000 rw 32 nocache Platform-Ls
g PLDM il Oxe6800000 il Oxe6900000 rw 32 nocache Platform-Li
10 AHB Slave Devices i OxeB0O0000D i OxfODODDO0  rw 32 nocache AHB Slave
1 APB Devices i 0xf0000000 i OxF1000000  rw 32 nocache APB Device
12 APB Extend Devices i 0xfB000000 i OxfcDOO0D0  rw 32 nocache APB Extenc
£ >

4.2.5 BEFFEENE

ZEAF AR (Cache Dump View) H THMEFHITE G, WiEH
R4 CPU 2247, X TR — 1277, WHMERRHEYHES, O
“Address”. “Set”. “Way”. “V” (Valid state). “D” (Dirty state).
“L” (Lock state) A1%i#s, unl& 4-31 Frw.,

4-31 EFEE LA

9 Breakpoints | B\ Modules | B} Debugger Console | [0 Cache Dump View &3 = 4
L1 Instruction Cache ‘ ‘_,_| B | |Find address

Address Set Way V D L 00 04 08 oc 10 14 u~
beeaaaae aeaa eges @ 8 @

Baaeen2e eaal @@ 1 @ @ 9@873E24B 28093852 AGG121A5 AGGlSRE2 ©000AREL COGBREEE BEEBGTE

peeaea2e aeal egel @ @8 @

baaeen2e aaal eea2 @ @8 B

peeaea2e aeal eges @ 8 @

BapeeRLE eaa2 epee 1 @ @ eBEB2T7BT 6GB3IVETI93Z TJCATATF3 T7CAB2T7F3 @I137FGSB  TCAR2TF3  BF4T7FESE

paaeeala aee2 Bgel @ B B8

beeaeade Bea2 egaz @ 8 @

Baaaeada eaa2 eegas @ @8 B w
< >

BAREFPPATEREAA RS, MRS MERAABTAER, WA
Rl bR iC B TT A% AR AL o

WEBITEKD

L B SR TTAR RN (1/2/418 575D, T DL G A7 N A IR R 7 3
AR ATEAAE R, TR iL# “Cell Size”, 1Kl 4-32 s,
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4 A TR

E 4-32 BIUARKPMTE
9 Breakpoints | B\ Modules | B Debugger Console | [ Cache Dump View &2 = B8
L1 Instruction Cache - | i | B | |Find address

Address Set Way V D L 00 04 08 oc 10 14 nun
L R POBOERRD  GRODADRE
o o S T e
0POBRGRE  DRBR . GREBERER  DROBOBRE
00eREER  BROR Sl Gl 2lbyies 0EP0EREE  PREBRGRE
oooosaop eeee = Copy Cacheline Cirl+C | NS GREBERER  DROBOBDE
000EER28  BEBL Check data consistency with memory 8 bytes BBREETE;

oopaea2E  BREL gl @ @ @

bopooE2E  BBBL Bega2 @ @ @

eepaea2e  BREL eges @ @ e
1 @

bopoba4a  BBB2 Baae @ ©eBB27B7 6@378793 TCAVATF3 TCAB2ZTF3 @L37F65B T7CAB2ZTF3 BF47FESE W
£ >

BERRSAE—B

WA GAF AL B AT LU B 2247 5 W AF 2 R Bl — Bk, A —A
ARIEAAT, FHEH ikt “Check data consistency with memory”,
NP 4-33 o . AR A T8 37 R 7R SR A7 AT (0 5088 2 75 -5 %6 B f P A7
s —5, W& 4-34 Fs.

4-33 REHBSNE—BM

9 Breakpoints | B\ Modules | G} Debugger Console | [J Cache Dump View &3 = O
L1 Instruction Cache | i | B ||Find address -

Address Set Way V D L 00 04 08 oc 10 14 un
0oO00BEE GO0 BB O O B
@RO000GE 0000 @BOL @ @ @
GOPADEGR GAAE  BBR2 @ B B
@O000000 G000 ©@PE3 @ @ @
: G @EGL  @EBR 1 @ @ g@Torhan meanaarn aoasanc | danaanam
epoePE28 ©BEOl @Eel @ @ @ 08l Cellses ¢
@EO00E20 G001 0BB2 @ @ O oo SRR Crl+A  ooozee  eoeeceor
ooepoe20 @021 @803 @ © @ ol -] CopyCacheline Crl+C  loopees eeoenoe:
@E000040 @002 02O 1 @ @ oa Check data consistency with memary AB27F3  BF4TFESEWV
£ >
4-34 FIREAHF—H
8 Breakpoints | B\ Modules | G Debugger Console | [J Cache Dump View &2 = 08

L1 Instruction Cache ~ | i | @ | |Find address «
IAll data in the cache line "0x20" matches that in the corresponding memory,

Address Set Way V D L 00 04 08 oc 10 14 un
boooobee  BoEE bgae @ @ @
boooobee  BoEE Bgal @ @ @
eaaooone eeaa eeaz @ e @
boooobee  oEE Bgas @ @ @
epopee2e @Bl eeee 1 @ @ OB73E24B 280893852 ABBL21AS ABBlEE5Z ©OEBABEL GODBBEBEE BBBEGTES
eaapee28 eeal eeel @ @ @
Baageeze Beal Begez @ @ @8
bbaoob2e  BBEL Beas @ @ @
eaaa20848 2ea2 eead 1 @ @ @eBsB327B7 68373793 TJCATATF3I TJCAB27F3 BI137FE5B  TCAB27F3  BF47FESEW

£ >

EHIZFT

R T BARAE AL P BRI B, W s — AN AT, RS
%% “Copy Cache Line”, izl —A~ 049, &l 4-35 Frows
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4 P T

& 4-35 SHIEET

9 Breakpoints | B\ Modules | G Debugger Console | [J Cache Dump View &3 = O

L1 Instruction Cache | i | =53 | |Fir1d address
All data in the cache line "0x20" matches that in the corresponding memory.

Address Set Way V D L 00 04 08 oc 10 14 un
000000G6 0000 ©0OO0 @ @ o
@eE00EEE GEGB GOl @ B @
0E000BE ©EBB  0EE2 @ @ o
00000OBE OO0 BEO3 @ @ O
0Be00028  0OBL  BBD 1 B - mnomcaen | mmassacd e
20000020 0001 0001 B @ Sl J60 0OOOBE0D DEGEEORL
00000028 G  0EE2 @ @ S Ci+A Lo eooeoose  oosecen:
sooeee2e eeel eees @ o | = Copy Cache Line Crl+C  30n oooosese oooseeo:
GoRERE4n @BB2  @EBe 1 @ Check data consistency with memory 5B JCA@27F3  BF4TFESEw
< >

4.2.6 FEHIEHE

fEfil G L oAt R, DUSOu A A S e AT . B, —
A~ CDT M=k &, SonB i TREMMELS R, W& 4-36 Frx.
4-36 TR G E

El Console i3 [T Properties | [2 Problems | & Terminal | flly Function C| filly Static Stac | 12 Call Hierar = 0

U= = = R
CDT Build Consale [ae350_dema]

FLILSMEU DULLIULNE: UULPUL) SYINDUL, LAL

Invoking: Readelf (ELF info listing)
riscv32-elf-readelf -a "ae358_demo.adx™ > output/readelf.txt
Finished building: output/readelf.txt

Invoking: Objdump (disassembly)
riscv32-elf-cbjdump -x -d -C "ae358_demo.adx” > output/ocbjdump.txt
Finished building: ocutput/cbjdump.txt

Inveking: Objcopy (object content copy)
riscv32-elf-objcopy -5 -0 binary "ae35@_demo.adx” output/ae35@_demo.bin
Finished building: ocutput/ae35@_demc.bin

Invoking: Size (sectien size listing)
riscv32-elf-size "3e350_demo.adx™ | tee output/.PHONY.size

text code  rodata data bss dec hex filename

9922 8954 968 e 728 laa42 2992 ae358_demo.adx
Finished building: output/.PHONY.size

14:12:24 Build Finished. @ errors, @ warnings. (tock 12s.286ms) “
£ >

4.2.7 GDB s S &

GDB 74 (GDB Command View), T GDB 480, WK
4'37 ﬁﬁﬂ_‘—\‘o
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[# 4-37 GDB ® 41 E

& Console |[2] Problems | Properties | [I Memory Browser GDB Command &1 . E2 Disassembly = B8
|5 BB &-E~- |8~ %
[11] ae350_demo Debug [MCU Program]

-stack-list-frames --thread 1
-stack-info-depth
-stack-list-frames

-stack-list-arguments 1 GDB Command Part

-stack-list-locals 1
-stack-select-frame 0

UUUUUUUY

$1 = Ot GDB Command Console
show endian
The target endianness is set automatically (currently little endian)

Input Field v

GDB A M Ef1FE 3 #5793 GDB #ig 47>« GDB iy 4154 & Al GDB
I
AL B TR A i — AN R HEME, Boniil e il g aT LR IE K
Frf GDB 4, LH:H%‘%WA ey, nILARA GDB fip M T HAL « 17
(Show Command Part) KM, K 4-38 .

[ 4-38 GDB #4¥84>
& consale |[£] Problems | Properties [G| GDB Command 2 =

m]
E=ErE M

[2] ae350_demo Debug [MCU Program]
SStacrno-Gep N
-stack-select-frame 0
-stack-list-frames
monitar nds mem_access cpu
maonitor nds configure dmi_quick_access 1
monitor nds configure dmi_quick_access 1
it e i Al el e 1 he
00000000 ~
Warning: the current language does not match this frame.
p/x (char)-1
$1 = Oxff v
< >
v
NH 3 X
IR B ) A ) 432 GDB &5l &, 7~ GDB 1y ? o A

& UAFRRIEE EoR AR R AUE B B3R GDB 4, yﬁéi%mﬁ}?
fs, MRS GDB 4R, Wik 4-39 fis.
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[# 4-39 GDB #4424 &

& Console |[2ll Problems [ Properties | [G| GDB Command &3

[2] ae350 demo Debug [MCU Program]

SStALRTOSUEp "
-stack-select-frame 0
-stack-list-frames ~
show endian ”
The target endianness is set automatically (currently little endian)
moniter nds mem_access cpu
monitor nds configure dmi_quick_access 1
configure: dmi_quick_access = 0x00000001
monitor nds configure dmi_quick_access 1
configure: dmi_quick_access = 0x00000001

W
T 2

W

SEAR B ) SR 7 2 i - 4m AR 1, FISRRI% GDB fin . Bhii /42 it

X fir AEI’J@LX%DT%‘QE, % ] LLORAF 20 2% GDB fin&-idsk, Wikl 4-40
P o

[#] 4-40 GDB <A

& Consale [[2] Problems [ Properties | [G| GDB Command £3

[2] ae350_demo Debug [MCU Program]

SSlEL AT ISR
-stack-select-frame 0
-stack-list-frames

show endian
The target endianness is set automatically (currently little endian)
monitor nds mem_access cpu

monitor nds configure dmi_gquick_access 1
configure: dmi_quick_access = 0x00000001

function caller is a | |Check the calling function's name
{ frame address
faas

| flash-erase

GDB #r 4% 5 GDB w42 & 1fE Brl A5 B —A e, sy
GDB AWM E T A “# ~” (Save GDB Context) FHifisk, ik#

“Save GDB commands to a file.” @k “Save GDB console to afile.”,
g] 4'41 Fﬁ/j——\‘o

MUG1025-1.3
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& 441 5|H GDB %%

&) Console |[2] Problems |[C] Properties | [G] GDB Command &2 = O
x| SEHEER-B-I&-%
[2] ae350_demo Debug [MCU Program] ﬁ Save GDB commands to a file.
SSlECRTTTIU U P | Save GDB consale to a file.
-stack-select-frame 0
-stack-list-frames v
A

The target endianness is set automatically (currently little endian)

configure: dmi_quick_access = 0x00000001

configure: dmi_quick_access = 0x00000001

< >

i v

4.2.8 SoC FFRFME

MUG1025-1.3

SoC Z s & (SoC Registers View) T iHUE 5 A7 2% 5 1
SoC F 7 ffE. MR EWE AR EIELE M — 5, (21 3 2l
R, WE 4-42 FoR.

4-42 SoC HfF=EE
# SoC Registers I3 Memory Map | iiii Registers = | g 1m0 | g ¥ = B
Name Value Address Description "
A% APB Bridge 5% APB Bridge Registers
"‘,", SMU AIAI System Management Unit...
v B8 UART1 %% UART1 Controller Registers
11 SYSVER 0x02011008 K4 0xf0200000  SYSTEM ID & Revision Regis..
14 HWCFGR 0x00000002 51 0xf0200010 Hardware Configure Register
11 OSCR 0x00000010 518 0xf0200014 Over Sample Control register
ilil Receiver Buffer/Transi 0x00000024 581 0xf0200020 Receiver Buffer Register (RB...
iil Interrupt Enable/Divis 0x00000000 58 0xf0200024 Interrupt Enable Register (IE...
i1 Interrupt Identificatior 0x00000001 £} 0xF0200028 Interrupt Identification Regis...
11} Line Control 0x00000000 111 0xF020002¢ Line Control Register (LCR) v

SINGI L EFFRHE

A LAEREFRIZATIN 51 AR B 1Y SoC 277 as Ml , %k FAHE 5] ) SoC
A ER i ge (AT LUE AT “Ctrl” BT 2 k%), i SoC Zifrastl
BT HA2 3" 7 (Export).

#iil SoC FAFA M E T EA2 “™ 7 (mport), A LA N SoC 2172851
I o

R FFROE
W] LB R TO RS T (1 A A R B R, a0 4-43 P
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E 4-43 B FFHENE

Registers

#® SoC Registers &0 Memory Map | i}
Name Value
&% APB Bridge
& SMU
w &4 UART1
» i1l SYSVER 0x02011008
it HWCFGR 0x00000002
i OSCR 0x00000010
11l Receiver Buffer/Trans| 0x00000024
i3l Interrupt Enable/Divig 0x00000000
i1t Interrupt Identificatiog 0x00000001
iiti Line Control 0x00000000

Address

Bt

18 0xf0200010
Lt 0xf0200014
Liti 0xf0200020
Lt 00200024
it Dxf0200028
18 0xf020002¢

&E SoC FHEH

Elllnlgl‘nm|ﬁ><p - = H

Description

%) APB Bridge Registers

i) System Management Unit...
&% UART1 Controller Registers
SYSTEM ID & Revision Regis...
Hardware Configure Register
Cwver Sample Control register
Receiver Buffer Register (RB...
Interrupt Enable Register (IE...
Interrupt Identification Regis...
Line Control Register (LCR)

M

W LAEE A SoC Fifray, WA/LIEE SoC afr#s4l. SoC & fFat

MBI, AR E SRR A HER N A, RRsR ik

“Watch”, #it=XHLE (Expressions View) f/rikiE ) SoC Z17 2 1115

2, WK 4-44 B
4-44 BE SoC FEHF

(x)= Variableslé’:‘f Expressions 3 I 0 Memory

Expression Type
v 1% SoCRegisters( LART1 )

it Readable, Not write-able
i HWCFGR Readable, Not write-able
1i1f OSCR Readable, Writeable
1§11 Receiver Puffer/Transmitte Readable, Writeable
i nable/Divisor Lz Readable, Writeable
1131 Interrupfldentification / FI Readable, Writeable
bt Readable, Writsable
i Control Readable, Writeable
it Readable, Writeable
bt Status Readable, Writeable
1131 Scratfh Register Readable, Writeable

£

#R SoC R &8 Memory Map | il Registers

MName Walue Address

&% APB(Bridge
M s

v B UARTY
11t svsf28 Watch 352 0xF0200000
1 HW View Memory 511 0xf0200010
i st . 5 0xf0200014
Ml Req  Selectall Crl+A 1 oufo200020
W inte  CoPY Ctrl+C | 558 ouf0200024
1i41 Interrupt Identificatior 0x00000001 1iti 00200028
1iif Line Control O 00000000 1l 0xf020002¢

No details to diselay for the current selection.

=

EE|+ XK | §F

Value

0x02011008
0x00000002
0x00000010
0x00000024
000000000
000000001
0x00000000
0x00000000
0x00000060
(00000000
000000000

EIETHE
Description
%% APB Bridge Registers
] System Management Unit...
%% UART1 Controller Registers
SYSTEM ID & Revision Regis...
Hardware Configure Register
Over Sample Control register
Receiver Buffer Register (RB...
Interrupt Enable Register (IE...
Interrupt Identification Regis...
Line Control Register (LCR)

8
-

~

8

Ll
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4.29 HEFHEILE

AT (Registers View) (&R f7as b8 I 900 CPU 5 &,
A DL B AR B Ok B O A AR AR B A, WP 4-45 P . SR A7 A
P T EAE “3" 7 (Export) B “™&” (Import), A LLG|HELGI A TFAEA T
1H.

B 4-45 HEFENE
#® SoC Registers | B8 Memary Map | ¥ Registers &2 = | | '=">| wg wn v = F
MName Value Description 63

&4 Al Registers

#% General Purpose Registers

A% Floating Point Registers

4 RISC-V standard machine mode CSRs
A4 AndeStar VS machine mode CSRs

&% AndeStar V5 debug mode CSRs

M4 RISC-V standard supervisor mode CSRs
& AndeStar VS supervisor mode CSRs

M4 RISC-V standard user mode CSRs

4210 TEE

ZEAE (Variables View) 51t 15 7£ 1 1AL 1] ik 5 R HERR 2544 A1
KRR ERERE . BRFPATEERN, SRRl ErZEErAl, W

4'46 Fﬁﬂ—\‘ o
& 4-46 TEYLE
()= Variables 52 . ¢4 Expressions| [] Memory = | i | ey ¥ = 8
Mame Type Value
()= num uint8_t Ox2
)= led_pin uint32_t Ox2
%)= begin_time long 0x60816
(=)= end_time long Oxbd961
)= use_time long Ox5d14b

4.2.11 FENE

BEMEAS BIRE R E, e H RS A 54 A8 & SE AT
(Global Variables Live View) KE7x, BAAS% 4.2.12 4 /"8 511
Bl Ry 4w mrE AR A S, AR S D AR
e XMTREAME, RAEEFPATEEE, F2BreREsEHm
H. MTFeRTELriE, JRERFIETE RISCV AT BIRRS L,

2 SER R 4 R AR 2 I AE
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Bltn, — AR RSP RRE A, WA 4-47 fios.

4-47 RiIAANE
)= Variables | & Expressions &3 0 Memory = O
BB d X K[ CIet] & ¥
Expression Type Value
» demo led int (void) Oxl
(® Driver GPIO AE350 DRIVER GPIO (.}
®# uart_init void {unsigned int) 37
=)= led_pin uint32 t 02
)= begin_time long Ox60816
or Add new expression
< >

R AR T HEA .

e “£7” (add global variables): FEFHITEEE, Hidi “& 7, “Add

Global Variables” XJiGHEH, EFAEE MK &R E, KERXME L
TNIEE WA R A N HE, ik 4-48 BTN

& 4-48 Add Global Variables %HiEHE

B Add Global Variables x
|
Watch Variables Type Address &
O cache info struct _cache.. 0x26d8 =cach..
O irg_handler const isr fun.. 0x231c <irg h.
] _dso_handle void * 0x0 =reset vec
] channel_active uint32_t 0x28e0 =chan..
O channel_info DMA Channe.. 0x26f8 <chann.
O init_cnt uint32 t 0x0 <reset vec
Driver_GPIC AE350 DRIVE.. 0x2404 =Drive.
] gpic_driver_version
| gpic_info GPIO_INFO Ox26ed <gpio_
O Driver 12C AE350 DRIVE.. 0Ox0 =reset vec
] check uint32_t 0x26e8 <check
] CriverCapabilities v
£ >
Select All| | Deselect All
oK Cancel

® “id” (Export): FLLG|HAREW AR, EE- I 2RERE, Bl
“ed”, e 4-49 Fs.
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E 4-49 5|2 /T E

Export data dialog x
Variable Name Start array End array Count
IZ demo_led 1
Export Cancel

“Export data dialog” Xfi1HHEH, Fi e HF 5] H 09248 & 46 4l SR
H, SR)EHdr “Export”s

4.2.12 £ FHTESCHLE

MUG1025-1.3

ERARKINLE, RERFIZTE RISC-V WM AR RS L, 1AL
Kty Ul e /A e, seif e E e R ENE, Wik 4-50 f. R
TEFIE, ATLUEY IR TR EITA AR A KT, FEraT i
(] BB 1 2 JRy AR B EREE M A L, LB s S R R

GRAE RS H bs R 40, L IUE R P IT EHE e 4 2 Bon 2 R
R E

& 4-50 £ /T ERE

9% Breakpoints | #)= Global Variables Live View &3 é§7| L | e v = 8

MName Type Value Address
cache_info struct _cache i.. {.} 0x26d8 <cache infa=
Driver GPIO  AE350 DRIVE.. {.} 0x2404 <Driver GPIO=
gpio_info GPIO_INFO {o} Ox26e4 =gpic_info=
Driver UART2 AE350 DRIVE.. {.}
uart2_info  UARTINFO  {.}

0x0 <reset vector=
02848 <uart2_info=
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G JRy AR B S AL I ) T A A

® “&9” (Auto Refresh): Sz RIH 4545 &,

e “&7” (Add global variables): FEF#UTEEE, Bk “& 7, “Add

Global Variables” XTiGHES, EHFEE MK LR E, 4 F2 8L
MR Rk e R s L IE, i 4-51 Fiw.

4-51 Add Global Variables

B Add Global Variables >

Watch Variables Type Address &
cache _info struct _cache.. 0x26d8 =cach.
| irg_handler const isr_fun.. 0x231c <irg_h..
[l _dso_handle void * D =<reset vec
[ channel_active uint32_t 0x26e0 =chan..
[ channel_info DMA_Channe... 0x26f8 <chann.
| init_cnt uint32 t 0x0 <reset vec
Driver GPIO AE350 DRIVE.. 0x2404 =Drive.
| gpio_driver versian

gpio_info GPIO_INFO x26ed =gpio_
[ Driver_12C AE350 DRIVE.. 0Ox0 =reset vec
[ check uint32_t 0x26e8 =check
[ DriverCapabilities &
<

Select All | | Deselect All

OK Cancel

“¥” (Delete the selected variables): M #E B HI 4 /A&,

“ i v ” (Select the format for values): Hiii Fhifisk, TFHisgsrhp
R4 R AR IR B — AR, BHE “Default”. “Hex”.
“Memory (Hex)”. “Octal” 1 “Binary”, & 4-52 ffizn. 117
“Memory (hex)” FEIRAFIENAFHIT 16 FEHME, FWNTF 5 Bis RS
P71 3 AR+ — 2
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& 4-52 IEF B RN
9 Breakpoints (4= Global Variables Live View &2 L§3‘| L | i~ = d
Name Type Value Address Lt
cache info  struct cache i.. {..} 0x26d8 =cache Hex
Driver GPIO  AE350 DRIVE.. [.} 0%2404 =Driver PR
gpio_info GPIO_INFO {.} Ox26ed =gpio_i Octal
Driver_UART2 AE350 DRIVE.. {.} Ox0 <reset_vect Binary
uart2_info UART_INFO {..} 0x2948 =uart2_info=

4.2.13 B SR E

Wr 4L B (Breakpoints View) FIH T 7E8KF T A2 Hh 13 & 1 AT A 187 5,
AT, B R s WS, Wk 4-53 Fios.

B 4-53 B L
9 Breakpoints &1 . 9= Global Variables Live View XK EHAN | FES ¥ = O
2 delay.c [line: 50]
B delay.c [line: 54]
& demo_led.c [line: 81]
2 demo_led.c [line: 83]
2 demo_led.c [line: 89]
B demo_led.c [line: 97]
2 demo led.c [line: 89]
2 demo led.c [line: 102]

No details to disnolav for the current selection.

4.2.14 RC4RALE

SACIRALE RN T B i & M A R gmARAY, BT & 3R 45
A, ik 4-54 Fios.
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& 4-54 FC4RLE

& Console [[2] Problems | [ Properties | @ Memory Browser | [G] GDB Command |22 Dlsassembly &3 = 08
|Enter location here v“ & @| i
 B@ealacc: c.bnez a@,8xlacd <simple_delay ms+12> -~
57 }
@eealace: c.jr ra
Geeelada: c.nop
@eealad2: c.nop
23 if (str)
printchar:
Geeelads: c.beqz a@,@xlaed4 <printchar+lé:
EL] **str = 3
Gepelads: c.lw as,e8(ad)
Geeelads: sb al,@(as)
31 +(*str);
eepeladc: c.lw as,e8(ad)
PeBelade: c.addi a5,1
Ge08lacd: C.5W as,e8(ad)
B8881lac2: c.jr ra
25 {
BeeBlacd : c.addi sp,-16
BeBelach: c.swsp ra,l2(sp) v

4.3 FIEE
Wil fﬁ’m FER T — 248 E AR P mT PAT SCAE . KA AT MR
T RAAMEARAE R ME B A S BOE MR R P TR @R & iR
Bn, Hidi RDS 8 T HE: “ % 7 (Debug) BRI UAIHIR 215

431 Bl PAERE

ZHLUN P RO A 215 A E .

1. IH R EERME S, HRTEE R TR, NRSERfiEs
“Debug As > Debug Configurations...”, & 4-55 7.

4-55 i%&#¥ Debug As > Debug Configurations...

A C/C++ - ag50 Ammamdoer m e A S mem e o A A=Cinke BOIG 451 _ O X
New ¥
File Edit Sou indow Help
— Show in Local Terminal > : "
. o s - G- osi e 18 »
= g G Ctrl+C :
brojectExpll B COPY i T3] oot demo ledc 32 [ trapec | [§ startS | [@ delayc | ?
Paste Cirl+V N
mple program shows the usage of the GPIO interface.
=5 ae350 de X Delete Deleie strates the waterfall led.
- Paste As Link
Source >
Move... itialized, the demo program will set GPIO direction to output for waterfall led.
Rename... 2 rfall led is lighted each led, the UART output lighted led.
) (e ly GPIO pin as output, there is no GPIO pin as input interrupt event, callback
. has no event to be handled.
iy Export.
Build Project
Clean Project B oo
.h
Refresh FS e =
Close Project ng waterfall led demo =
40_LED =
Build Targets > =
48 Target Man: Index y |77 Includes weswsssssss ff
r:wer GPIO h" e
Build Configurations b3 SETC N
-+, ol
2% Running } .
e Targets (e ld Szifnge H Praperties | (2] Problems| 4 Terminal | fils Function Co | il Static Stack | 2 Call Hierarch = O
B Target Configuration S—
X Flash B Cirl+™ X%k LEEEEImE-O-
b Hash Burner " | demo Debug [MCU Program] ae350_demo.adx
Validate
@ RunAs >
4% Debug As > J# 1 Application Program
Profile As > 4k 2 MCU Program
Eampaiii B b Eenrgueifore
Restore from Local History...
< (== File Explorer
=5 a2350_demo Configure > IR |
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o # % RDS 32 % “Run > Debug Configurations...”, #1& 4-56

B o

4-56 i%F¥ Run > Debug Configurations...

A~ | | ~idh~ k% % HB-0-2
l{ Project Explorer &2 = B |[E¥ Andes Py 1_;
5% || & |

=5 22350 _demo 31

A C/C++ - ae350_demo/sro/demoyled/demo _led.c - AndeSight RDS v5.1.1
File Edit Source Refactor Navigate Search Project |Run | Window Help

Run
Debug
Profile

Profile Histary

Profile As

Profile Configurations...
Run History

Run As

Run Configurations...
Debug History

Debug As

Debug Configurations...
Breakpoint Types
Toggle Breakpoint
Toggle Line Breakpoint
Toggle Watchpoint

Toggle Method Breakpoint

Skip All Breakpoints

Remove All Breakpoints

External Tools

Ctrl+F11
Fi1

>

Ctrl+Shift+B

Ctrl+Alt+B

- ] x

i) = @@

trap.c [§ start.s [£ delay.c > |
~

PI0 interface.

GPIO direction to output for waterfall led.
RT output lighted led.

10 pin as input interrupt event, callback

EL]
M Target Mana 22 0= Outline| = 8 2
32 #ing
=N e |
& Running Target
b Targets & Console. &
<terminatec Q
< >

=% ae350_demo

ooo ooo

Function Co | ly Static Stack |2® Call Hierarch| = B

X% EpEES 2259~

adx

= iai e

2. £ “Debug Configurations” XfifitEH,
B, I E R B 2R A,

Z K 4-2 s EC E 2R
fil4n “MCU Program”, R skt

“New Configuration”, @& — M TEACE, WK 4-57 Fox.

= 4-2 R AECE KR

il

Eitipa

Application Program

T RERGINS K H I RS

MCU Program

T ARMERGR S H AR &R 5

Core Group

é\

FIF RN R AR, FIN B A RO R

Multi-Core Application

M RERGMRS 2% B s 25

Program
Multi-Core MCU MTARBERGRS 2B RS
Program

Target Monitor

T B AR BRARES

MUG1025-1.3
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& 4-57 SIBEFREASETE

A Debug Configurations

Create, ge, and run c

0O e

El

Configure launch setting

type filter text

J#% Application Program
oo Core Group
~ 4 MCU Pronram

4 ae3s( || New Configuration
‘ Multi-Cq [F  New Prototype
Multi-Cc (& Export..
¥ Target h Duplicate
Delete

L| Link Prototype...
u| Unlink Prototype
r Reset with Prototype Values

< >

Filter matched 7 of 12 items

s from this dialog:

|} - Press the 'New Configuration' button to create a configuration of the selected type.
- Press the 'New Prototype' button to create a l...ch configuration prototype of the selected type.

10O - Press the 'Export’ button to export the selected configurations.

' button to copy the selected configuration.
utton to remove the selected configuration.
on to configure filtering options.
ing configuration by selecting it.

tion(s) and then select ‘Link Prototype’ menu item to link a prototype.

tion(s) and then select..link Prototype’ menu item to unlink a prototype.

tion(s) and then select...alues’ menu item to reset with prototype values.

Configure launch perspective settings from the 'Perspectives’ preference page.

)

Debug Close

3.
2%, K

4'58 ﬁﬁ/j_‘—\‘o

# 4-58 AR SIERE

FERREIRIR PR E R E, $id “Apply” 1 “Debug”,

A Debug Configurations

] x
Create, ge, and run ifi
- Y
CEeEX|B 3~ Name: [2£350_demo Debug
type filter text Main| % Debugger i Startup | % Source| -] Common| % Exception Handling|
4% Application Program . ~
4 Project:
&% Core Group
v 3 MCU Program [ae350_demo || Browse..
% ae350_ demo Debug Program:
Multi-Co Application P
_‘ 1 Hore APPACION Tt [Debughaeasn_demo.adx
@ Multi-Core MCU Program =
g Target Monitor Variables... |  Search Project.. Browse..
[JRTOS Awareness Debugging: | $(AUTO} Browse...
[A Target Management Service
[IFlash Programming Before Debugging
Automatically burn
[ Disable Memory Map
v
< > :
Revert A
Filter matched 7 of 12 items = BEY
@ Close

T
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432 BERASIERLE

DL 1 PRI 4 % B MCU Program 10 C & -
Main JZIF
Main i 50 W1l 4-59 s .
4-59 Main £

E| Main %5 Debugger | B+ Startup | % Source| 5] Common| 3 Exception Handling

Project:

| }aeESD_d &mo Browse...

Program:

| Debug\ae350 demo.adx

Variables... Search Project... Browse...
[JRTOS Awareness Debugging: | ${AUTO) Browse...
[“] Target Management Service
[JFlash Programming Before Debugging
Automatically burn
[]Disable Memory Map
v
Main ST IR 415% 4-3 s

% 4-3 Main i£10

eI it

Project BB AT TR

Program B TR AT AT SO

RTOS Awareness Debugging | il T &/x RTOS 15 B3R, HIhRERTHRIE
PR S5 B ZAI RTOS WAZMA,
AL “Browse...” FahfBE—MEXT
GDB fir 2 ] Python A

Target Management Service H e 3R 55

Disable Memory Map DREAR P AT AT SO, TR WS B FUE S A A7
X 35k

Debugger £k
Debugger i i~ a1l 4-60 s .
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[# 4-60 Debugger £k

r B> Startup| B Source| [£] Common| #F Exception Handling

Debugger Options

GDB Setup Remote Target

GDE Setup

1 Do not read .gdbinit file when launching GDB. {--nx)
Read .Andesgdbinit file when launching GDB.
GDB Command:

|${gdb} | Browse...

GDB Init File:

|${-dei”it} | Browse:

Startup XN F
Startup &I~ W& 4-61 Fris.

4-61 Startup IEIF

E Main ﬁ:Debugger =
1. GDB Initialization Commands
Reset and Hold

Startup: E:,- Source | [] Common | ¥ Exception Handling

Variables...

Variables...

load

2. Binary File Options
[Load binary file

Workspace...

3. Runtime Options

[Jset program counter at (hex):

Set breakpoint at:

[JResume

4. GDB Run Commands

File System...

Startup JETi#AR a1FK 4-4 Fios.

% 4-4 Startup £
15T ik
Reset and Hold SALJESLRMRERE “_start”;
load: GDB JN#FEFF
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I ik

Set breakpoint at WE W SALE,

Bt “main”

Resume SALEIEAT RN AL E

GDB Run Commands GDB izfrfn 4

Source &Ik
Source ETR U1K 4-62 Fi7s .
& 4-62 Source £k

A

Create, manage, and run configurations

1A
FoEX| B3
type filter text Add a container to the source lookup path

B Application Program | A project in the workspace.

@e Core Group

~ 4k MCU Program 9 Absolute File Path

ik 22350 demo Debug (i Compilation Directory Edit...
e Multi-Core Application Pry (= File System Directary
@ Multi-Core MCU Program [ Path Mapping GELE
“¥a Target Monitar [EProgram Relative File Path A selection Needed m] X

= Project
Teg Project - Path Relatr
= Workspace

[=Workspace Folder

ce Folders

||_—Add..

Edit

Choose project(s) to add:

@

[ Search for duplicate source files on the path

< 2>
Filter matched 7 of 12 items

@

[l eRemoteSystems TempFiles!
[ =5 ae350_demo

Select All Deselect All

[JAdd required projects of selected projects

PEe TR AT BAAR E T C B C++ 1 FH AR P s ST, Bl mT DA
SE - ME IR ENRA TR, JFIMA B,

Common &Rk
Command &+ a1 4-63 Fix.

MUG1025-1.3
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& 4-63 Common IR

E| Main | %% Debugger | b+ Startup | &~ Source |[T] Common| 3 Exception Handling

Save as "
(O Local file
|\ae350_demo Browse...
Display in favorites menu Encoding
[ 45 Debug (® Default - inherited (GEK)
O B=profile () Other |150-8859-1
[ @ FRun
Standard Input and Qutput
4] Allocate console (necessary for input)
[JiInput Eile:
Warkspace... | | File System... Variables...
[J Output File:
Workspace... File System... Variables...
Append
. v
Common &R U15E 4-5 s .
= 4-5 Common %I
AT fik
Save as JEBNC B SO AR AR St (*launch)
Standard Input and Allocate console (necessary for input): % & %] 541
Output KRS BS R, BiaS% 4.2.6 HHl6 0
B

Input File: MIHH BT (Hifi “Workspace...”) BG3C
f (Bads “File system...”) J>BChrdEsiN
Output File: MWIH #J8 (Hdi “Workspace...”) B
A (B “File system...”) Z)EchruERH!

Exception Handling i&TiF
Exception Handling i& 5= w1 4-64 s
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[# 4-64 Exception Handling i£IF

E| Main | %% Debugger | b= Startup | B Source | [l Common | 8 Exception Handling
[JHardware Stack Recording
[“Break on General Exceptions;

[JHardware Stack Protection []Instruction Access Misaligned Instruction Access Fault

lllegal Instruction ] Non-Maskable Interrupt Load Access Misaligned
Load Access Fault Store Access Misaligned Store Access Fault

Bus Write Transaction Instruction Page Fault Load Page Fault

Store Page Fault Performance Counter Overflow

[“] ACE Exception [if mmsc_cfg.ACE == 1]
Slave Port ECC [if (mmsc_cfg.ECC == 1) & (mmsc_cfg.LMSLVP == 1]]

Hardware Stack Overflow Detection
Hardware Stack Underflow Detection

Set the top of stack boundary cbtained from hardware stack recording as the stack overflow bound

IR TR T J5 S AR TSk, 8 8 A PP AT ST 1) 0 2T 3 1) S 2R
A, FEMHIATEZ A 6 il B A BEAMER IO SRMRY . T EAN BRI
1%FE “Hardware Stack Recording” Al “Hardware Stack Protection”.

4.4 Wi FIME 5

RDS #cft ] A B (1 Wr A8 AN R H A I SRR A REF W7
RAEG TS5 H AR IR T AR 5E B SR AR W s BV m 1 A2

441 XEWS

ZWELLUT P PR B
1. ARESgwHE AT T — A

2. AR A ML HIPR R, THisE ikt “Breakpoint
Types > C/C++ Hardware Breakpoints” 1{ “C/C++ Breakpoints”, #&
SEWTRRAL, K 4-65 FT

)
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& 4-65 i%#F Breakpoint Types

Andes Project Creator (@ main.c (@ demo_led.c &2 = 8

TOTTEINCIOOE  demoT

27 ~

Cirl+Shift+B

Add Breakpoint... Ctrl+Double Click

Add Dynamic Printf...

Disable Breakpoint Shift+Double Click

Breakpoint Properties... Ctrl+Double Click

Breakpoint Types b3 . C/C++ Breakpoints

Build Selected File(s) C/C++ Hardware Breakpoints

Toggle Breakpoint

Clean Selected File(s) C/C++ Dynamic Printf

C/C++ Single Core Breakpoints
Ge e Annetation Z0d C/C++ Single Core Hardware Breakpoints

Add Bookmark..
Add Task...

00ao

+  Show Quick Diff Ctrl+Shift+Q
~  Show Line Numbers

000

i >
Folding t event

Preferences...

< >

3. EFEREWSATIAM, WEHbrR, B R, FREER Ak
& “Toggle Breakpoint”, 41 4-66 fiis.

[# 4-66 1%£#%F Toggle Breakpoint

Andes Project Creator r@ main.c (@ demo led.c i = 08
= - e—— -~ ~
Toggle Breakpoint Ctrl+5Shift+B
Add Breakpoint... Ctrl+Double Click
Add Dynamic Printf...
Disable Breakpoint Shift+Double Click |5 38408
Breakpoint Properties... Ctrl+Double Click \P\mrAn™y 5
Breakpoint Types >

Build Selected File(s)
Clean Selected File(s) d: output)

Go to Annotation Ctrl+1 £358_GPIO_DIR_OUTPUT);

Add Bookmark...
Add Task...

+  Show Quick Diff Cirl+5hift+Q
+  Show Line Numbers

000

Folding >

000

Preferences...
JT Other leds are off

PR RSB mbsid, FoRBEREFFRATEEINAE, Wik 4-67
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B 4-67 W5
A
[& Andes Praoject Creator [£ main.c [£] demo led.c &2 = O
”

printf("\r\nIt's a Waterfall Led demo.\r\n\rin™);

// Initializes GPIO

GPIO_Dri-:Initialize(gpic_callback);

// Set GPIO direction (GPIO pins as led: output)

GPIO_Dri->SetDir(GPIO_LED USED MASK, AE358 GPIO DIR_OUTPUT);

S# Waterfall led

while(1)

begin_time = time();

3 simple_delay ms(106008); =
5 // This led
6 led_pin = @x1 << (num++);
7 =
8 // Other leds are off =
9 GPIO_Dri->Write(~led_pin, @); =
o
1 // This led is on =
92 GPIO Dri->Write(led pin, 1); =
93
4 end_time = time(); v
T < >

WA LAE RAAL A (Outline View) H st & B AUb 25, i — /N iR
¥, FhisEsdik$ “Toggle Breakpoint”, 1 4-68 ffis.

& 4-68 XM E HiE#E Toggle Breakpoint
8 Target Manager : Local Targets |25 Outline 22 Bl R o % = 0O
W demo.h
Wl Driver_GPIO.h
= misch
Wl stdio.h
® Driver GPIO : AE350 DRIVER GPIO
# GPIO LED USED MASK
# NUM LED
® gpio_callback{uint32 1) : void
@

demo_ [ A LR Y

Open Declaration F3
Open Call Hierarchy Ctrl+Alt+H
Open Include Browser Ctrl+Al+1

Refactor ¥

Declarations »

References »

3" Toggle Breakpaint

4. FREWT R AR, EWT AL T eGSR AR AR R L, A A
Wr, THisgEsrhikdt “Breakpoint Properties...”, 1/ 4-69 11X
4-70 FfiR o
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& 4-69 K7 R L E Fhi%$FE Breakpoint Properties...

9 Breakpoints

B Modules} G Debugger C::rnscrlew

= B

2 demo_led.c [line: 63] =]

o demo_led.c [line: 77] [t

@ demo led.c [line: 91] 0

2 main.c [line: 121]
X
T
%
=]
(="
@
@

A demo led.c [function: damn ladl fhuna: Harduearal

Go to File

Enable

Disable

Remove

Remove All Triggers
Remove All

Select All

Copy

RXERBAEANEBRSG ~

Cirl+A
Ctrl+C

Paste

Breakpoint PBlroperties...

[

Import Breakpoints...
Export Breakpoints...

Breakpoint Properties...

No details to display for the current selection.

& 4-70 K8 4w1E 28 £ Breakpoint Properties...

Andes Project Creator

r@ main.c

[§ demo led.c 12

79 while(1)
20 {

21 lhamin +ima — Fimal s

Toggle Breakpoint
Add Breakpoint...

Add Dynamic Printf...
Disable Breakpoint
Ereakpoint Properties...
Breakpaint Types

Build Selected File(s)
Clean Selected File(s)

Go to Annotation

Add Bookmark...
Add Task...

"  Show Quick Dniff
+  Show Line Numbers

Folding

Preferences...

Ctrl+5Shift+B
Ctrl+Double Click

Shift+Double Click
Ctrl+Double Click

Ctrl+Shift+Q

@ start.5

-]

Ctrl+1

m, (int)use_time);

000

000

“Properties for C/C++ Line Breakpoint” XfifHEH, i%&#%
“Common”, “Condition:” i\ sFfF£E, Hd “Apply and Close”,

e 4-71 ok
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[#] 4-71 Properties for C/C++ Line Breakpoint

A pProperties for C/C++ Line Breakpoint [m| X
type filter text Common =1 2 - -
Corl'nmon Class: C/C++ Line Breakpoint
Actions
Type: Regular ~
File: D:\RDSS\workspace\ae350_demo\src\demolled\demao_led.c
Line number: |81 |
[ Enabled

Condition: | |

lgnore count: |D |

(?)' Apply and Close Cancel

5. WIRETRERMT, XA CRS g 4 a8 X W7 S b 1L BT AT

442 EME =
TR T, W8 R e Bk ik s R A A A, A1 A
7.
1. TSN JUR 7 v B S A4

- RiEgmiEdy: EAMmESE T, EREENRNSRLE, &
RDS #3328 “Run > Toggle Watchpoint”, 1K 4-72 Ffx.

)
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& 4-72 i%#F Run > Toggle Watchpoint

A cics - ae350_demo/src/bsp/driver/ae350/uart_ae350.c - AndeSight_RDS v5.1.1 - m] x
File Edit Source Refactor Navigate Search Project Run Window Help
A | & ~ i~ & qﬂ#.o-% Run Ctrl+F11 j@‘%ﬁ#
Debu F11
4 Project Explorer £2 = 0 main.c (@ de & o flg art_ae350.c & > = 0
- Profile
=] <_b‘> - 252 // Trigger = ~
26 // Can be Profile Histor >
> [B configh ~ 27 #ifndef UA v
w = driver 28 #define uA Profile As »
w (= ae350 29 #endif Profile Configurations...
d 3@ #ifndef UA
» ¢ dma_ae350.c 31 #define UA Run History >
> [B dma_ae350.h 32 #endif
. 33 D RunAs b
> [€ gpio_ae350.c o X
B api 350 34 // UARTL Run Configurations...
7 Lhl gpio_ae330. 35 #if (DRV_U
> [ i2c_ae350.c " 36 static URR Debug History »
> i2c_ae350.h 37 N
o - 33 #if (DRV_U 3 BEmas
> |2 pit_ae350.c 39 wvoid uartl Debug Configurations...
> [ pit_ae350.h 4@ static UAR .
s T8 owm ae350.c ¥ 41 Breakpoint Types >
< > 42 . .
43 #endif @ Toggle Breakpoint Ctrl+Shift+B
BTarg 2§ OUtli"\l - B 44 #ifd (DRV_U & Toggle Line Breakpoint
45 woid uartl hd
2] ‘ E B | N < j"’) Toggle Watchpoint 5
- . e, —
5 Running Target Toggle Method Breakpoint
+, & Console E ills Static Stack 2+ Call Hierarc = 0
> 3¢ Targets & Skip All Breakpoints Ctrl+Alt+B ] _]4 - 1
. %% Remove All Breakpoints K %l BB & @‘ 8-~
<terminated> ae350,
Q. External Tools »
< >
Writable Smart Insert 36:28 L1 |

- RNMKE: ERNME G, EFEEENRN SR E, ARheE
A, FhEHdikiE “Toggle Watchpoint”, 41 4-73 fiis.

4-73 KM E%EHE Toggle Watchpoint

48 Target Manager : Local Targets | B= Outline &3 EA R o % = O
u uart_ae350h A
# AE350 UART_DRV_VERSIOM
& yart_driver version : const AE350 DRIVER VERSION
# UART1 TRIG LVL
# UART2 TRIG_LVL
@ 5 uartl_info : UART '™mEM

4 uartl_dma tx ever
& uartl dma tx: UA
#
Pe
iSC
@ g
"
e
#

uartl_dma_rx_evel
uartl_dma_rx : UA
uartl_resources :

uart2_info : UART_
uart2_dma_tx_ever
uart2_dma_tx : UA

uart2_dma_rx_evel:

Open Declaration F3
Ctrl+Alt+H
Ctrl+Alt+I

Open Call Hierarchy

Open Include Browser
Refactor

Declarations

References

%% Toggle Watchpaint

@5 ant? dma ey - LIART DMA

- WA ERARET, A N AAE SR — AN AR R R Gk
JCERICYE ], NREERTIERE “Add Watchpoint (C/C++)...7, U
Kl 4-74 flioR.

MUG1025-1.3 116(143)




4 A TR

MUG1025-1.3

& 4-74 RFHEIEREFE Add Watchpoint (C/C++)...

)= Variables | €7 Expressions | [] Memory &3

(|
v| T o =‘| 1:| HA &

Monitors &5 3¢ %% |demo_led : Ox1 <Traditional= 2 | &5 New Renderings...

@ OxB0000000 | @xbooeassl
@ demo led exaeaaaell
B xaaanae2l
exeeaaaa3l

exeeanaadl

Gxeeeaaa51

Gx@eeaaR61

@xbeaaaa7l

e@xeeeoaesl

@xbeeaapal

eaxaeaaaaAl

exBeaaaanl

exaeaaaaCl

exaeaaaall

o B S

o,

633kﬁnﬁﬁ FEAAAANA ATIAEARAAA A SAASATA oA 0. %.1. ..
g7ec T8 Add Watchpoint (C/C++).. Ap. ...k
5256 Find and Replace Ctrl+F k1. ..
BBOE o Add Rendering g--6-5|
a38e b G’

# Remove Rendering 551 l
F3e1 [pGg....A
BBCE Panes > - Ei
B2l Endian I e
BSFE - s P
2343 , ...66.}g

Cell Size * .

B7ae . G.AG-..0
AL3E Radix ? Lagstuf
1326 Columns > Fcaf
338¢ Update Mode o RBILL L
caarn L -l

- Wi e ER A, Bl A TR ¢ (View
Menu), FHiZZH IS “Add Watchpoint (C/C++)...7, K

4'75 Fﬁ}j_:\‘o

& 4-75 B 2 L Ei%EFE Add Watchpoint (C/C++)...

9 Breakpoints 2

Mo details to display for the current selection.

2.

2 delay.c [line: 50]

2 delay.c [line: 54]

2 demo_led.c [line: B1]
2 demo_led.c [line: 85]
2 demo_led.c [line: B3]
2 demo_led.c [line: 97]
2 demo_led.c [line: 99]
2 demo_led.c [line: 102]

B\ Modules| B3 Debugger Console| ®)= Global Variables Live View
XREBHANEES

ele]

P .0 e, @

Layout

Group By

Sort By

Select Default Working Set...
Deselect Default Working Set
Working Sets...

Add Line Breakpoint (C/C++)...
Add Function Breakpoint (C/C++])...
Add Event Breakpoint (C/C++)...
Add Watchpoint (C/C++)...

Show Full Paths

“Properties for C/C++ Watchpoint” XFiHHEH, 52 WS 15 P 5
B, Hidi “Apply and Close”, 1K 4-76 s
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[#] 4-76 Properties for C/C++ Watchpoint

A Properties for C/C++ Watchpoint O X
Commaon Common - > -
Class: C/C++ Watchpoint

Expression to watch:

[JRange:
[JRead
] Write
Enabled

Condition: | |

lgnore count: |0 |

@ Apply and Close Cancel
WS S D R N5R 4-6 Fis
* 4-6 MWE FHEM
gL ik
Expression to watch WIREAE “Range” Ui € Z IR XK, E1EX
BN — /N R A Bl (&)
Range 8 WL s AL v Sk T
Read TE U A ) 2R IA 2 5 1R FE PP AT
Write 5 N AR ) I 45 1 B2 e AT
Enabled TFJE W5 R
Conditions A E —MEWEE S PR R A
Ignore count Fi e Fak AR AR b EL

3. WSS T E R E W s, M SRRl “¢ 7 BREME S,
“er” RoORNBLWEE S, WK 4-77 Fios.
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& 4-77 B S L E PRI M E =

9 Breakpoints &2 . =i Modules| G} Debugger Console | #9= Global Variables Live View = 0

XZER I BES ~
2 delay.c [line: 501
2 delay.c [line: 54]
2 demo led.c [line: 81]
2 demo_led.c [line: 83]
2 demo_led.c [line: 89]
2 demo_led.c [line: 97]
2 demo_led.c [line: 39]
2 demo_led.c [line: 102]
&/ [expression: 'demo_led']
¢/ [expression: 'led_num']
&/ [expression: 'uart_init]

Mo details to display for the current selection.

4. JERRUEE R, AR RO g rh SN BRSO A A
“3” (Remove Selected Breakpoints), #1& 4-78 ffix.

B 4-78 FERRET AL E P RO

9 Breakpoints i3 . =i Modules| B} Debugger Console | #= Global Variables Live View = 0

@ix|BBS -
B2 delay.c [line: 50]
2 delay.c [line: 54]
2 demo_led.c [line: 81]
2 demo_led.c [line: 85]
2 demo_led.c [line: B3]
2 demo_led.c [line: 87]
2 demo_led.c [line: 89]
B2 demao_led.c [line: 102]
& [expression: 'demo led']
& [expression: 'led_num']
& [expression: 'uart_init’]

Mo details to display for the current selection.
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5 THERHTIE

Z LU BB TR
S8 2.4 TR RGN 2.5 R s B L RR B T R g S B T
E, FPEAEBAYRTE Binary S

i%H] Gowin FTDI USB 4wt #3555 ik 83 1%E# PC £HLE Histk (B4R
f¥) Gowin RiscV_AE350 SOC JTAG #11), H T LBz &%

f# F Gowin USB #wfZE N #iZki%+: PC L5 Histk (FPGA
Programming JTAG #:11), HT F##H 44 FE Binary 1.

¥ RDS % T EA: “ ®” (Flash Burner), Bif5 8k & it T
F, Fhsgshiks “Flash Burner”, )53 Gowin Programmer, U1K
5-1 FillE 5-2 Fliw o

N

C. 3 FF CPU il 5 FPGA/CPU T #[F i B Gowin FTDI USB #fe#% LA & WinUSB i
3. EHES P Gowin FTDI USB 4mfE F#Zk, 7 il#h<c3E oy WinUSB k3)), —AMi&E#:
CPU JTAG 2T CPU ik, —/Ni%d: FPGA JTAG #I1HF FPGA/CPU F#.
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& 5-1 §&h Flash Burner

A C/C++ - ae350_demo/src/demo/main.c - AndeSight RDS v5.1.1 - [u] X
Elle Edit Source Refactor Navigate Search Project Run Window Help
BB Q]S A SHE TG D [avick Access] | 5| R 4 @
E . = o = 0
[ Project Explc e , it Creator [€ main.c &2
v 5 ae350 de ~
> 4 Binarie Show in Lacal Terminal > '
: main.c
> @l Include Copy Ctrl+C r  : GowinSemicoductor
» (= Debug Paste Ctrl+V . i .E?SB?SOC .
v = sre dion @ Main functions
b Delete Delete
>
& D) poste As Link
> (= der
S 7 Y
£ ae350. Source dis
Move... e "democ.h
Rename... F2
FEEOMS = mmmmm o o m mm e o e e
i Import.. (void)
&y Export.
Build Project ser application codes
Clean Project
B Target Mana & Refresh FS  fun UART demo
c DEMO_UART v
Close Project == >
3 Running 1 Build Targets > i B0 ; - : 3 i
5 % Targets 9 =] Pmpemeq \_:_ Pmblams} @' Termlnan fills Function Cade S\ze} [l Static Stack Ana\ysls} = O
o Index > =
‘ . trElEE=-& OO
Build Configurations | o e
Build Settings ze "ae350_demo.adx” T’tee output/.PHONY.size ~
- e rodata data bss dec hex filename
Ml =tgctConkiguakan 5 634 ) 726 9802 2643 ae35@_demo.adx
m Flash Burner Ctrl+” ing: ocutput/.PHONY.size
Validate .
© RunAs > >
5 22350 demo 3§ Debug As > ‘5 A

& 5-2 /3l Gowin Programmer

AC-HGES-idk-iE

— O *
ile Tools  About
a s & | | = ':':'b USE Cable Setting
Enable Series Device Operation MCU/FW/(HEX) File User Code IDC
1 [~ GWSAST GWS5AST-138B  exFlash C Bin Erase,Program 5AT E:/desktop/meu_test/ae350/rtthread.bin 000108
R C/C++ - - AndeSigh $v5.1.1 [GOWINSemic] - O #
File Edit Source Refactor Mavigate Search Project Run  Window Help

YO Qv HE 1D

[ Project Explor 52

= O (] Andes Project Creator 32

o] |BE %
= 8

B A prog

~ =5 ae350_atomic
) Includes
> (= Debug
¥ = src

|=| 22350 atomic Deb
1J 2e350_coremark
1J a2e350_cpp

v

@ Wait programmer to complete.

ress Information O X

Create Project...

Read

< 13 ae350_demo . — >
Duty (3 ae350_dhrystone Cancel Details == I 5 %
.
Info || . >
Info :
S BTar 2 E= Dutﬂ = g | Project Crealorl Pre‘ferances|
3;|| = ﬂl L B Console 2 . [0 Propenies}@ Prnb\ems‘} Sk BE E<.| B~y = 8

Info || v }:D Running Target # | [ICE-ICE Connection Console [ADP-AE350-A25-GOWIN:5]
Info '5 ADP-AE350-A25-GOWID ICEman is ready to use. ~
Info || v :<=::> Targets v &
Info|| < >

=5 22350 atomic LA

5. Gowin Program
Setting”, “2J#

F 3 ¥ “Edit > Configure Device”, B{f# T HA

mer, 4 Z WIinUSB 35Xz, Hscik# THAF “Cable
“using ft2xx driver” #&£IT, &l 5-3 Fis; A JE, EFE
“2” (Configure

Device), FCE F#HIED, WK 5-4 Fis.

121(143)




5 TEHMT TR

MUG1025-1.3

[#] 5-3 Cable Setting

i Cable Setting ? x
Cable: Ic-owin USE Cable (WINUSE) v]
Port: Gowin USE Cable (WIHUSE)/0/404/null
Frequency: 15MHz e
Cuztom LFT Querw/Tetect Cable

]Jo HOT shew at startup

cav
[D uzing ftfux driver ]

R T B AT

Access Mode: External Flash Mode 5A
Operation: exFlash C Bin Erase, Program 5A
External Flash Options > Device: Generic Flash
External Flash Options > Start Address: 0x600000

FW/MCU/Binary Input Options > Firmware/Binary File:
ae350_demo.bin

[ 5-4 FTHEMECE

% Device configuration ? X

Device Operation
Accezz Mode: External Flazh Made BA ~

Operation: exFlash C Bin Erase, Program BA LY

exFlazh C Bin Eraze Frogram GA

External Flazh Optionz

Device: Generic Flash ~

Start Address: 0600000 |

FW/MCU/Binary Input Options

Firmware,Finary File: |E:/desktop/men_test/ae350/2e350_demo. bin | D

Save Cancel

By “Save”, TER T HIETIE .
gy T A2 “50” (Program/Configure), | ## 4 4% % Binary 301
¥

T#EsEME, RDS #F#R “TARGET ERROR! Target is disconnected with AICE. ”,
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RDS ¥t 5 B s R IWITIERE, nl&l 5-5 frm. X257l T #)n FPGA EHINEC T
HHAT e Binary ST, BLIS RDS 815 B sz BTigEs. sy “OK” LK

Gowin Programmer, i&it} Flash Burner 7],

& 5-5 EF N

A C/C++ - 32350 demo/src/demao/main.c - AndeSight RDS v5.1.1

File Edit Source Refactor Nawvigate Search Project Run Window Help

BO-H@ & k-8 % -0 - -9~ SFETCOCD- I

Quick Access] ; = | il ¥ @
Sreapom] B rrooreq B roblem Ocared -8 XbE < =g
Wa 18:07:38.322 ICE-ICE Error on Target A -
v 2% ae350 demo @ [ADP-AE350-A25-GOWIN]
B o
> 3, Binaries TARGET ERRORI Target is disconnected with AICE.
> @l Includes
> = Debug E OF i | i XX XK XK EELELELE
Details ==
¥ = src L
> = bsp
< Cancel Details ==
v
M Targe 2 Z o= Ou | . >
& |— =
5, Runnl':gJ'I!aetE | & & Console 2 i=| Properﬂ[ﬂ Proble Wé,E'TerminaWEiy Fundio?lﬂy Static Sq = 0
) — [
3o Targets B EE B mE-0-
CDT Build Consacle [ae350_demo]
riscv32-elf-size "ae358_demo.adx” | tee output/.PHONY.size :
< >\ <Fm . . >
=5 ae350 demo i
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6 I AL B AR AL SR/ TR

6.1 HEAR T R/RY

6iEFH S A H

&

6.1 R ICR/ARIP

B FnERR 10 R /AR

X SCRFE A HERR ORI ) CPU A%, RDS B S0 VR 1 B T0C 5% B
PEHERRORST, (ESZ XA DhREABE A o BEPFRR THC SR ThRE, A7
IBATI MU 5, B BN RS 7 P =5 AR A A K/ o B HERG

DRI TIRE, ek HER R Bl ¥ A L
2t e PA T 26 A

® NHEME AR PP AR AZ UM 1 A HEM ARG (1 R G A7 4 B 1L

® MBI/ FIT mBCRAIR, L2

G HERAORY A B YA

HZ LN D BIT R M HER L S DI g -

1. 2R 4.31 QRS E PR 1 FPE 2, Al g — MR ER
&, “Debug Configurations” *fi&#E, Hidr “Exception Handling”
I, %P “Hardware Stack Recording”, W& 6-1 iR .

6-1 i£#¥ Hardware Stack Recording

[E] Main | %3 Debugger | B+ Startup | E~ Source |[C] Comman | #f Exception Handling

[lHardware Stack Recording

[[]Break on General Exceptions

MUG1025-1.3
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A RAR EAE A 23 1 TP AT SR A B R MR T 550 DA i e i 3 5
Jiik £ “Break on General Exceptions > Set the top of stack boundary
obtained from hardware stack recording as the stack overflow bound”, un

K 6-2 fTs.
6-2 I EXRTAR

[E| Main | %% Debugger | B= Startup | E Source |[C] Common | #f Exception Handling
Hardware Stack Recording
Break on General Exceptions

[JHardware Stack Protection Instruction Access Misaligned Instruction Access Fault

lllegal Instruction Mon-Maskable Interrupt Load Access Misaligned
Load Access Fault Store Access Misaligned Store Access Fault

Bus Write Transaction Instruction Page Fault Load Page Fault

Store Page Fault Performance Counter Overflow

[] ACE Exception [if mmsc_cfg.ACE == 1]
Slawve Port ECC [if (mmsc_cfg.ECC == 1) & (mmsc_cfg.LMSLVP == 1]]

Hardware Stack Overflow Detection

Hardware Stack Underflow Detection

Set the top of stack boundary obtained from hardware stack recording as the stack overflow bound

2. “Debug Configurations” XtiitEH, i “Apply” 1 “Debug”,
A

3. i <1E)E, RDS B4 AN ENE, FfEmE T A
£ “0e” (Resume), HEPHATFERF . RDS B4 T RS ERERF
BATH FIARTIIA A “Top” HIME, Wl 6-3 Fias.
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& 6-3 BT R

A Debug - ae350_demo/sre/demo/main.c - AndeSight RDS v5.1.1 - m] X

File Edit Source Refactor MNavigate Search Project Run Window Help

BG83 % %0 -0 -®5- G- [auick Access) | 1 | T B %

5 Project Explorer &2 = O ||4% Debug 2 = oo = | | i = = B |[t=Variables 22 0 Memory = 0O
= G | vk ae350_demo Debug [MCU Program] = ‘ ] jl 2
=5 22350 dema v J¢ Process Name Type

& Thread #1 (Running : User Request)
s gdb(8.2.50.20190522)-5

[8] start.s [ main.c 22 [£] delay.c i = 8

demo_mm( ) ; ~
#endif
< >
// Run multiple peripherals interrupts demo

#if RUN_DEMO_INTR

demo_intr{); #® SoC |F# Mem |bif Regi &2 = 8
-
A

#endif A E‘l i fl o1y 1m0

/# Run waterfall led demo Name
#if RUN_DEMO_LED .
B Targe 32 57 Outlin = 0 demo_led(); &% All Registers
a | o | - #endif M4 General Purpose Registers
. ! 4% Floatina Point Reaisters A
v ¥ Running Target / >
B ADP-AE350-A25-GOWIN ICE // User application codes o
Lo Targets < > 0 B 0| dks|dhF| ™ = 7
& cons % . [2 Prob | Prop | 0 Mem GDB |=F Disas = 0 a8 \, | s v
= |BEE S 8-

ae350_demo Debug [MCU Program] ae350 demo.adx

< >

Writable Smart Insert 127 : 30 E |5 e eE 'I 0x7FFFFEQ/Ox7FFFFEQ

6.2 BAFELE

RDS #f SO VEAELE A R o % R R A {2 IE R P AT, “ Stack
Overflow” X iHHESE R 72 H 52, W 6-4 Frn.

6-4 Stack Overflow

A stack Overflow O *
General exception: HW stack protection (OVERFLOW)
B !\_ DPC: 0x0000000000001E58

SP: 0x0000000007FFFFEQ
SP_BOUND: 0xD000000007FFFFED

SN BB 7 AT /] RDS B R 1 1k 2 1 o A 38 e 2
A, R rp A AL ROM B Flash #1, AR PAT TN 52 1 7 SR Y
AR, XSO, E AW IR H AR R GUA 2N TR
5o

1. 28 4.31 QI HASIERES R 1 PR 2, Al — MK Ei
#, “Debug Configurations” *f1EHE, iy “Exception Handling”
INE, %+ “Break on General Exceptions”, & 6-5 fl7x.
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& 6-5 i£#¥ Break on General Exceptions

E Main | %¥ Debugger | B Startup | Source | [] Common | 3 Exception Handling
Hardware Stack Recording
Break on General Exceptions

[JHardware Stack Protection Instruction Access Misaligned Instruction Access Fault

lllegal Instruction MNon-Maskable Interrupt Load Access Misaligned
Load Access Fault Store Access Misaligned Store Access Fault

Bus Write Transaction Instruction Page Fault Load Page Fault

Store Page Fault Performance Counter Overflow

[«] ACE Exception [if mmsc_cfg.ACE == 1]
Slave Port ECC [if (mmsc_cfg.ECC == 1) & (mmsc_cfg.LMSLVP == 1]]

Hardware Stack Cverflow Detection

D7 el

Hardware Stack Underflow Detection

Set the top of stack boundary obtained from hardware stack recording as the stack overflow bound

2. FREAREF AT I ZHH IR e A R E R, Wil 6-6 Fin.
& 6-6 tHEFFIKE

[E| Main | % Debugger | B Startup | B~ Source | =] Common | 3 Exception Handling
Hardware Stack Recording
Break on General Exceptions

[JHardware Stack Protection Instruction Access Misaligned Instruction Access Fault

lllegal Instruction Mon-Maskable Interrupt Load Access Misaligned
Load Access Fault Store Access Misaligned Store Access Fault

Bus Write Transaction Instruction Page Fault Load Page Fault

Store Page Fault Performance Counter Overflow

[»] ACE Exception [if mmsc_cfg.ACE == 1]
Slave Port ECC [if (mmsc_cfg.ECC == 1) & (mmsc_cfg.LMSLVP == 1]]

Hardware Stack Overflow Detection

D7 el

Hardware Stack Underflow Detection

Set the top of stack boundary obtained from hardware stack recording as the stack overflow bound

%} “Hardware Stack Protection”, Zii4g € /& &5 447 “Hardware

Stack Overflow Detection” #1/8% “Hardware Stack Underflow
Detection”, #1k 6-7 flix. %7 “Hardware Stack Overflow Detection”,
fE “Bound:” CAMEH M A HEAR D A A e ME, BT S5HEkkiRE (SP)
FAFREMEAE L. T “Hardware Stack Underflow Detection”, 7£

“SP Base:” XAKHEHHg NHERRFEHINE 2 A7 28 M8, H T 5 SP &7 8 iI{E
EELEE . 2 A Eiikid “Hardware Stack Recording” Al “Set the top of
stack boundary obtained from hardware stack recording as the stack
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overflow bound”, | “Hard Stack Overflow Detection” /] “Bound:” £
H 208 % B o Ed sk B HEAR 2 5 B KB .
6-7 %&#F Hardware Stack Protection

[E| Main | %% Debugger | B+ Startup | E Source |[C] Common | #f Exception Handling

[1Hardware Stack Recording
Break on General Exceptions

I Hardware Stack Protection Instruction Access Misaligned Instruction Access Fault

lllegal Instruction Mon-Maskable Interrupt Load Access Misaligned
Load Access Fault Store Access Misaligned Store Access Fault

Bus Write Transaction Instruction Page Fault Load Page Fault

Store Page Fault Performance Counter Overflow

[] ACE Exception [if mmsc_cfg.ACE == 1]
Slawve Port ECC [if (mmsc_cfg.ECC == 1) & (mmsc_cfg.LMSLVP == 1]]

[“lHardware Stack Overflow Detection:
Bound: |Dx?fﬂ'feD

[JHardware Stack Underflow Detection

Set the top of stack boundary obtained from hardware stack recording as the stack overflow bound

3. “Debug Configurations” XI1itEH, i “Apply” 1 “Debug”,
A

4. RSk )G, RDS ¥t A st NREGEL K], AR o E K
AL, RE AR E T AR “00” (Resume), HEEPATIEIT .

MR O E “hardware Stack Protection”, Il RDS #th-4 F MR A
ERFERFIBATH I HERRPOIRAS, Wl 6-8 ATz
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6 I8 5 AL SRR HEAR 10 SR/ TR

& 6-8 RRHERRIPIRAS

B cons = Probw i=| Prop} @ Mem 1 G GDB 1=_' Disaq = 8

R R EE rEB -
ae350 demo Debug [MCU Program] ae350 demo.adx

Writable

A Debug - ae350_ demo/sre/demo/main.c - AndeSight RDS v5.1.1 - m] X
File Edit Source Refactor Navigate Search Project Run Window Help
Bo D6 Rl 8 % s-0-C-BF- SRE 15O~ k]| | B BB
Y Project Explorer 32 = 5 |[4% Debug I3 Bkl 0] B3 @ .| T2 5 |- Variables 52 [ Memory| = @
= %G 7 || v ¥ 22350 demo Debug [MCU Program] ~ e et e T
> 2% ae350_demo v i Process Name Type
~ i Thread #1 (Suspended : Breakpoint)
= main() at main.c:123 Oxledd
A odhiA.2.50.20190522)-7 h
|8 start.s €] main.c ¥2 €] demo_led.c ] 2 = 0
113 demo_mm( ) ; ~
114 #endif
115 < >
116 // Run multiple peripherals interrupts demo
117 #if RUN_DEMO_INTR
118 demo_intr(); #8 SoC | B8 Mem | bii Regi &2 = O
119 #endif 3
120 LgE| ot me =
121 // Run waterfall led demo Name L)
122 #if RUN_DEMO_LED .
ATarge 2 B outin| = T [505 | dems 1ed(); > iﬁ All Registers
124 #endif > B General Purpose Registers
[ANN=N =10~ R o .
-, . | | s 125 > &% Floating Point Reqisters e
~ ¥ Running Target 126 /" < >
BE ADP-AE350-A25-GOWIN ICE-| |2 127 // User application codes ©
-, - o
> 5@ Targets < > % B I Elﬂﬂzﬂlﬂnﬂ » = 5
-

XRPIAW BES

Smart Insert 127:30

5 A w1 | oxTrrFRE0/ONTRRFFEQ

5. REHKAEFENFHEN, M —DIHERSAHRIER,
PRV e LR A S AL B

MUG1025-1.3
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7 AT TR

7.1 S HrEALE

7 AT

K

RDS #cftn] LAAE H s _ESEI 04 GCC i as 2 I AF LS, =4
FEfy T EHE AT B P RAT B JA . SO REE . Gt A A A SR

H/tho

7.1 STHTENLE

SHTEME (Profile Perspective), &0 #4LE (Profile View),

TRt s, WK 7-1 s
& 7-1 AmENLE

A Profile - 2e350_demo/sre/bsp/lib/delay.c - AndeSight RDS v5.1.1

File Edit Source Refactor Mavigate Search Project Run Window Help

~ {8 Process
v i Thread #1 (Suspended : User Request)
= _start() at start.5:34 Oxc

1S 22350 deme

[@ mainc [ [6 demoled.c [ [€] delay.c 52 %
4 STATIC Unsignea 1nT BET._core_treq(vold)
25

return (unsigned int)(CPUFREQ/MHZ);

204 static unsigned long long rdmcycle(void)

e
31 #if _riscu_den - 32

ﬁ 57 » = B 32 do

I 33 i

2l B .| 34 unsigned long hi = read_csr(NDS_HMCYCLEH);

- 35 unsigned long lo = read csr(NDS_MCYCLE);
36

~ & Running Target <

ADP-AE350-A25-1

. e B consol = [2] Proble | [T Propert| & Termin GDB Co
3¢ Targets

L] | Bk BB

2e350_demo Debug [MCU Program] ae350_demo.adx

AC-HEl 8- id-id- & -F -G %% "0 - %O
[ proj 52 = O |4 Debug 52 Bikm | 3. R i v =0
5 %G, ¥ v ik 2e350_demo Debug [MCU Program] "

v
>

a8

P e B0

Profile Perspective
oo -

Quick mm £

O has

[ Target Board Profiling i

F B @ ed B | 5058 g | |
gmon file: DARDSS\workspace\ae350_demol\gmon.s
program file: D:/RDS5/workspace/ae350_demo/Debug/ae350_demo.adx

= 0

um

Profile View

‘type filter text
Name (location) Samples % Time
v Summary 308 . 100.0%
~ delay.c 305 I 92.03%
simple_delay_ms 305 - 00.03%
~ uartc 3 . 0.97%
uart_putc 3 - 0.97%

99 Breakpoints |y Static Stack Analy |ills Function Code Siz 2

Binary File: fae350_demo/Debug/ac350_demo.adx --

Name Size File

e DA . -

= a
==
> Total Function Code $i;

Line Path

Has M=tk (Profile Session) 5, RDS ¥ Hshit N o HriE L&,
B % RDS B3 H “Window > Perspective > Open Perspective >
Profile”, Tzt N #riZEfLE, Wik 7-2 flos.

MUG1025-1.3
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7 S HriAE TR 7.2 HARHR B AL

& 7-2 #%&#¥ Window > Perspective > Open Perspective > Profile

A ¢/C++ - ae350_demofsrc/demo/main.c - AndeSight RDS v5.1.1 - u] X
File Edit Source Refactor WNavigate Search Project Run | Window Help
B o~ | & ~iglh -t w0 Q- New Window s - o - :g|@@g~@
Editor >
5 Project Exp 2 = 0 |[/Al Andes Project Creator [+ = O
= = Appearance >
= e/ A~
= Ul Mode »
=% ae350_demo 5
a Show View >
5 £358_ Perspective > [% Open Perspective > 45 Debug
6 * Function : Main fi Brofi
A Navigation > Customize Perspective... Iﬁ rome
g 0=
S Bemeaim G £ Team Synchronizing
9 Preferences
f/ Includes --------- e Reset Perspective... Other...

11 #include "demo.h"

Close Perspective
Close All Perspectives

f DB T AN I OnE = m m = o o o o o e = oo
5= int main(void)

BT 5 Bow = O B Console 5 ™. [ Properties|[£] Problems| @ Terminal | ills Function Code | lly Static Stack Ana | 5® Call Hierarchy| = B
a=

o) e | ” X% ABEES B -0~
H, Running Target <terminated> ae350_demo Debug [MCU Program] ae350_demo.adx
2

:=:!> Targets

< >
Writable Smart Insert | 123:1 : R |

B AT DL RDS #AFEMLIE T HA2 “@” (Profile), #E A%
ML

7.2 B AL E

H AR B4 E (Target Board Profiling View) T H¥x &4t 73 Bk
K, SoRFEFRLE R T R 2 TR TE], SRR e B R RS
B, AT UE A TR R E R, Wl 7-3 fis. AR AL T — N seh
B, FHORERERAE A FE P $AT F R

& 7-3 B STHILE

[» Target Board Profiling 3 E%@ﬁ“ i@@@ﬁl E-D| = O
gmon file: DARDSS\warkspace\ae350_demolgmon.sum
program file: D:/RDS3/workspace/ae330_dema/Debug/ae330 demo.adx

type filter text

MName (location) - Samples % Time

v Summary 308 I 100.0%
v delay.c 305 I 09.03%
v simple_delay ms 305 I 09.03%
simple_delay ms (delay.c:56) 305 I 09.03%

¥ uart.c 3 I 0.97%

¥ uart_putc 3 I 0.97%

uart_putc (uart.c:59) 3 I 0.97%

VEN I HE B B —# 7, TR tresilia, B3hE3h 3 Arion Hril
K. tharLLES RDS #4F £ 225 “Windows > Show View > Other...”7, I
Kl 7-4 flzr. “Show View” XfiEHEH, #L$ “Profile > Target Board
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7.2 HARHR B AL
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Profiling”, 34520 H bsti i, il 7-5 Fios.
& 7-4 #%£#¥ Windows > Show View > Other...

A C/C++ - ae350_demofsrc/demo/led/demo_led.c - AndeSight RDS v5.1.1 - O X
File Edit Source Refactor Navigate Search Project Run | Window Help
B 6% ik i8 |0 N foo o v reee] ! |G @
Editor >
[ Project Explor 22 = O |[[A Andes Project Creator = 8
- Appearance >
B <‘I=F9 = 16 ¥ ~
< d 17 = After initializ Ul Mode > [ set GPIO direction to output for waterfall led.
? & ae350_ demo 18 * The waterfall 1 e e
19+ Show View > Build Targets
20 Perspective > [@ C/C++ Projects callback
21 .
22 sfer o B Console Alt+Shift+Q, C
23 = Include Browser
24 Preferences o :
25 // Includes ------- %. Navigator |
26 #include "demo.h” o= Outline Ale+Shift+Q, O
27 = .
28 // Tf running waterfall led demo (L Problems AR,
29 #if RUN_DEMO_LED {5 Project Explorer
EL] .
31/ Includes I E iseranize
3 2 32 #include "Driver_GPTD.h" <" Search Alt+Shift+Q, S
o 3 = 33 #include "uart.h” -
HTar 2 o= Oulh] = 34 #include "delay.h” = TESk%
Fal ‘ B ﬂl R < 35 #include <stdio.h> & Terminal
. 36
> 3 Running Target 37 Other... Alt+Shift+Q, Q
> 3:* Targsts 38 /f** * Definitions [/
39 extern AE35@ DRIVER GPIO Driver GPIO: /I GPIO v
& Console 5 . [ Properties | [2] Problems| & Terminal | ils Function Code Size| il Static Stack Analysis| =8
B
No consoles to display at this time.
0 items selected &8

[# 7-5 1%#¥ Profile > Target Board Profiling

A show View O

type filter text

>

» = General
» (= Help
» = Make
» = Other
v = Profile
= Simulator Performance Meter
Ali Simulator Profiling
[ Target Board Profiling
» [ Remote Systems
> = RTOS Awareness
> = Scripting
> = Team
» = Terminal
5 B XML

Open Cancel

H AR BT AL R R A0 N 3R 7-1 B
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7 AT TR

7.3 i aih

* 7-1 B S EE =5

RS

Eitipay

Name (location)

e A IS R H AR R

Samples

B MR TR 10 ZA0RAE— IR

%Time

R E AR 2 IPAT IR 18] 5 R 7 S AT I TR 1 20 B

F bt 7 A AL B ) LA A 45

® “%©” (Show/Hide columns) : “Show/Hide columns” XfifHErF, fi
5E BLAE H AR AL B BoR i 1
“4” (Exportto CSV): 5l H 74k #.csv 3CfF.
“EL” (Sorting): “Sorting” XHEHER, F5 5 H AR Hr A8 & 2 4 %

FHIHEBIR T o

“2d” (Sort samples per file): X BIEFER
“24” (Sort samples per function): fZIhEEXT s HET -
“2” (Sort samples per line): %47 X Hr¥dsHi T

“all” (Reset): T EN 0.

&ZO

“E2” (Switch samples/time): H¥ MREAAS B Y He 3 a2 5, 5%

® “&” (Createchart...): ffiHIgEITEdE, CQIELAEE. EEHX

UASE RN

7.3 DS NE

Z ML P RAIE i 218
1. ZWE 2 5 _QUEAMM I TR & — N TR

2. UiHRREHBEMET, Apdiddh e TR, Thgsdikst
“Profile As > Profile Configurations...”, 1% 7-6 ffiix~.

MUG1025-1.3
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[# 7-6 #&#¥ Profile As > Profile Configurations...

File Edit

A~

Source  Refactor

Navigate

| & ~idh - &

Search Project Run

G40 -0~

A cicrs - ae350_demo/src/dema/main.c - AndeSight RDS v5.1.1 — O e

Window Help

) Project 2
New

» 25 ae35C

Copy
Paste

¥ Delete
Paste As Link
Source
Move...

Rename...

Import...

G E

Export...

Build Project

Clean Project
& Refresh

Close Project

Build Targets
—_— |ndex
AT

| B8

unni

=

Build Settings

=

arge

iyt gk (2
-

Flash Burner

=g

Validate
Run As
Debug As
Profile As

#* Q

<

File Explarer

& ae350_de =

= O 1(& Andes Project Creator

Compare With

>

Show in Local Terminal »

Ctrl+C
Ctrl+V
Delete

F2

F5

Build Configurations »

Target Configuration

Ctrl+”

Restore from Local History...

“Profile Configurations”

Program”, Gl — "ot E, i 7-7 s
7-7 QI AL E

( mainc &2

51 oo 9 [ 2| @D
= 0

coductor A

tions

codes

>

n Problems] Pl Tarminan ills Function Co] ills Static Stack] 3 call Hiararcw = 8

EXRR|GEREEFE 2B
[MCU Program] ae350_demo.adx

## 1 Application Program
# 2 MCU Program

Profile C

£ =
2}

g
&
i

XUEHEH, XHEERM “MCU

A profile Configurations

Create, ge, and run fi

CEaREX B2~

type filter text

## Application Program
o Core Group
~ i MCU Program
ik ae350_demo Debug
M Multi-Core Application P
®& Multi-Core MCU Prograt

< >

Filter matched 6 of 11 items

Name: |ae350_demo Debug |
Main] 45 Debugger B+ Startup B~ Source| = Qommoﬂ| Al Proﬁler| #f Exception Handling|
-~
Project:
| ae350_demo ‘ Browse...
Program:
| Debughae350 demo.adx
Variables... Search Project... Browse...
[JRTOS Awareness Debugging:  ${AUTO) Browse...
[#] Target Management Service
[IFlash Programming Before Debugging
Automatically burn
[] Disable Memary Map
w
Revert Apply

@

Close
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“Profiler” &Ik, WREFIIFE 5, NEFE “Enable manual
profiling”, #M=<l4, RDS #4FHFFE 1T, #idi “Profile”, Wik 7-8
Frs o
7-8 1%+¥ Enable manual profiling

[El Main | %% Debugger | B+ Startup | B Source |[C] Commaon | /A Profiler #f Exception Handling

[“liEnable manual profiling:

Profiling within
(® Program default region

Start address End address: |0x2300

(O User-specified region
Start address  (,33 End address  (,23200

“text” BARENUBE O TIE, G R B g AT I X, ik
“User-specified region”, f&7E Z 5t X IR EE 4G bk AN g5 sk, ]
7-9 F7R.

& 7-9 %#¥ User-specified region

[E| Main | %% Debugger | B> Startup | B Source |[C] Comman | /A Profiler %f Exception Handling
Enable manual profiling
Profiling within

() Program default region
Start address (38 End address: 42300

®)User-specified region:

Start address End address |0x2300

3. JTiRMHrexil, RDS ¥k E N @A, Sl A
“ k" (Resume). “ #-” (Step Info) B “=” (Step Over), #k&Hh
TR, Wi 7-10 P,
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7.3 AT eih
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& 7-10 WXL E
15 Debug i Bk m| 3 .| v = A
w4t ae350 demo Debug [MCU Program]
v & Process
~ f# Thread #1 (Suspended : Step)
= demo_led() at demo_led.c:68 Ox1ebd

WA E “Enable manual profiling” M &il, i FEHAT {5
gk fE, BRI B 3 AR BoR o T BeE, W 7-11 s

& 7-11 BArtRHTARE PR 5 gz
& Target Board Profiling &3 % ea ﬁl,l E | & — O

gmaon file: DARDSS\workspace\ae350_dema’\gmon.sum
program file: Dy/RDS5/workspace/ae350_demo/Debug/ae330 demo.adx

type filter text |

MName (location) - Samples % Time

¥ Summary 308 . 100.0%
~ simple_delay_ms 305 N 99.03%
v simple delay_ms (delay.c:36) 305 I 99.03%
OxlacB 299 . 07.08%

Oxlacc 6 N 1.95%

» uart_putc 3 I 0.97%

w uart_putc (uart.c:59) 3 I 0.97%

Oxle22 3 . 0.97%

ik “Enable manual profiling” HIaHr &1, S 4.4.1 B

SR ENW S, R T EAE ¢ U REEPATIR T, 217 RE W Ak

fﬂ* UEi e RDS #fF T EA2 “ 77 (Start Profiling), B iR 5 AT ALK
SRR R A e, R 0, WEE A, i 7-12 Fos.
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7 S HriAE TR 7.3 ik

& 7-12 Fx18 15 il E

A profile - 2350_demoysrc/bsp/lib/delay.c - AndeSight RDS v5.1.1 - O X

Fle Edit Source Refactor Navigate Search Project Run Window Help
Ar-dalS-d-[Fle w%-0-8-85-sBE10E-D-Y [auide Aceess] | 1 | B[4
&5 proj 52 = B |[# Debug 2 ‘!‘.\.,\ub | 2. @ g|i¥ . ¥ = O |[[@ Target Board Profiling 32 =g
A i ®aE | e 2| @
gmon file: DARDSS\workspace\ae350_demo\gmon.sum

program file: Dy/RDS5/workspace/ae350 demo/Debug/ae350 demo.adx
[type filter text |

= G || v ik 26350 demo Debug [MCU

> 1% 2e350_dema ~ [ Process
v @ Thread #1 (Suspended : Breakpoint)
= demo_led() at demo_led.c:83 Ox1e90

m]

Wgliame (iocation) Samples % Time
= = ~ Summary 137 — 100.0%
8 mainc [lg] demoledc [ (8 delay.c 22 2 B v delay.c 135 — 0354%
s unsigned long lo = read_csr(NDS_MCYCLE); " > At ddms 135 . 95.54%
37 if (hi == read_csr(NDS_MCYCLEH)) v uartc 2 T 1.46%
38 1 > uart putc 2 — 145%
9 return ((unsigned long long)hi << 32) | lo;
20
2 } while(1);
12 #else
=5 © return (unsigned long long)read_csr(NDS_MCYCLE);
TR 1 42 gendif
& B e\ e }
- 47 f Get time counter based on @
475 Tano +imalunidl o < >

v % Running Target
BE ADP-AE350-A25
> Ho Targets

<
. = ; > : =
D Consol 5 & pmh\e] = Dmper)@'rermiﬂ Tl aoe c] = 5 ||% Breakpoin i3 ills Static Stac]ﬂg Function ]Q Chart V\e]
Xk BEEE® T o Xx&IAn[BES
22350 demo Debug [MCU Program] 2e350_demo.adx

=]
-

&l
1)
i}
E
4

4. MREESITEEE, AT DIRBRE P PAT RO W R BRI R, ER
N RSN E, W 7-13 fos.

& 7-13 B EFERAE

[ Target Board Profiling i3 E%ﬁﬁ@|:@®®ﬁ|ﬁb|0=5\
gman file: DARDSS\workspace\ae330_demolgmaon.sum
program file: D:/RDS5/workspace/ae350_demo/Debug/ae350 demo.adx
|t:.rpe filter text |
MName (location) - Samples % Time
v Summary 308 N 100.0%
~ simple_delay ms 305 I 99.03%
+ simple_delay_ms (delay.c:56) 305 N 99.03%
Nularg 200
Jeygdrive/d/RDS5/workspace/ae350_demo/Debug/../src/bsp/lib/delay.c:56 i
~ uart_putc 3 . 0.97%
w uart_putc (uart.c:59) 3 I 0.97%
Oxle22 3 I 0.97%

5. YRR ORI R HOE )AL B E W S, Wi 7-14 PR
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7 S HriAE TR 7.3 il

s
& 7-14 BB
A Andes Project Creator [ main.c [8] start.s s} demo_led.c &2 g delay.c = B8

// Initializes GPIO
GPIO_Dri->Initialize(gpio_callback);

/{ Set GPIO direction (GPIO pins as led: output)
GPIO_Dri->SetDir(GPIO_LED USED_MASK, AE358_GPIO DIR_OUTPUT);

// Waterfall led
while(1)

begin_time = time();

simple_delay_ms(leeeea);

/7 This 1ed Set a breakpoint =
——ETETI L (antt);

// other lgds are off
GPIO_Dri-»Write(~led pin, @);

6. i RDS #fF T HAL “9-7 (Profile), HiasHreif, FBFEHATH
“main” EREALET .

7. BEHERME T AR I (Resume), P ATIET, FEE—
BT S AL B

8. MR E T H AL 27 (Step Info) B¢ “ =7 (Step Over), Hiib
PAT LR P bR BUE A

9. HIWIAMEY, HIXEESTEYE, SRUIT PR EEHEEE D

DIRAEE
- BRI AEh, R AR AR B SR L, R B AR AT A
K T EF% “&” (Create chart...), WK 7-15 ffi7R.
[&] 7-15 i£#% Create chart...
& Target Board Profiling 2 Sk EEE IR OEE

gmon file: DARDSS\workspacelae330_demo\gmaon.sum
program file: D:/RDS5/workspacefae350 demo/Debug/ae350 demo.adx

type filter text |

Mame (location) a Samples % Time

v Summary 308 N 100.0%
v simple_delay_ms 305 I 09.03%
~ simple_delay_ms (delay.c:56) 305 . 09.03%
Oxlac8 299 I 97.08%

Oxlacc +] . 1.95%

w uart_putc 3 I 0.97%

~ uart_putc (uart.c:59) 3 I 0.97%

Ox1e22 3 I 0.97%

“Create chart from selection...” XiFHEF, FCE “Select your
char type” #il “Select the column(s) to show”, i “OK”, =4
K&, i 7-16 FE 7-17 fis.
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7.3 ik

7 A TR

& 7-16 Create chart from selection...

A Create chart from selection...

& Chart builder

Select the columns(s) to show

] Samples
[+]% Time

Select all \ \ Deselect all

oK | ‘ Cancel

& 7-17 ER{E
g = O

9 Breakpoints ﬁ mrﬂ ﬁ b

Bar graph

B % Time
M Samples

Summary

Name (location)

50 100 150 200 250 300

10. WRFEF R E LA, Ad R E T AR “3” (Instruction
Stepping Mode), AJ LAV 2| i gL IE, D PAT KL RmIES, W

Kl 7-18 F11E 7-19 P

[& 7-18 1%#¥ Instruction Stepping Mode
4 Debug 72 g nm 2B v= 0

~ i ae350 demo Debug [MCU Program]

v 2 Process
v f® Thread #1 (Suspended : Breakpoint)
= demo_led() at demo_led.c:83 0x1e90
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& 7-19 KL 4w E

Bl Consale ﬂ_:—_ Problems (E Properties lré,i' Terminal (@ GDB Command | == Disassembly &3 = 8
|Enterlocaticrn here v|| &1 ﬁj- <§‘> @)l i s

> BPBO1acs: addi al,ad,-1 -~

pepelacc: c.bnez a@,@xlacd <simple_delay ms+12>

57 1

Bepalace: c.jr ra

aeaelade: c.nop

Beealad2: c.nop

28 if (str)

printchar:

poealads: c.beqz a@,@xlaed4 <printchar+l6>

38 **gtr = ¢y

Beealads: c.lw as,a(ad)

Be0a1ads: sb al,@(as)

31 +H(*str);

peealadc: c. 1w as,8(ad)

paBelade: c.addi a5,1

2epelace: C.5W as,e(ad) v
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8 ICEman 4

ICEman &

ICEman #4AF “AndeSight RDS_v511\ice\andes-iceman.bat”,
BUR EBE TR “ICEman_AndeSight RDS v5.1.17, &Ik Nz 8-1

I
2= 8-1 ICEman kIR
eI ik
-a, --reset-aice Reset AICE as ICEman startup, for AICE only
-b, --bport Socket port number for burner connection
(default: 2354)
-c, --clock Specify JTAG clock setting

Usage: -c num

num should be the following:
: 30 MHz

: 15 MHz

1 7.5 MHz

: 3.75 MHz

:1.875 MHz

:909.091 KHz

:461.538 KHz

7:232.558 KHz

10: 10 MHz

11: 6 MHz

12: 3 MHz

13: 1.5 MHz

14: 750 KHz

15: 375 KHz

Andes AICE-MINI+ only supports 11 ~ 15

oo 0 A W N 2~ O

-C, --check-times Second to check DTM
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(default: 3 seconds)

Example:

1.-C 100 to check 100 millisecond

2.-C 100s or -C 100S to check 100 seconds

-D, --larger-logfile

The maximum size of the log file is 1TMBx2. The size is
increased to 512MBx2 with this option.

-f, --log-output output log file path

-h, --help The usage is for ICEman

-H, --reset-hold Reset-and-hold while ICEman startup

-1, -interface Specify an interface config file in ice/interface

-l, --custom-srst

Use custom script to do SRST

-L, --custom-trst

Use custom script to do TRST

-N, --custom-
restart

Use custom script to do RESET-HOLD

-0, —-reset-time

Reset time of reset-and-hold (milliseconds)
(default: 1000 milliseconds)

-p, --port Socket port number for gdb connection
-s, --source Show commit ID of this version
-S, --stop-seq Specify the SOC device operation sequence while CPU stop

-R, --resume-seq

Specify the SOC device operation sequence before CPU
resume

Usage:

--stop-seq A1:D1[:M1],A2:D2[:M2]

--resume-seq A3:D3[:M3],A2:rst

A*:address, D*:data, [:M*]:optional mask, rst:restore
A*,D*,[M*] should be hex as following example
Example:

--stop-seq 0x500000:0x80,0x600000:0x20
--resume-seq 0x500000:0x80,0x600000:rst

-t, --tport

Socket port number for Telnet connection

-T, --boot-time

Boot time of target board (milliseconds)
(default: 5000 milliseconds)

-v, --version

Version of ICEman

-X, --diagnosis

Diagnose connectivity issue
Usage:
--diagnosis[=address]
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-X, --uncnd-reset-
hold

Unconditional Reset-and-hold while ICEman startup
(This implies -H)

-z, --ace-conf

Specify ACE file on each core

Usage:

--ace-conf <core#id>=<ace_conf>[,<core#id>=<ace_conf>]*
Example:

--ace-conf core0=core0.aceconf,core1=core1.aceconf

-Z, --target

Specify target type

--target-cfg

Specify the CPU configuration file for a complex multicore

--halt-on-reset

Enable/Disable halt-on-reset functionality
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